Contents

About This Guide.....................................................................................................vi
Where to Go for More Information .......................................................................viii
What is New in Applications Manager 8.0 ..............................................................x

1. Applications Manager Operations .................................................................1
   1.1 Introduction to Applications Manager Operations........................................2
   1.2 Using the Applications Manager Desktop.....................................................4
   1.3 Working in the Applications Manager Windows ...........................................6
   1.4 Editing General Desktop and ToolBar Settings ..........................................8
   1.5 Setting Alerts.................................................................................................10
   1.6 Setting the User Interface Font....................................................................12
   1.7 Viewing Operations Reports.........................................................................14
   1.8 Customizing Tables......................................................................................18
   1.9 Changing Status Colors................................................................................20
   1.10 Viewing the About Applications Manager Window....................................22
   1.11 Linking to Online Manuals and Applications Manager Web Sites................24
   1.12 Launching the Applications Manager Client...............................................26
   1.13 Logging on to Applications Manager..........................................................28
   1.14 Getting More with Applications Manager Add-on Products..........................30

2. Requesting Jobs and Process Flows ..............................................................35
   2.1 Introduction to Requesting Jobs and Process Flows.....................................36
   2.2 Requesting Jobs and Process Flows............................................................38
   2.3 Submitting Jobs and Process Flows.............................................................40

3. Viewing and Printing Output ..........................................................................45
   3.1 Introduction to Viewing and Printing Output................................................46
   3.2 Working with the Output Window...............................................................48
   3.3 Querying the Output Window........................................................................50
   3.4 Viewing Output Files with the File Viewer................................................54
   3.5 Printing, FTPing, and Emailing Output Files...............................................56
   3.6 Opening Output Files with Other Applications...........................................58
   3.7 Sharing File Associations with All Applications Manager Users..................60

4. Monitoring and Managing Tasks in Explorer.................................................63
   4.1 Introduction to Monitoring and Managing Tasks..........................................64
   4.2 Using the Explorer Window.........................................................................66
   4.3 Working with the Backlog............................................................................68
   4.4 Working with History...................................................................................70
8. Viewing Forecasts and Monitoring System Performance .................169
  8.1 Introduction to Viewing Forecasts and Monitoring System Performance ..........170
  8.2 Viewing Forecasts ..................................................................................................................172
  8.3 Viewing Graphical Forecasts ...............................................................................................174
  8.4 Setting the FORECAST Job Parameters ..............................................................................176
  8.5 Generating Production Schedules .........................................................................................178
  8.6 Monitoring System Performance with the Dashboard .........................................................180
  8.7 Editing Dashboard Properties .............................................................................................182

9. Monitoring and Managing Tasks with the Gantt View .........................185
  9.1 Introduction to Monitoring and Managing Tasks with the Gantt View .........................186
  9.2 Reading the Gantt View Window .........................................................................................188
  9.3 Interpreting Adjusted Start and End Times ..........................................................................190
  9.4 Finding Tasks in the Gantt View Window ............................................................................192
  9.5 Setting the Gantt View Preferences .....................................................................................194
  9.6 Printing from the Gantt View ..............................................................................................196

10. Monitoring Multiple Automation Engines and Agents with AppMaster .......199
  10.1 Introduction to Monitoring with AppMaster .................................................................200
  10.2 Monitoring AppMaster Views .........................................................................................202
  10.3 Viewing the Agent Summary or Properties for an Icon ..................................................204
  10.4 Monitoring Statuses with AppMaster ..............................................................................206

Appendices ..................................................................................................................209
  Appendix A: Automation Engine/Agent Status Values ............................................................210
  Appendix B: Task Status Values ..............................................................................................213

Index ..........................................................................................................................225
About This Guide

The User Guide is a comprehensive procedures manual for Applications Manager operators.

The User Guide is a comprehensive procedures manual that covers all aspects of Applications Manager operations.

Text Conventions

The following text conventions are used throughout this guide:

- User interface field names, menu items, and window names are written in **bold**.
- File names and text within scripts are written in a **bold arial font**.
- Variable text is written `<within brackets>`. In the example below `<run ID number>` represents the actual run ID number of a requested job.

  If you submit a large process flow, the message will read, ‘Task submission in progress: Run ID = `<run ID number>`’ until all components of the process flow have been placed into the Backlog.

Cross-Reference Conventions

Cross-references to topics within a manual list the topic name and number as shown in the following example: For information on task details in the Backlog, see topic 4.7 Viewing and Editing Task Details.

Cross-references to topics in other Applications Manager manuals list the manual name as shown in the following example: For information on external predecessors, see topic 5.5 Working with External Predecessors in the Development Guide.
Unique Format

The manual is written as a series of topics, with all but a few topics presented on two facing pages. Illustrations are always displayed within the topic. These features make it easy to find where a topic starts and ends, and eliminate flipping pages to find an illustration.

<table>
<thead>
<tr>
<th>1.1 Topic Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary paragraph set off by horizontal rules.</td>
</tr>
<tr>
<td>__________</td>
</tr>
<tr>
<td>__________</td>
</tr>
<tr>
<td>__________</td>
</tr>
<tr>
<td>__________</td>
</tr>
<tr>
<td>__________</td>
</tr>
<tr>
<td>__________</td>
</tr>
</tbody>
</table>

In some rare cases a topic cannot fit onto two pages. To draw attention to these exceptions, we have included a continuation symbol...

...in the lower right corner of the second page.

Each topic begins with a heading followed by a summary paragraph set off by horizontal rules. The summary paragraph states the key concepts presented in the topic. If a topic has a subtopic, the subtopic is also presented on two facing pages. The topic heading is carried over to the subtopics, and is displayed in smaller letters above the subtopic heading.

To get a quick overview of a chapter, read the summary paragraph for each topic and look at the figures and figure captions.
Where to Go for More Information

The most up-to-date Applications Manager documentation is available in the online manuals. You can access the manuals from the Help menu in the Applications Manager client. PDF manuals are also available, but may not be as current. The knowledge base on the UC4 Support site provides write-ups to address problems and frequently asked questions. Additionally, support technicians are available based on your support contract.

Online Manuals

Complete online versions of the Applications Manager manuals are accessible by selecting Applications Manager Manual from the Help menu on the Applications Manager desktop or by clicking the Help button in various client windows. If you select Help while defining an object, Applications Manager opens the corresponding help topic. Occasionally new functionality is added to an Applications Manager version and bugs are fixed throughout each version's life cycle. The most recent edits to the manuals are included in the online help of each build.

PDFs on the Support Site

PDF files for Applications Manager, Operations Manager and Rapid Automation agents are available on the UC4 Support site:

   http://support.uc4.com

PDF files are usually only generated when an application is first released. For the most up to date information, see the online help that ships with the application.

Knowledge Base

The knowledge base provides write-ups to address problems and frequently asked questions. It is searchable by error message, category, and text. The knowledge base is located on the UC4 Support site.

Applications Manager User Forum

The Applications Manager User Forum is a place where you can network with other Applications Manager users to trade tricks, tips and best practices. Check on the latest product developments, find out about new service offerings, and make new friends and connections. The forum is located on the UC4 Support site.
Contacting UC4 Support

If you encounter problems with Applications Manager, you can solve most problems using:

- The instructions provided in the Applications Manager manuals.
- The knowledge base available at the UC4 Support site.

You can access the UC4 Support site from the Applications Manager desktop by going to the Help menu and selecting Applications Manager Support.

If you are unable to resolve a problem, contact UC4 Technical Support. Except for emergencies, we suggest opening a support call from the UC4 Support site. All support calls received via the Web are reviewed within one business day.

UC4 Technical Support via phone is available from 6:00 A.M. to 5:00 P.M. Pacific Standard Time, Monday through Friday. Emergency (24 x 7) technical support is available. Contact your UC4 Account Manager if you are interested in purchasing emergency support.

You can contact UC4 Technical Support at:

<table>
<thead>
<tr>
<th>United States</th>
<th>Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web: <a href="http://support.uc4.com">http://support.uc4.com</a></td>
<td>Web: <a href="http://support.uc4.com">http://support.uc4.com</a></td>
</tr>
<tr>
<td>Telephone: 1-877-277-9679</td>
<td>Telephone: +43 (2233) 7788-22</td>
</tr>
<tr>
<td>Email: <a href="mailto:support@uc4.com">support@uc4.com</a></td>
<td>Email: <a href="mailto:support@uc4.com">support@uc4.com</a></td>
</tr>
<tr>
<td>Fax: 425-562-9350</td>
<td>Fax: +43 (2233) 7788-99</td>
</tr>
</tbody>
</table>

Before you call UC4 Technical Support, please have the following information available:

- Version number of Applications Manager you are running
- Operating system on which Applications Manager is running (e.g. Sun, Hewlett-Packard)
- Operating system host name
- Operating system login information for the Applications Manager account(s)
- Database login information for the Applications Manager account(s)
- Problem reference number if you are making a follow-up call on a previous problem

If you are calling UC4 Technical Support for the first time, please be prepared to provide your name, company name, location, and phone number.

The UC4 Technical Support representative will give you a problem identification (PID) number. Please write down the number. If you call again about the same problem, the number will allow the representative to more quickly access the history of the problem.

What is New in Applications Manager 8.0

Applications Manager 8.0 includes several new features and enhancements from previous versions.

UC4 has always been known for their industry-leading and innovative capabilities in scheduling applications across enterprises. UC4 continues this tradition with the Applications Manager Version 8.0 release, once again demonstrating why it is the most innovative task scheduling company today.

New Look and Feel

For version 8.0 of the UC4 Automation Suite, both Applications Manager and Operations Manager now use a new, improved common look and feel. Several Applications Manager screens have been improved for ease of use, including the Jobs definition window and the Submit window.

Rapid Automation Agents for SCT Banner and VMware and FTP

New agents are now available for the SCT Banner and VMware and FTP. Benefits of these solutions include:

- Automated remote deployment
- No agent upgrades
- No more waiting for the next software version to upgrade
- Jobs run faster than with scripting solutions
- No new processes are spawned
- Login connection pooling saves time and is more efficient
- Highly customizable agent and job tabs are integrated into the product
- Solution version control
- All resources for a solution are located in a single file

New Replacement Values

Two new replacement values have been added. They are:

- {job}: The job name rather than its alias
- {subflow_id}: The flow id of the individual flow rather than its top level parent

Several additional replacement values that used legacy terminology have also been copied and renamed. For a full list, see topic 7.6 Replacement Value Descriptions in the Development Guide.

Notifications, Output Scans, and Environment Variables for Process Flow Components

Notifications, output scans, and environment variables can now be selected for process flow components. This was the most requested feature at the 2007 User Conference.
What Was New in Applications Manager 7.1

**New Client Login Report**

A new AW_CLIENT_LOGINS_REPORT report has been added to the already extensive list of actions audited in the Applications Manager environment. Applications Manager will keep track of the time each user logs into or out of the Applications Manager system. Monitoring logins is becoming one of the critical elements required to meet Sarbanes/Oxley compliance. For information on viewing reports, see topic 1.7 Viewing Operations Reports in the User Guide.

**Quick Searches for Tasks in the Backlog**

You can type the first few letters of a task name from the Backlog’s Search field, and Applications Manager will find it.

**Agent Groups and Machines Displayed in their Own Branches in the Explorer Window**

In the Explorer window, you can view agent groups in their own branch in the object tree. They are no longer part of the agents branch. Additionally, you can now view all the agents installed on each machine.

**New Status Detail Information in Backlog Task Summaries**

New status detail information in the Backlog Task Summaries shows why a task is not running. Tasks may not be eligible to run due to unsatisfied predecessors, queue status, agent status, automation engine status, conditions, or time settings. For more information on Backlog Task Summaries, see topic 4.5 Backlog and History Column Descriptions in the User Guide.

**Notifications, Output Scans and Environment Variables Shown in Task Details**

A task’s notifications, output scans, and environment variables are now shown on the General tab of the task’s Task Details window in the Backlog and History. For more information, see topic 4.10.1 General Task Details: Viewing and Editing in the User Guide.

**Re-Request from History**

You can now re-request a single task listed in the History pane of the Explorer window. To do so, right-click the entry and select the Request option. Applications Manager lists the selected job or process flow on a tab on the Submit window.

When you re-request process flow components this way, they will run with the same prompt values as the selected entry in History. All other settings, including alias name, conditions, predecessors, output settings, and queues will use the settings in the job definition.

**Send Email Attachments as PDF Files or in Zip Files**

When you email an output file from the Task Details or Output windows, or using a notification, you can now attach the output files as PDF files on in Zip files. For more information, see topics 3.5 Printing, FTPing, and Emailing Output Files in the User Guide and 2.6.2 Defining Notifications in the Development Guide.

**View Output Files in Any Application You Define File Associations For**

When viewing output files, you can now manually select an application when you want to view any output file if you have specified a file association for that application. For more information, see topic 3: Opening Output Files with Other Applications in the User Guide.
Focus Output Scan on the End of a Long File

You can optionally specify to start the scanning a number lines from bottom of the file with output scans. This is so you can just scan the end of very long files. For more information, see topic 2.6.1 Defining Output Scans in the Development Guide.

Scan .zip and .pdf Output Files

Output scanning now supports .zip and .pdf files.

Rename Email Attachments Sent with Notifications

A new option allows you to rename outputs when attached to email with a notification. For more information, see topic 2.6.2 Defining Notifications in the Development Guide.

Calculate Job and Process Flow Average Run Times Based on History

You can now calculate job and process flow average run times based on History using a calculate button on the General tab. For more information, see topics 2.6.5 Storing and Calculating Job Average Run Times and 3.14 Calculating Process Flow Average Run Times in the Development Guide.

Select Program Names for Jobs Using Agent Groups

You can now use the Select button next to the Program Name field on the General tab of the Jobs window to select a job's program name when the job is assigned to an agent group.

Create and Run ZOS Tasks

The new ZOS agent supports the full range of Applications Manager functions including launching tasks, tracking status, and capturing output. For more information, see chapter 2.14 Creating Jobs to Run on a ZOS Agent in the Development Guide.

New Formats for Prompts and ToolTips on the Submit Window

Prompts are now displayed in different formats on the Submit window when you make ad hoc requests. Prompt formats include radio buttons, check boxes, Select buttons, selectable dates from a calendar, and more. Prompt formats are selected when you define a prompt's data type. You also have the ability to add ToolTips to prompt descriptions. For more information on prompts and data types, see chapter 6: Adding Prompts to Jobs and Process Flows in the Development Guide.

Environment Variables in Prompt Values

You can now include environment variables in prompt values. The environment variables must be enclosed in {} curly brackets. When an environment variable is used in a prompt’s value, its corresponding environment variable object must be assigned to the task via its agent, application, program type, or job definition. For more information on prompt values, see topic 6.4 Adding, Updating, and Deleting Prompts in the Development Guide.

Comma Separated Prompt Values

A new setting for prompts allows you to select one or more values from a list and return them as a comma separated string. For more information, see topic 6.4 Adding, Updating, and Deleting Prompts in the Development Guide.
New Agent Type Logins for Data Types

You can now use agent type logins to request information from an agent’s application. Agent type logins are written in {} brackets. For example you can select {RME} or {PSE} and Applications Manager will run that SQL statement using the API connection it has to PeopleSoft or the remote automation engine. For more information, see topic 6.6 Defining Data Types in the Development Guide.

New File and Password Data Types

File data types allow you to select the files in a directory as a list of values. For more information, see topic 6.6.3 Using File Data Types in the Development Guide. Password data types allow you to enter passwords as prompt values. For more information, see topic 6.6.4 Using Password Data Types in the Development Guide.

New Predecessors from and to Sub Process Flows

Predecessors can now originate from and/or be assigned to components in sub process flows. For more information, see topic 5.5.1 Adding Internal Predecessor Links in Process Flows in the Development Guide.

New Active/Inactive Setting for Schedules

There is a new Active check box for job and process flow schedules.

New Conditions Types

Three new condition types have been added to Applications Manager:

- CHECK FILE FTP: Allows you to check for a file on any remote host that has a specified host login object.
- CHECK CONNECTION: Checks whether a login connection exists or does not exist. When selecting the login, you can first pick a login type to filter the list.
- ALWAYS TRUE: Takes an action every time a task is run. This serves the same purpose as entering 1=1 for a USER DEFINED condition.

For more information on condition types, see topic 8.4.2 Selecting Condition Types in the Development Guide.

New FTP_JAVA and SFTP_JAVA Jobs

Two new jobs have been added for file transferring. They are:

- FTP_JAVA: This is an updated version of the FTP job. It includes several prompts and prompt options not available on the original FTP job, such as mget and mput commands.
- SFTP_JAVA: This job uses secure FTP with SSH to transfer files.

For more information, see chapter 11: File Transferring in the Development Guide.

Simplified Email Output Devices and Interfaces

Applications Manager now ships with an email output interface object and an output device, both named AW_EMAIL. You can use the AW_EMAIL output device to send email on any supported operating system. For more information, see topic 2.8 Emailing Output in the Administration Guide.
Assigning User Options to a User Group

User options can optionally be assigned to user groups. When user options are assigned to a user group, all users with that user group will have that user option set to true for them. You cannot add, edit, or delete user option objects like other Applications Manager objects. You can only assign them to user groups. For more information, see topic 3.2.1 Setting User Options in the Administration Guide.

New Export Format Prompt for Report Jobs

When jobs are created from reports, they now include an ‘Export Format’ prompt. Use this prompt to determine whether to separate entries in a row by spaces, commas, or tabs. It is useful if you will be exporting the report to another application. For more information, see topic 5.11 Creating Jobs from Reports in the Administration Guide.

Parsing Oracle Errors in Triggers and Procedures from the Database Browser

You can parse Oracle errors in triggers and procedures from the database browser. For more information, see topic 5.13.2 Parsing Oracle Errors in Triggers from the Database Browser in the Administration Guide.

Enhanced Event Logging

With the enhanced event logging capabilities, Applications Manager can log status changes for tasks, agents, and the automation engine. You can use a monitoring tool such as HP OpenView, SNMP, Patrol, Tivoli, or Unicenter to query the output files and report Applications Manager statuses. For more information, see chapter 6: Event Logging in the Administration Guide.

Run Tasks Remotely on Other Automation Engines

You can now define remote execution agents that allow you to initiate jobs and process flows on one automation engine and run them on another. For more information, see chapter 7: Running Tasks on Remote Automation Engines in the Administration Guide.

AgentService Can Use Any RMI Server for Database Connections

The AgentService process now looks for RMI servers in a database table and connects to all RMI servers it sees. If the automation engine RMI server (the one at master_ip_address) goes down, the AgentService will use one of the other RMI servers to make database calls. For more information, see topic 8.5 The AgentService Process in the Administration Guide.

Automatic Log Rollover and Zip

When log files grow to approximately 50 megabytes, Applications Manager automatically rolls them over. When Applications Manager finishes writing to a log, it auto-zips it to save disc space. When the log directory reaches 500 megabytes, it is purged. Server logs are purged after 7 days. The rollover and purge settings are configurable. For more information, see topic 12.3.1 awenv.ini Replacement Values and Variables in the Administration Guide.

Customizable System Look and Feel or Theme

You can specify whether to use the system look and feel, or to set a theme. You might want to specify themes to differentiate your production automation engine from your development automation engine. For more information, see Appendix D: Specifying the Look and Feel and Theme for the Client in the Administration Guide.
Use Custom SSL Certificates for Connection Authentication

You can use a custom SSL certificate for connection authentication by creating `user_keystore` and `user_keystore_config` files. You can encrypt the password in the `user_keystore_config` file. For more information, see topic 2.10 Using Custom SSL Certificates for Connection Authentication in the Installation Guide.
1

Applications Manager Operations

1.1 Introduction to Applications Manager Operations ...................................................... 2
1.2 Using the Applications Manager Desktop ................................................................. 4
1.3 Working in the Applications Manager Windows ...................................................... 6
1.4 Editing General Desktop and ToolBar Settings ......................................................... 8
1.5 Setting Alerts ............................................................................................................ 10
1.6 Setting the User Interface Font ................................................................................. 12
1.7 Viewing Operations Reports ..................................................................................... 14
1.8 Customizing Tables .................................................................................................. 18
1.9 Changing Status Colors ........................................................................................ 20
1.10 Viewing the About Applications Manager Window ............................................... 22
1.11 Linking to Online Manuals and Applications Manager Web Sites ....................... 24
1.12 Launching the Applications Manager Client ......................................................... 26
1.13 Logging on to Applications Manager ...................................................................... 28
1.14 Getting More with Applications Manager Add-on Products ................................. 30
1.1 Introduction to Applications Manager Operations

As an operator, you will monitor tasks as they run through Applications Manager.

Applications Manager provides robust operations tools that make it easy for you to monitor and manage tasks as they execute. As an Applications Manager operator, you can:

- Monitor the system.
- Run tasks on an as-needed basis.
- See what tasks will run during your shift.
- Troubleshoot tasks.
- Take actions on tasks.
- Stage tasks up to 48 hours ahead.
- Handle exceptions to normal processing.
- View and print task output.
- Control load on the system.
- Prevent tasks from launching.
- Run tasks from the command line.
- Troubleshoot tasks.
- Prevent tasks from launching.
- Take actions on tasks.
- Run tasks from the command line.

Each of the areas of Applications Manager used by operators is described briefly below. Details for each are given in the remainder of this chapter and the chapters that follow.

Using the Explorer Window

The Explorer window is the primary tool you use to monitor and manage agents, queues, and tasks. A sample Explorer window is shown in Figure A.

![Figure A. The Explorer window.](image)

Viewing Forecasts

Using the forecast feature, you can view a list of scheduled jobs and process flows.
Requesting Jobs and Process Flows

There may be times when you want to run tasks outside of a set schedule. You can submit individual jobs and process flows from the Requests window. In Applications Manager, we refer to these as “ad hoc” requests.

Using the Graphical Analysis Package

Your license key determines whether the add-on features of the Graphical Analysis Package are included with your Applications Manager automation engine/agent instance. A license key with the Graphical Analysis Package gives you access to several windows including the following:

- **Graphical Forecast**: Displays scheduled jobs and process flows in a Gantt chart format.
- **Backlog Gantt View**: Displays the contents of the Backlog in a real-time Gantt chart format. You can take actions on tasks or view/edit their task details.
- **History Gantt View**: Displays in Gantt chart format how the components of a process flow in the History executed.
- **Dashboard**: Provides information about system performance.

For a complete list of Graphical Analysis Package features, see topic 1.14 Getting More with Applications Manager Add-on Products.

Viewing Operations Reports

Applications Manager comes with a set of predefined reports that provide information about your Applications Manager objects. If your product key includes the Graphical Analysis Package, you can also import an extensive set of Applications Manager History Analysis reports that you can use to review how tasks were processed. With the Graphical Analysis Package, you can also create your own custom reports.
1.2 Using the Applications Manager Desktop

From the Applications Manager desktop you can access all Applications Manager features and options.

You can access all Applications Manager features and options from the Applications Manager desktop.

![Figure A. The Applications Manager desktop.](image)

**Note:** If you are using a Windows client with 800x600 resolution, you will need to select the Windows auto hide taskbar option.

**ToolTips**

ToolTips provide a brief description of buttons, icons, and fields. To see a ToolTip, rest the mouse pointer over the button, icon, or field. A ToolTip appears after the mouse pointer has remained motionless for a second or two. In Figure A, the mouse pointer is resting on the Jobs icon in the toolbar. You can disable ToolTips by going to the **View** menu and unchecking the **ToolTips** option.
ToolBar and Menus

The toolbar consists of a row of icons running across the top of the screen. Click an icon to open its corresponding window. You can also access the windows in the toolbar from the Operations and Object Admin menu items.

Activities menu listings open windows where you can take actions such as opening Explorer or running ad hoc tasks with Requests.

Object Admin menu listings open selector windows where you can view, add, edit, or delete object definitions (depending on your user group access).

You can view or hide the toolbar by opening the View menu and checking the toolbar option. You can add or remove the icons displayed on the toolbar by selecting Settings from the Options menu. For instructions on editing desktop settings, see topic 1.4 Editing General Desktop and ToolBar Settings.

Taskbar

The taskbar is a graphic bar running across the bottom of the desktop that is used to select active windows. When you open an Applications Manager editing window, the window is represented by an icon in the taskbar. From the taskbar, you can right-click a window icon to:

• Restore a window to the desktop or minimize it to the taskbar. You can also display an active window by opening the View menu, selecting Windows, and choosing a window.
• Maximize a window to fill the desktop.
• Move a window to the front of the desktop.
• Close a window.

Selector windows are used when defining Applications Manager objects. They are not displayed on the taskbar because they do not contain unique information and are represented by icons on the toolbar.

Status Bar

The status bar is displayed across the bottom of the Explorer window. Its color alerts you to the status of the automation engine, agents, and tasks running in the Backlog. When the Explorer window is minimized it uses the same color scheme on the taskbar. For more information on the status bar, see topic 4.7 Monitoring with the Status Bar and Object Icons.

Closing All Windows or Selector Windows

To close all windows, go to the View menu and select Close all. To close only the selector windows, select Close selectors. For more information on selector windows, see topic 1.5 Adding, Editing, and Deleting Applications Manager Objects in the Development Guide.
1.3 Working in the Applications Manager Windows

In many of the Applications Manager windows, the columns can be sorted and rearranged. Applications Manager conforms to most GUI standards, including keyboard navigation.

In most Applications Manager windows that include a table, you can sort the entries, and size and rearrange the columns.

**Sorting Columns**

You can display the items within a column in ascending or descending order. Click the header of a desired column to view its entries in descending order. Click a second time to view the entries in ascending order. Note that the arrow to the right of the column name reflects this change. Some columns can be clicked a third time to display the entries in their default order. The arrow may be displayed in a separate column, or not at all, when entries are in their default order. You can click the columns additional times to cycle through the options.

**Copying Text from Rows**

To copy text from a table in an Applications Manager window, click one or more rows and enter Ctrl-C. You must select the entire row. You can then paste the text into an email, word processor, or other application of your choice.

**Temporarily Changing Column Order**

To temporarily change the order of the columns, use the mouse to point to the heading of the column you want to move, hold down the mouse button, and drag the column to the new position (see Figure A).

**Note:** These settings are not retained when you close the window. Many columns can be configured and saved. For more information, see topic 1.8 Customizing Tables.

**Copying, Cutting, and Pasting Text**

You can right-click in a field to bring up a pop-up menu with copy, cut, and paste options.

**Bringing Error Dialogs into View**

If you minimize the Applications Manager desktop when an error message is displayed, the Applications Manager desktop may seem to lock up. This is because the Error dialog is out of
view. To bring the error dialog back into view, hold down the Alt key and press the Tab key until you highlight the Java coffee cup icon.

**Keyboard Navigation**

You can use the following keyboard navigation in Applications Manager:

- Ctrl-Up arrow key sets the focus on the current tab, then the right and left arrow keys will navigate to the other tabs. Ctrl-Down arrow key returns focus to the page.
- If a table has focus, then Ctrl-Tab will move the focus out of the table.
- When you are in a table, Enter and Tab are used for navigation within the table.
- To alternately expand and collapse an object’s key, press Enter.
- To select a mnemonic key, click Alt+<the key>.

**Assigning Options.**

When required, you assign options and objects using the type of window shown in Figure B.

![Figure B. Double-click or use the arrow key to assign/unassign options.](image)

Assign objects by moving them from the **Unassigned** column to the **Assigned** column. The table below describes how to assign multiple options.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a selected value between the two columns</td>
<td>Double-click the value.</td>
</tr>
<tr>
<td></td>
<td>-or- Select the value and click the single arrow button.</td>
</tr>
<tr>
<td>Move all values between the two columns</td>
<td>Click on the double arrow button.</td>
</tr>
<tr>
<td>Make multiple contiguous selections</td>
<td>Hold down the Shift key and click the first and last values.</td>
</tr>
<tr>
<td>Make multiple nonadjacent selections</td>
<td>Hold down the Control key and click on each value.</td>
</tr>
</tbody>
</table>
1.4 Editing General Desktop and ToolBar Settings

To edit general Applications Manager and ToolBar settings, select Settings from the Options menu.

You can edit and save general, toolbar, and alert desktop settings. These settings apply only to your workstation while you are logged in to an Applications Manager session.

Editing General and Toolbar Settings

To set the Applications Manager desktop settings:
1. From the Options menu, choose Settings. Applications Manager displays the General tab of the Settings window shown on the left in Figure A. The settings are described in Table A.
2. You can customize the toolbar by adding and removing icons. To add or remove icons on the toolbar, select the Toolbar tab shown on the right in Figure A.
3. To move items between the Unassigned and Assigned columns, double-click or use the arrow keys.
   For details on assigning and unassigning values, see topic 1.3 Working in the Applications Manager Windows.
4. You can set alerts in Applications Manager that are triggered by the status of tasks in the Backlog by selecting the Alerts tab. For example, you can play a sound whenever a task aborts. For more information, see topic 1.6 Setting the User Interface Font.
5. Applications Manager can log status changes for tasks, agents, and the automation engine. If you have the DBA user group, you can configure status logging options from the Task Events and Agent Events tabs of the Settings window. If you do not have the DBA user group, you will not see these tabs. For more information, see chapter 6: Event Logging in the Administration Guide.
6. To save the settings for the current session and future sessions, click OK.
Table A. Applications Manager Desktop Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explorer Refresh Seconds</td>
<td>You control the Explorer window’s automatic refresh rate by entering a number of seconds in this field. In Figure A, the refresh frequency is set to 10 seconds (the lowest number of seconds available). You can also manually refresh by entering Ctrl-R or by clicking the status bar on the Explorer window.</td>
</tr>
</tbody>
</table>
| History Display Minutes  | You control how long records are displayed in History using the Previous minutes field. For example, if you set Previous minutes to 60, only tasks that have run within the last 60 minutes will be displayed.  
Note: In some cases records will remain in History beyond this setting due to predecessor requirements.  
In Figure A, the Previous minutes field is set to 30.  
The amount of History displayed when you log in to the client is determined by the HistoryRetentionTime setting in the Options.properties file. For more information on the HistoryRetentionTime setting and the Options.properties file, see topic 12.4 Options.properties File in the Administration Guide.  
Caution! The higher you set your Previous minutes, the more memory you will use. You can always run a History query to view older tasks in History. For more information on History queries, see 5.2 Querying for Tasks in History. |
| Use Database Time Zone   | If this option is selected, times shown in the Submit window are based on the time set for the Applications Manager database. If it is not selected, then the times shown in the Submit window are local time based on the client machine. This is translated to database time for running the task.  
Times shown in the Backlog, History, on the status bar, and in the lower right corner of the Explorer screen are always in database time. |

What Are User Options?

User options are additional settings selected by your Applications Manager administrator. They control user access to Applications Manager features such as the Hide feature in the Output window. For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.
1.5 Setting Alerts

You can set alerts in Applications Manager that will be triggered by the status of tasks in the Backlog.

If the color change in the status bar is not a sufficient alert for your monitoring purposes, you can set additional alerts for specific statuses. For example, you might have a sound or voice message play when a task aborts. Alerts launch a program or script on the client machine while you are logged on. To set the alerts, use the Alerts tab on the Settings window shown in Figure A.

![Figure A. You can set alerts for specific statuses.](image)

**Statuses**

You can define alerts for the following statuses:

- Aborted task: when a task completes with a non-FINISHED status such as ABORTED
- Hold task: when a task goes into a HOLD status
- Agent trouble: when an agent goes into a status that requires operator intervention such as a BUSY or TROUBLE
- All clear: when all task/agent statuses are changed so that tasks are eligible to run again

You can choose to trigger the alert when the first task or agent displays the status, or every time a new task or agent displays the status.

**Local Windows Programs**

An alert runs a local Windows program that you specify in the field next to the alert category. You must enter a command which includes the full path to the program file. In Figure A, commands like the following are used to play .wav files with the operating system's default player:

```cmd
cmd /c="C:\Sounds\abort_task.wav"
```

You may want to create custom scripts to run as alerts.
Procedure

To set an alert:

1. Display the Settings window by opening the Options menu and choosing Settings.
2. Select the Alerts tab as shown in Figure A.
3. For each type of alert, enter a fully-pathed program name, or click the Select button and choose the program name.
   
   **Note:** The program you choose must be an executable or Applications Manager will return an error message when the task/agent goes into the specified status.
4. To activate the alerts, click the Alerts on option.
5. Choose one of the frequency options:
   - **First time:** The alert is executed the first time a task or agent shows the indicated status. The alert will not be executed again as long as that task or agent remains in the indicated status. For example, if three tasks abort at the same time, you will get only one alert.
   - **Every time:** The alert is executed every time a task or agent shows the indicated status. For example, if three tasks abort at the same time, you will get three alerts.
6. To save the alert definitions, click OK.

Creating Notifications

Applications Manager notifications send messages and output files, based on task status, to any output device defined in Applications Manager. For information on defining notifications, see topic 2.6.2 Defining Notifications in the Development Guide.

Applications Manager can log status changes for tasks, agents, and the automation engine. If you have the DBA user group, you can configure status logging options from the Task Events and Agent Events tabs of the Settings window. If you do not have the DBA user group, you will not see these tabs. For more information, see chapter 6: Event Logging in the Administration Guide.
1.6 Setting the User Interface Font

You can adjust the size of the user interface font from the Font tab or the Settings window. You must entirely exit the Applications Manager client for the change to take effect.

To set the font size, use the **Font** tab on the **Settings** window shown in Figure A. After selecting a font size and clicking **OK**, you must close the Applications Manager client, re-open it, and log into a new session for the new font size to take effect. Re-logging in from the **File** menu will not make the change.

*Figure A. After selecting a font size, you must exit the client and re-open it to see the change.*
1.7 Viewing Operations Reports

To view reports for an object type, open that object’s selector window and click Reports.

Applications Manager comes with a set of reports that provide information about the Applications Manager objects. If your product key includes the Graphical Analysis Package, you can also import an extensive set of Applications Manager History Analysis reports that allow you to review how tasks were processed. With the Graphical Analysis Package, you will also be able to create your own custom reports. A report that audits schedule changes is shown in Figure A. Additional reports may be created if users have the necessary user group access. For information on creating reports, see chapter 5: Creating Reports and Browsing the Database in the Administration Guide.

You can view reports for each of the operations windows and selector windows.

<table>
<thead>
<tr>
<th>To view reports for:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>An object type</td>
<td>Open that object’s selector window and click Reports.</td>
</tr>
<tr>
<td>An operations window</td>
<td>Open the operations window and choose the report type from the Reports menu.</td>
</tr>
</tbody>
</table>

This opens the Reports window and selects the report type corresponding to the window you opened it from. In Figure B, the Reports button is selected on the Jobs Selector window, opening the Reports window with the Jobs type highlighted.
To view reports for another object type, select that object type from the **Type** box. If an object is not listed in the **Type** box, there are no reports for it. Once you select a report, click the **Show** button.

![Figure B. Select a report on the Reports window.](image)

**Enabling Audit Reports**

To run auditing reports, your Applications Manager administrator must enable auditing for the automation engine. For more information, see topic 4.6 *Enabling Applications Manager Auditing* in the *Administration Guide*.

**Prompt Values**

Some reports require you to enter prompt values. If the report you select requires prompt values, you must respond to the prompts in the **Report Parameters** window shown in **Figure C**. Once prompt values are provided (if necessary), Applications Manager displays the report in its own window as shown in **Figure A**.

![Figure C. Enter prompt values](image)

**Changing the Lines per Page**

You can specify the number of lines displayed on each page using the **Lines per Page** field. The new setting will go into effect when you click the **Redisplay** button. Doing so will update the time and date in the report header, but not the data displayed in the report.
Running Applications Manager History Analysis Reports

With the purchase of the Graphical Analysis Package, you receive several pre-defined reports that analyze your task history. These reports are referred to as Applications Manager History Analysis or AHA reports. They include an AHA prefix designation in their names. For example, the AHA-FINISHED_JOBS_BY_STATUS_HR report returns completed tasks according to status by hour. Data relating to AHA reports is generated and loaded into Applications Manager by running the CALC_HISTORY_STATISTICS job. For more information, see topic 5.12 Retrieving Historical Data for Applications Manager Historical Analysis Reports in the Administration Guide.
1.8 Customizing Tables

In many of the Applications Manager windows, you can choose the columns you want displayed. You can also change the order of the columns and change the column names.

Many of the Applications Manager windows display tables of information. In these windows, you can choose the columns displayed and their order using Setup windows.

The tables that you can customize are listed below:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Customizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlog</td>
<td>All views of the <strong>Backlog</strong> viewable from the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>History</td>
<td><strong>History</strong> on the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>Output</td>
<td>The <strong>Output</strong> window.</td>
</tr>
<tr>
<td>Agent Summary</td>
<td>The <strong>Agent Summary</strong> on the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>Queue Summary</td>
<td>The <strong>Queue Summary</strong> on the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>Process Flow Summary</td>
<td>The <strong>Process Flow Summary</strong> on the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>Status Summary</td>
<td>The <strong>Status Summary</strong> on the <strong>Explorer</strong> window.</td>
</tr>
<tr>
<td>Task Output files</td>
<td>The <strong>Output files</strong> tab on the <strong>Task Details</strong> window.</td>
</tr>
<tr>
<td>Agent Logs</td>
<td>The <strong>Agent Logs</strong> window.</td>
</tr>
<tr>
<td>Gantt task summary</td>
<td>The information displayed in the pop-up table when you hover over a job or process flow in the <strong>Backlog Gantt view</strong> window and the <strong>Flow Diagram</strong> window.</td>
</tr>
<tr>
<td>Backlog task summary</td>
<td>The information displayed in the pop-up table when you hover over the Run ID column for tasks in the <strong>Backlog</strong>.</td>
</tr>
</tbody>
</table>
The steps for choosing columns and changing the column order are the same for all tables. To edit a table, open the Options menu, select Tables, then select the table you want to edit. The Setup window for the Queue Summary table is shown in Figure A.

The top of the window shows the table as it will be displayed in Applications Manager. The bottom of the window displays a list of the columns that can be displayed. For a description of all customizable columns, see Appendix C: Customizable Columns in the Administration Guide.

Making Changes

The table below describes how to customize Applications Manager tables.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a column</td>
<td>Check the VISIBLE column. All visible columns are brought to the top of</td>
</tr>
<tr>
<td></td>
<td>the list. Newly checked columns are added to the far right side of the</td>
</tr>
<tr>
<td></td>
<td>table. You can click the title of the column in the top display and drag</td>
</tr>
<tr>
<td></td>
<td>it to a new location.</td>
</tr>
<tr>
<td>Change the name of</td>
<td>Edit the entry in the Name column.</td>
</tr>
<tr>
<td>a column</td>
<td></td>
</tr>
<tr>
<td>Control the width</td>
<td>Enter a number of pixels in the MAX_WIDTH and MIN_WIDTH columns. If you</td>
</tr>
<tr>
<td>of a column</td>
<td>enter MIN_WIDTH settings, its possible that some columns will be pushed</td>
</tr>
<tr>
<td></td>
<td>off the table. If this happens, select the Horizontal scrolling option</td>
</tr>
<tr>
<td></td>
<td>described below.</td>
</tr>
<tr>
<td>Format date columns</td>
<td>Select a date format from the FORMAT column.</td>
</tr>
<tr>
<td>Control the margins within a column</td>
<td>In the Column margin field, enter a number of pixels to be added to the left and right margins of the column.</td>
</tr>
<tr>
<td>Allow scrolling</td>
<td>By default, tables do not scroll. As you add columns, Applications</td>
</tr>
<tr>
<td></td>
<td>Manager adjusts the width of the columns so they are all displayed in the</td>
</tr>
<tr>
<td></td>
<td>table. If the tables become to narrow to read the contents, you can select</td>
</tr>
<tr>
<td></td>
<td>the Horizontal scrolling option. This maintains the default width of the</td>
</tr>
<tr>
<td></td>
<td>columns and displays a scroll bar across the bottom of the table.</td>
</tr>
<tr>
<td>Change the order</td>
<td>Select the title of a column in the top window and drag it to a new</td>
</tr>
<tr>
<td>of the columns</td>
<td>location.</td>
</tr>
<tr>
<td>Return the table</td>
<td>Click the Reset button at the bottom of the window.</td>
</tr>
<tr>
<td>to its last saved setting</td>
<td></td>
</tr>
</tbody>
</table>

Default Settings

Your Applications Manager administrator can set default settings for Applications Manager tables. If you customize tables, the default settings are overridden. For more information on setting table defaults, see topic 3.2.2 Customizing Applications Manager Defaults with DEFAULT_USER in the Administration Guide.
1.9 Changing Status Colors

You can change the colors used to indicate statuses for tasks, agents, and the automation engine in the Backlog and History.

In the Backlog and History on the Explorer window, Applications Manager displays a task’s status in the Status column. To provide visual cues, Applications Manager uses colors for the statuses. For example, green is RUNNING, yellow is HOLD, and red is ABORTED. If you wish, you can change the colors used for groups of statuses.

![Status colors window](image)

*Figure A. You can change status colors for groups of statuses.*

**Procedure**

To change the color for a group of statuses:

1. From the Options menu, select **Status colors**. Applications Manager displays the **Status colors** window shown in Figure A.
2. Select the status group you want to change and click **Edit**. Applications Manager displays the color selection window shown in Figure A. Statuses included in each group are listed in Table A.
3. Select a color and click **OK**.
### Table A. Status Color Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Statuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready to run</td>
<td>QUEUED</td>
</tr>
<tr>
<td>Time Dependent</td>
<td>DATE PENDING</td>
</tr>
<tr>
<td>Resource Dependent</td>
<td>SELF WAIT, QUEUE WAIT, CONDITN WAIT, UNAVAILABLE, AGENT WAIT, PRED WAIT</td>
</tr>
<tr>
<td>Intermediate Completion</td>
<td>STG SKIP, PW-SKIP, PW-DELETE</td>
</tr>
<tr>
<td>Hold</td>
<td>HOLD PRED WT, HOLD</td>
</tr>
<tr>
<td>Staged</td>
<td>STAGED HOLD, STG_PW HOLD, STAGED, STAGED_PW</td>
</tr>
<tr>
<td>Running</td>
<td>LAUNCHED, STARTING, RUNNING</td>
</tr>
<tr>
<td>Completion</td>
<td>FINISHED, SkipCond, CANCELLED, DELETED</td>
</tr>
<tr>
<td>Error</td>
<td>DB ERROR, RESUMED, STARTED, STOPPED, ERRORS, EXPIRES, EXPIRED, IDLED, TROUBLE, BUSY, CHECK LOG, INACTIVE, BAD CONNECT,BAD MJN, BAD TYPE, BAD BATCH, BAD LIBR, BAD LOGIN, HOST FAILURE, BAD QUEUE, BAD DATE PRM, BAD SQL STMT, BAD MODULE, BAD_AGENT, FILE_ERROR, START_ERROR, START_FAILED, RECURSIVE, BAD CONDITN, DIED, ABORTED, KILLED, TIME-OUT, LAUNCH ERROR</td>
</tr>
<tr>
<td>Intermediate Error</td>
<td>DEAD, ABORTD, KILL, TIME-OUT, KILL1, KILLING, LAUNCH ERR</td>
</tr>
</tbody>
</table>

**Default Settings**

Your Applications Manager administrator can set default values for status colors. If you customize status colors, they override the default settings. For more information on setting status color defaults, see topic 3.2.2 Customizing Applications Manager Defaults with DEFAULT_USER in the Administration Guide.
1.10 Viewing the About Applications Manager Window

To view the About Applications Manager window, open the Help menu and select About Applications Manager.

Use the About Applications Manager window to view details about your Applications Manager build. This information may be requested if you call UC4 Technical Support. When you select the About Applications Manager menu item from the Help menu, Applications Manager displays the About Applications Manager window shown in Figure A.

![Figure A. The About Applications Manager window.](image)

The About Applications Manager window includes:
- The Applications Manager version and build number
- Workstation Java VM information
- Server Java VM information
- Java VM free memory information
- The DNS name and IP address of the computer you are using
- The RMI host’s DNS name and IP address
- The RMI host’s port number
- The Oracle database version and details

To place the system information on your clipboard, click Copy.

To view copyrights for third party software used by Applications Manager, click Copyrights. Copyright information also exists in the copyrights directory on the Applications Manager automation engine.
Setting Debug from the Applications Manager Client

You can turn on debug for the Applications Manager client, the RMI server, or Oracle trace by selecting options in the Debug menu. For more information, see topic 10.4 Setting Client, Server, Oracle Trace, and All Agent Debug in the Administration Guide.
1.11 Linking to Online Manuals and Applications Manager Web Sites

The Applications Manager Help window includes all the Applications Manager manuals online. PDF manuals are available on the Applications Manager Support site. You can link to the Applications Manager Support site or the Applications Manager home page from the Help menu.

Use the Applications Manager Online Manuals option on the Help menu to view the Applications Manager manuals online. When you select the Applications Manager Online Manuals menu item, Applications Manager opens the Applications Manager Help window shown in Figure A.

Many of the Applications Manager windows include context sensitive Help buttons or menu items that link to a corresponding topic in the Applications Manager manuals.

The Applications Manager Help window includes table of contents, index and search tabs. This index is a combined index of all the Applications Manager manuals.
By default the Applications Manager Help window is displayed in the top left corner of the screen. Its default size is 800 by 600 pixels. Your Applications Manager administrator can change these settings for all users. For more information, see Appendix B: Changing the Default Size and Location of the Help Window in the Administration Guide.

PDF files for all Applications Manager manuals are available on the Applications Manager Support site. A new PDF file is generated each time its corresponding manual is printed. Occasionally new functionality is added to an Applications Manager version and bugs are fixed throughout each version’s life cycle. Therefore, the most recent edits to the manuals are included in the online help of each Applications Manager build.

### Connecting to the Applications Manager Web Sites

Use the Applications Manager Web Site item on the Help menu to access information about Applications Manager products and services. Use the Applications Manager Support item to open new support issues, check the status of open support issues, browse our Frequently Asked Questions, view announcements and holiday information, view release notes, browse our Knowledge Base, and read the current and back issues of our newsletters.

When you select the Applications Manager Web Site or Applications Manager Support menu items, Applications Manager launches a Web browser and opens the appropriate site.

### Visiting the Applications Manager User Forum

The Applications Manager User Forum is a place where you can network with other Applications Manager users to trade tricks, tips and best practices. Check on the latest product developments, find out about new service offerings, and make new friends and connections.

To register, visit [http://forum.appworx.com](http://forum.appworx.com) and fill out a short registration form. The forum content is available only to current Applications Manager customers.
1.12 Launching the Applications Manager Client

To launch Applications Manager for the first time, enter the Applications Manager URL and select an option to either launch using Java Web Start or the Java Plugin.

You launch Applications Manager from the Introduction to Applications Manager page shown in Figure A. The location of the Introduction to Applications Manager page is http://<automation engine IP address>:<Apache port>/<automation engine name>/Intro.html.

**Note:** If you are using Internet Explorer, this page will include a link to install Java2. With other browsers, you may automatically be prompted to install Java2 if you do not have it.

From this page you can launch the Applications Manager client in one of a few ways as described in the table below.

<table>
<thead>
<tr>
<th>To open the Applications Manager client using:</th>
<th>Click the following link:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java WebStart without support for loading Rapid Automation solutions or running Web Service solutions</td>
<td>Start the Applications Manager Client under the Java WebStart section.</td>
</tr>
<tr>
<td>Java WebStart with support for loading Rapid Automation solutions and running Web Service solutions</td>
<td>Start the Applications Manager Client (fully featured) under the Java WebStart section.</td>
</tr>
</tbody>
</table>
If you have the AppMaster add-on product, you can also open the AppMaster client from this page. For more information on AppMaster, see topic 1.14 Getting More with Applications Manager Add-on Products.

### Creating Shortcuts

If you use Java WebStart, which is recommended, you can create desktop and start menu shortcuts by selecting an option on the Advanced tab of the Java Control Panel window. You access the Java Control Panel window by selecting Java from the Windows Control Panel.

### The Applications Manager Signed Certificate

UC4 provides a signed security certificate with its Applications Manager Java client. By granting the certificate when you first launch the Applications Manager Java client, you can bypass the need to set up an individual Java security policy file for each user. This certificate guarantees that the Applications Manager applet code is tamper-free.

When you first launch Applications Manager, a Java Plug-in Security Warning window is displayed. You are asked to either grant or deny a signed certificate provided by UC4 Software, Inc., asserting that the Applications Manager application code is safe to download to your system.

The certificate also gives you access to clipboard functionality and user configuration files. If you choose to deny the certificate, you will have to modify the policy file permissions for each of your client users to use the clipboard for capturing information for support. Notice that the user can choose to grant the certificate for the current session only, or to grant it always. If the certificate is granted always, the user will not have to go through this security check each time an Applications Manager session is launched.

### Launching Applications Manager from the Command Line

If you are running on a console or through an X-Windows enabled terminal, you can type appworxj (or in Motif, startso client) to launch Applications Manager. When you launch the client from the command line, you won’t be able to use hyperlinks in task documentation.

### Accessing the Client Through a Firewall

If you will be accessing the Applications Manager client through a corporate firewall, you must open the appropriate ports, and specify those ports in the Options.properties file on the host machine. For details, see 2.2 Configuring the Applications Manager Client in the Installation Guide.

<table>
<thead>
<tr>
<th>To open the Applications Manager client using:</th>
<th>Click the following link:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Java Plugin <em>without</em> support for loading Rapid Automation solutions or running Web Service solutions</td>
<td>Start the Applications Manager Client under the Java Plugin section.</td>
</tr>
</tbody>
</table>
1.13 Logging on to Applications Manager

To log on to Applications Manager, enter your user name and password and select OK.

When you launch the Applications Manager client, it displays the Logon window shown in Figure A.

Logging On

To log on to the Applications Manager client:

1. At the Logon window, enter your Applications Manager user name and password, and select an automation engine from the drop-down list.

User names are not case sensitive, but passwords are.

**Note:** If you do not know your user name and password, check with your Applications Manager administrator.

2. To have Applications Manager remember your user name and automation engine, select the Remember logon button.

3. Select the automation engine you wish to log into. For information on adding additional automation engines to this drop-down list, see topic 1.5 Accessing Multiple Applications Manager Instances from One Client in the Administration Guide.

4. Select a language, or accept ‘User default’. For information on languages, see topic 1.6 Translating Languages in the Administration Guide.

5. To accept the entered information and log on to Applications Manager, click OK.

**Note:** If you have a large number of output files or tasks in the Backlog, Applications Manager will display a message alerting you that the display has been truncated.
When you log out of Applications Manager, the following settings are remembered the next time you log back in:

- The size and position of Explorer and Backlog Gantt View and Dashboard windows.
- The size and position of the main Applications Manager client window
- The content pane of the Explorer window (if open)
- Whether a saved Backlog/History Filter was selected

**Receiving RmiServer Error Broadcasts**

If the Receive RmiServer Error Broadcasts user option is assigned to your Applications Manager user, the RmiServer Errors window might pop up with one or more errors when you log in.

When the Receive RmiServer Error Broadcasts user option is assigned to a user, any RMI errors will be displayed in a pop-up window as they occur. Additionally, if any RMI errors occurred since the last time the RMI server was started, the last ten errors will be displayed in a pop-up window each time the user logs on.

**Note:** If you have the DBA user group, you can clear the RMI errors without stopping the RMI server by selecting Clear RMI Errors from the View menu on the Applications Manager Desktop.

For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.

**Re-Logging on to Applications Manager**

There may be times when you want to log on to Applications Manager under a different user name or connect to a different automation engine. To change your logon from the desktop, go to the File menu and select Re-Login. You will have to re-enter your password when you re-log in, unless the Disable clearing of login passwords on re-login automation engine option is checked. For more information on automation engine options, see topic 4.4 Setting Automation Engine Options in the Administration Guide.

**Changing Your Password**

You can change your password at any time. Your Applications Manager administrator can also set your password to expire after a certain period of time.

To change your Applications Manager password go to the Options menu on the Applications Manager desktop and click Change Password.
1.14 Getting More with Applications Manager Add-on Products

Your license key determines whether the Graphical Analysis Package, AppMaster, Web service, and Java Message Service add-on products are included with your Applications Manager automation engine/agent instance.

The following add-on features can be purchased with Applications Manager:

- The Graphical Analysis Package
- AppMaster
- Web services support
- Java Message Service support

These are sold separately. Your license key determines whether these add-on features are included with your Applications Manager automation engine/agent instance.

Graphical Analysis Package Features

A license key with the Graphical Analysis Package Features includes the following features:

- **History Gantt View**: Displays the components of a process flow in History and how they executed.
- **Graphical Forecast**: Displays scheduled jobs and process flows in a Gantt chart format.
- **Backlog Gantt View**: Displays the contents of the Backlog in a real-time Gantt chart format. You can take actions on tasks or view or edit their details.
- **Dashboard**: Provides information about system performance, including:
  - **Backlog Distribution**: Displays the percentage of tasks in the Backlog by status.
  - **Workload Balancing**: Displays the percentage of running tasks by agent.
  - **Progress of Day**: Displays the number of tasks scheduled for the day and the number that have completed.
  - **Agent Loading**: Displays the task count and thread capacity used for each agent.
  - **Queue Loading**: Displays the thread count and capacity used for each queue.
  - **Daily Activity**: Displays the maximum number of tasks running each hour of the day.
- **Process Flow Gantt View**: Displays the contents of a process flow in a Gantt chart format.
- **Process Flow Simulation**: After you have created a process flow, you can check to see if the components will execute in the correct order by running a process flow simulation. When you run a simulation, Applications Manager steps through the process flow using the predecessor links.
- **Custom Reports**: You can create additional reports as Applications Manager objects to run against the Applications Manager database or other databases.
Applications Manager History Analysis Reports: With the purchase of the Graphical Analysis Package, you receive several pre-defined task history reports. These reports are referred to as Applications Manager History Analysis or AHA reports.

AppMaster Features

AppMaster is an add-on product for the Applications Manager product. From the AppMaster window, you monitor one or more views of any combination of the following as defined on your system:

• Automation engines
• Agents
• Tasks by application

To use AppMaster, you must have the same version of Applications Manager on all automation engines and all processes must be running for all automation engines. Additionally, the Masters.properties file must be configured for each automation engine you wish to work with. For more information, see topic 12.6 Configuring Masters.properties for AppMaster in the Administration Guide.

Web Service Features

Applications Manager offers two Web service solutions.

• External Web services
• Internal Web services

Each solution is its own add-on product you can purchase.

Applications Manager can execute external Web services. With Applications Manager, you can create Web service logins and calls to methods. You define calls to the methods using substitution variable definitions and a Web service data type. Once defined, you invoke a method by calling its subvar in a prompt or condition.

Using Applications Manager Web services, external prompts can retrieve a variety of information from Applications Manager and perform the most common operations functions externally.

For more information on Web services, see chapter 17: Working with Web Services in the Development Guide.

Java Message Service Features

The Java Message Service (JMS) allows you to develop business applications that asynchronously send JMS messages to queues or topics. It defines a common enterprise messaging API that is designed to be easily and efficiently supported by a wide range of enterprise messaging products. In Applications Manager, you can send JMS messages with conditions and retrieve messages from other applications as Applications Manager subvars. For more information on JMS support, see chapter 18: Sending and Retrieving JMS Messages in the Development Guide.
Activating Add-on Products

The Graphical Analysis Package, AppMaster, and JMS are installed as part of the Applications Manager product. Web services require additional install components, which are included as an option for a standard Applications Manager automation engine install/upgrade. AppMaster, JMS, and Web services require configuration before they can be used.

To use any of these add-on products, you must have a valid product key. For information on purchasing Applications Manager add-on products, contact your UC4 account representative or UC4 Support.
Chapter 1: Applications Manager Operations
2

Requesting Jobs and Process Flows

2.1 Introduction to Requesting Jobs and Process Flows ...................................................... 36
2.2 Requesting Jobs and Process Flows ............................................................................... 38
2.3 Submitting Jobs and Process Flows .............................................................................. 40
2.1 Introduction to Requesting Jobs and Process Flows

You can request jobs and/or process flows on an ad hoc basis. After requesting one or more jobs/process flows, you can view their statuses from the Explorer window.

There may be times when you want to run tasks outside of a set schedule. You can submit individual jobs and process flows from the **Requests** window. We refer to these as “ad hoc” requests.

![Figure A. Select one or more jobs or process flows and click Request, or simply double-click a single job or process flow to request it.](image)

**Requesting and Submitting Jobs and Process Flows**

The ability to request jobs and process flow on an ad hoc basis offers a useful way to request tasks that have not been scheduled ahead of time.

When requesting jobs and process flows, you use the following two windows:

- The **Requests** window shown in Figure A is used to select one or more jobs/process flows.
- The **Submit** window shown in Figure B is used to complete prompts, select options, and submit the requested jobs and process flows to the Backlog.

When you request tasks, you can set the start date and time, queue, designated output device, send option, number of copies, and output function (LOG, PRINT, or STORE). You can also enter values to customize a job or process flow if prompts have been defined.
Checking Task Statuses

After submitting a job or process flow, you can view its status in the Backlog and History. For information on the Backlog and History, see chapter 4: Monitoring and Managing Tasks in Explorer.

Viewing Output

After a job executes, you can view and print output online using the File Viewer window. You can access the File Viewer window from the Explorer, Backlog Gantt view, and Output windows. For information on viewing and printing output, see chapter 3: Viewing and Printing Output.

Re-Requesting Tasks from History

To re-request a task listed in the History pane of the Explorer window, right-click the entry and select the Request option. Applications Manager lists the selected job or process flow on a tab in the Submit window.

When you re-request a process flow component this way, it will run with the same prompt values as the selected entry in History. All other settings, including alias name, conditions, predecessors, output settings, and queues will use the values set in the job definition.

Figure B. The Submit window
2.2 Requesting Jobs and Process Flows

To request jobs and process flows, open the Requests window, select one or more jobs and/or process flows, and click Request, or simply double-click to submit a single job or process flow. The selected jobs and process flows are displayed in the Submit window where you can set options and parameters.

The Requests window offers a quick and easy way to request jobs and process flows.

**Figure A. The Requests window**

**Procedure**

To request one or more jobs from the Requests window:

1. Open the Requests window shown in Figure A by doing one of the following:
   - Open the Activities menu and select Requests.
   - Select the Requests icon from the toolbar.

2. If appropriate, select an application from the Application list box on the left side of the screen.
   Applications specify a group of jobs and process flows. The application you select determines the jobs and process flows displayed in the table. Only the applications and jobs assigned to you via user groups will be displayed.

3. Select one or more jobs from the list of jobs and process flows on the right side of the screen. To select more than one object, use Shift-Click or Ctrl-Click.

   When selecting a job/process flow, you can type the first few letters of its name in the Search field and Applications Manager will find it. The Search field accepts valid regular expressions. For information on the syntax for regular expressions, see Appendix A: Regular Expression Tables in the Development Guide.

   **Note:** You can double-click to quickly request a single job or process flow.

   In Figure A, three jobs are selected.
4. If the **Requestor** field is active, you can select the Applications Manager user that will be assigned to the job/process flow.
   You must have the **Select Requestors** user option assigned to you by your Applications Manager administrator to select a different user in this field.

5. To have the Request window automatically close upon request, check the **Close on Request** box.

6. To request the job(s), click **Request**.
   Applications Manager opens the **Submit** window and displays the selected items as tabs (see Figure B). Each job can be viewed by selecting its tab. In Figure B, three jobs have been requested: JOB_REPORT, MODULE_REPORT, and REPORT_BATCH.

   ![Figure B. The Submit window](image)

   If any jobs or process flows you select have agent groups assigned to them with application agents, you will be prompted in a pop-up window to select which agent you want to use to validate prompts. You will still be able to select the agent or agent group for these tasks to run on from the **Submit** window.

**Next Step**

After requesting one or more jobs and/or process flows, the next step is to enter prompt values, select options, and submit. For more information, see topic 2.3 **Submitting Jobs and Process Flows**.
2.3 Submitting Jobs and Process Flows

Before you submit a job or process flow, you can specify values for prompts and options such as output settings, queues, agents, and start date.

After requesting jobs and process flows, they are displayed in the Submit window shown in Figure A. You can enter values for the prompts and options before you submit the jobs and process flows.

**Figure A.** You can respond to prompts and set the Options to control output, queues, agents, start date, and more.

**Procedure**

To respond to prompts and submit options:

1. Respond to the prompts in the Prompts box. Prompts are defined by an Applications Manager developer and are specific to the job or process flow. They are most often used to pass values to the program being run by a job. When a prompt includes a Select button as shown in Figure A, you can click it to select a single value or multiple values from a list of options (depending on the job/process flow definition).

   Selecting values from lists helps to eliminate data entry errors. For information on selecting options from a list, see topic 1.3 Working in the Applications Manager Windows.

2. If the Send To option is active, select an output device from the drop-down list.

   The output devices displayed in the list are determined by the output group assigned to the job or process flow. If the Send To option is not active, an output group was not assigned to the job/process flow. You can still run the job/process flow and view output online, but the output will not be sent to an output device.
3. If the **Send Option** is active, select an option from the drop-down list.
   The **Send Option** will be active if an output option is defined for the output device you select. For more information, see topic 2.6 Adding Output Options to Output Interface Definitions in the Administration Guide.

4. Select an output function from the **Output Function** drop-down box. The output function determines how output is handled. With any of these settings, the application output or report files and the system output files are viewable from the **Explorer** window. There are three choices:
   - **LOG:** Legacy setting that should not be used unless you need to use the **Output** window rather than the **Explorer** window. For jobs that have the output function set to LOG, Applications Manager loads all output or report files in the **Output** window every time you log into the client. This can take several seconds or minutes. If more than 500 files are loaded, an alert will be displayed. Therefore, if you are not using the **Output** window (that is, you view output from History instead of the **Output** window), you should use the **STORE** setting.
   - **PRINT:** The output is printed according to the output settings specified on this tab.
   - **STORE:** The output is not printed.

5. If you are printing and want more than one copy of the output generated by the task, enter a value in the **Copies** field.

6. Select a queue from the **Queue** list box.
   The **Queue** list box will be active only if you have been assigned the **Select Queues For Requests** user option by your Applications Manager administrator. If you have not been assigned this option, the **Queue** list box will be read-only, and will list only the default queue of the job.

7. If you are requesting a job that was assigned to an agent group (or a process flow assigned to a multi-execution agent group), you will be able to select a specific agent from the **Agent** drop-down list. For information about which agents components in process flows run on, see topic 4.4 How Agent Assignments are Handled for Process Flow Components in the Development Guide.

8. The **Requestor** field is read-only and shows the user name that is assigned to the task. This name will be displayed in the Requestor columns in the Backlog and History.

9. To set a different start date and time, place the mouse cursor in the **Start Date** field and enter a new date or time. Or, click the button to the right of the field to open a window where you can select the date and time.
   When entering start times, you can include time zone abbreviations. For more information on time zones, see topic 4.4 Setting Automation Engine Options in the Administration Guide.
   If you set the date and time forward, the task status in the Backlog will be shown as DATE PENDING. Components of a process flow in DATE PENDING status will show as STAGED or STAGED_PW status (depending on the components’ predecessor requirements). If you set the date or time to a time that has already passed, the task will be eligible to run immediately.
   You can pre-date the start date of this job or process flow to meet the predecessor requirements for tasks waiting in the Backlog from a previous virtual day.
10. If you want the task to go into a HOLD status when it is submitted to the Backlog, you can select the Hold option. The task will stay in the Backlog with a HOLD status and not run until you reset it.

11. If documentation has been created for the job, you can view it by clicking the Documentation button.

12. When you have entered the prompt values and set the options, you are ready to click one of the following to submit the job or process flow:
   - To automatically close the Submit window after it the job is submitted, click the Submit & Close button.
   - To keep the Submit window open, click the Submit button. After you submit the job or process flow this way, Applications Manager displays a message in the status bar (see Figure B). If you submit a large process flow the message will read, 'Task submission in progress: run_id = <run ID number>' until all components of the process flow have been placed into the Backlog. The Close button will be grayed out until the task is in the Backlog. Once the task is in the Backlog the message will read, 'Task was Successfully submitted run_id = <run ID number>'.

Removing Tabs for Jobs and Process Flows from the Submit Window

If there is more than one tab in the Submit window, you can remove the tab by selecting it and clicking Close Tab. To close the Submit window and all tabs, click Close.

Invalid Prompts

After you click Submit, Applications Manager checks the prompt values. If the values you assigned to prompts are invalid, Applications Manager will display an error message. You can correct the values and then submit the job or process flow.
Adding a Suffix to a Job or Process Flow Name So Predecessor Links Are Not Satisfied

To add a suffix to a job or process flow name, enter the suffix in the Task Name Suffix field. The job or process flow will run with an underscore followed by the suffix at the end of its name. This will prevent the request from satisfying any predecessors, since the name is changed.

The Task Name Suffix field will only be available if you have been assigned the Set Task Name Suffixes user option by your Applications Manager administrator.
Chapter 2: Requesting Jobs and Process Flows
3

Viewing and Printing Output

3.1 Introduction to Viewing and Printing Output ............................................................. 46
3.2 Working with the Output Window ............................................................................. 48
3.3 Querying the Output Window ................................................................................... 50
3.4 Viewing Output Files with the File Viewer ............................................................. 54
3.5 Printing, FTPing, and Emailing Output Files ........................................................... 56
3.6 Opening Output Files with Other Applications ....................................................... 58
3.7 Sharing File Associations with All Applications Manager Users ............................ 60
3.1 Introduction to Viewing and Printing Output

Using the File Viewer, you can view output and print it to a local or system output device.

One of the most unique features of Applications Manager is its ability to capture output from tasks and make it available for printing and viewing online. Online viewing gives you immediate access to reports as soon as they have been generated. Applications Manager captures both the log file of the task and any output generated by the task. The output generated by the task may exist in the `out` directory where the automation engine is installed, or in a directory on another server associated with the application. Where output is registered is determined by the program type script associated with the job. For more information on registering output, see chapter 13: Run-time Extensions and Environment Variables in the Development Guide.

![Figure A. You can view reports using the File Viewer or another designated viewer.](image)

After you submit a task and it executes, you can view the output as plain text, HTML, or rich text format using the File Viewer window shown in Figure A. You can also use an alternate viewer using file associations. For information on setting file associations, see topic 3.6 Opening Output Files with Other Applications. Output can be printed to a local or system output device.
Opening the File Viewer Window

You can access the File Viewer window from:

- The Explorer window.
- The Output window.

The Explorer window is used to monitor and manage Applications Manager tasks, as well as agents and queues. To open the File Viewer window from the Explorer window, right-click a task in the Backlog or History and select Output from the pop-up menu. For more information on viewing output from the Explorer window, see topic 4.10.8 Task Output Files: Viewing.

The Output window provides access to task output for users who have not been given access to the Explorer window. To open the File Viewer window from the Output window, select a task and click the View button. For more information on viewing output from the Output window, see topic 3.2 Working with the Output Window.

Querying for Tasks

You can query History in the Explorer window and you can query the Output window. You can search for specific tasks by criteria such as job name, process flow, agent, and requestor. For more information on querying, see topics 5.2 Querying for Tasks in History and 3.3 Querying the Output Window.

Viewing Output in Other Applications

After a task has completed, you can view the output in the File Viewer window as shown in Figure A. You can also associate types of files with other viewers. For example, if you are generating an .xls file, you can have Applications Manager automatically launch Microsoft Excel as the viewer. To do this, you must specify the association in the File Association window. For information on setting file associations, see topic 3.6 Opening Output Files with Other Applications.

Printing Output

After viewing a report, you can preview the printed output and print it to a local Windows printer or to an Applications Manager output device. These options are available from the File Viewer window’s File menu and from the icons in the File Viewer and Output windows. For more information on printing output, see topic 3.5 Printing, FTPing, and Emailing Output Files.
3.2 Working with the Output Window

The Output window only exists for legacy purposes. We do not suggest new users use it for any purpose. The Output window provides Applications Manager users access to task output without requiring that they have the necessary user group access to monitor and manage tasks in Explorer.

The Output window shown in Figure A provides access to task output for users that have not been given access to the Explorer window. By default, only tasks whose Output function was set to LOG will be displayed in the Output window. These tasks have a logged status. You can see printed, stored, or viewed tasks by running a query and searching for tasks with one or more of these statuses.

Opening the Output Window

Open the Output window shown in Figure A by doing one of the following:

• Open the Activities menu and select Output.
• Select the Output icon from the toolbar.

Output Restricted to User

By default, only the tasks you have submitted will be displayed in the Output window unless the View Other Users’ Output option was assigned to you by your Applications Manager administrator. With this option set, you will have access to all outputs for the jobs you have been assigned access to regardless of the user that submitted the job. If View SYSOUT Device Output Files and View Other Users’ Output are not assigned to your user, Applications Manager restricts output that is assigned to the SYSOUT output device on this window. For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.

Output and User Groups

When you are setting up user groups, consider setting up a user group for end-users that includes access to the Requests and the Output windows only. This lets end-users submit, view, and print their specific task requests.
Working with the Output Window

The table below describes the available actions on the Output window.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View output</td>
<td>Select a task and click the View button. Applications Manager displays the output in the File Viewer window. For information on using the File Viewer window, see topic 3.4 Viewing Output Files with the File Viewer.</td>
</tr>
<tr>
<td>Query for specific tasks</td>
<td>Click Query on the Output window. You can query for a specific task by a wide range of criteria such as job name, process flow name, requestor, and output status. For more information on querying the Output window, see topic 3.3 Querying the Output Window.</td>
</tr>
<tr>
<td>Hide or unhide tasks</td>
<td>Select one or more files and click the Hide button. To select multiple adjacent files, use Shift+click. To select multiple non-adjacent files, use Ctrl+Click. Hiding output changes the status of the selected files to STORED and removes the listing from the viewable list. To hide all listings in this window, request the OLPRTS job. To display hidden files, you must use the Query function and query for the STORE status. If after querying, you select a file and click Hide, its output function will be changed to LOG. If the Hide Files on the Output Window option was not assigned to you by your Applications Manager administrator, you will not be able to use the Hide button. For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.</td>
</tr>
<tr>
<td>Refresh the display</td>
<td>Click the Refresh button. When you first open the Applications Manager client, tasks that have completed with a LOG status will be available for viewing without running a query on the Output window. If other tasks complete while you have a client session open, they will not automatically be added to the Output window. Refresh the display to see them.</td>
</tr>
<tr>
<td>Print output</td>
<td>Select a task and click the Print button or one of the Print icons. For more information on printing output, see topic 3.5 Printing, FTPing, and Emailing Output Files.</td>
</tr>
</tbody>
</table>

Customizing Table Columns

You can customize many tables in Applications Manager including the table in the Output window. When customizing tables, you determine which columns are listed, what each column is named, and how each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns in the Output window may be different from what is described above. For more information, see topic 1.8 Customizing Tables.
3.3 Querying the Output Window

To search for specific tasks in the Output window, click the Query button. You can query by jobs, process flows, requestors, output functions, output devices, agents, start times, and run IDs.

If you are looking for a specific task and the number of tasks listed in the Output window is overwhelming, or you wish to view output from tasks which are not listed by default, you can run a query on the Output window.

Procedure

To perform an output query:

1. Click the Query button on the Output window.
   Applications Manager displays the Output query window shown in Figure A.

2. Select search criteria for your query.
   You can use any combination of query criteria available in the Output query window.
   The Output query window fields are described in Table A.
   To query by one or more objects, enter values in each object’s field by doing one or both of the following:
   - Type in names of the objects separated by commas.
   - Select from a list of objects by clicking on the object icon at the end of the field.

Table A. Output query options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs</td>
<td>Searches for any task assigned to the specified job(s), including tasks that ran the job under an alias name. To query for a task run under an alias, enter the alias name.</td>
</tr>
</tbody>
</table>
### Process Flows
Searches for tasks that are part of the process flow(s). The process flows themselves are not returned.

### Agents
Searches for any task run on the specified agent(s).

### Output Devices
Searches for any task assigned to the specified output device(s).

### Requestors
Searches for any task run by the specified requestor(s).

### Output Function
Searches for tasks based on the output function set for the job at run-time. There are three statuses:
- **LOG**: The output is available for printing, but has not been printed. Outputs with this status appear on the **Output** window list by default.
- **PRINT**: Same as **LOG**, but output is sent to output devices as well.
- **STORE**: You must query to see output files with this status. System output files are typically stored.

### From start time
These fields accept date/time information. If the **Current day** option is selected, the **From start time** and **To start time** fields will be inactive.

### Run ID
This field references the unique number (format: 1320.00) assigned to each task by Applications Manager. When using this field, include the decimal value where appropriate. Decimal values at the end of Run IDs indicate that tasks have been restarted. Every task has .01 added to its Run ID each time it is restarted.

### Current day
The default is to query by the current day. All tasks run from midnight to the current time will be included. If you save a query with this option checked, it will be applied each time you run the saved query.

The date and time of the current day are saved as an offset from the current time. That means that if you save a query for tasks run in the last two days, it will always run a query for the tasks in the last two days. There is no way to save a query from a specific date. If you uncheck this option, the **From start time** and **To start time** fields become active. You then can enter specific dates and times for the query.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Flows</td>
<td>Searches for tasks that are part of the process flow(s). The process flows themselves are not returned.</td>
</tr>
<tr>
<td>Agents</td>
<td>Searches for any task run on the specified agent(s).</td>
</tr>
<tr>
<td>Output Devices</td>
<td>Searches for any task assigned to the specified output device(s).</td>
</tr>
<tr>
<td>Requestors</td>
<td>Searches for any task run by the specified requestor(s).</td>
</tr>
<tr>
<td>Output Function</td>
<td>Searches for tasks based on the output function set for the job at run-time. There are three statuses:</td>
</tr>
<tr>
<td></td>
<td>• <strong>LOG</strong>: The output is available for printing, but has not been printed. Outputs with this status appear on the <strong>Output</strong> window list by default.</td>
</tr>
<tr>
<td></td>
<td>• <strong>PRINT</strong>: Same as <strong>LOG</strong>, but output is sent to output devices as well.</td>
</tr>
<tr>
<td></td>
<td>• <strong>STORE</strong>: You must query to see output files with this status. System output files are typically stored.</td>
</tr>
<tr>
<td>From start time</td>
<td>These fields accept date/time information. If the <strong>Current day</strong> option is selected, the <strong>From start time</strong> and <strong>To start time</strong> fields will be inactive.</td>
</tr>
<tr>
<td>To start time</td>
<td></td>
</tr>
<tr>
<td>Run ID</td>
<td>This field references the unique number (format: 1320.00) assigned to each task by Applications Manager. When using this field, include the decimal value where appropriate. Decimal values at the end of Run IDs indicate that tasks have been restarted. Every task has .01 added to its Run ID each time it is restarted.</td>
</tr>
<tr>
<td>Current day</td>
<td>The default is to query by the current day. All tasks run from midnight to the current time will be included. If you save a query with this option checked, it will be applied each time you run the saved query. The date and time of the current day are saved as an offset from the current time. That means that if you save a query for tasks run in the last two days, it will always run a query for the tasks in the last two days. There is no way to save a query from a specific date. If you uncheck this option, the <strong>From start time</strong> and <strong>To start time</strong> fields become active. You then can enter specific dates and times for the query.</td>
</tr>
</tbody>
</table>
3. You may select a default sort order for the query by selecting a Sort option. The sort order can be overridden from the Output window by selecting a different column name.

4. You may also optionally save this output query to use later by entering a name in the Filter name drop-down box. The output query will be saved when you click OK. Saved Output queries can be recalled from the Filter name drop-down box for History queries, Output queries, and filters of the Backlog and History.

5. Click OK. Applications Manager displays a small animated window as it processes the query. Once the query is processed, Applications Manager displays the results in the Output window.

Using the Object Assignment Windows

When you click on an icon at the end of one of the applicable fields, Applications Manager displays the object assignment window where you can pick one or more objects to use in an output query. The windows will list only the objects to which you have user group access. Use the arrow buttons to move objects between the Unassigned and Assigned tables. For more information on assigning objects, see topic 1.3 Working in the Applications Manager Windows.

![Object assignment window for jobs](image)

**Figure B.** Object assignment window for jobs

Use the Other filters field to enter text-based filters.

- You can enter several letters, and all objects beginning with those letters will be included.
- You can use wildcards in the text. You can use the _ wildcard to represent a single character, and the % wildcard to represent an unlimited number of characters.
- You can include negative filters to exclude tasks from the search using the ! character. For example, entering !AW% will exclude tasks with the letters AW together in their name.

Any text entered in the Other filters field will be included in the appropriate field on the Select filters window.

Use the Search field to query the Unassigned table. You can apply the search criteria to the Assigned column as well by unselecting the Show all assigned option.
Viewing Query Results

When you click OK in the Output query window, Applications Manager runs the search and displays the queried results. The Apply Query check box will be checked as shown in Figure C. To clear the query, uncheck the Apply Query box. You can view the queried results again by rechecking the Apply Query box. To apply a saved output query, select it from the drop-down box.

Figure C. The Output window with the Apply Query check box checked
3.4 Viewing Output Files with the File Viewer

You can access the File Viewer from the Explorer window and the Output window.

After a task executes, you can view its output online from the Applications Manager client. This means you can view a report as soon as it is available rather than waiting for printed output to be distributed. Online viewing also is useful if you are trying to debug a new program or if the output is such that you do not need a hard copy.

You can enter page and line numbers for viewing, and bookmark pages. Output is automatically displayed in one of three formats: plain text, HTML, or rich text format.

You can use the File Viewer window shown in Figure A, or an alternate viewer. For information on viewing output with alternate viewers, see topic 3.6 Opening Output Files with Other Applications.

Viewing Output Files

To view output, open the File Viewer window shown in Figure A by doing one of the following:

- From the Explorer window, right-click a task in the Backlog or History and select Output from the pop-up menu. For more information on accessing the File Viewer window from Explorer, see topic 4.10.8 Task Output Files: Viewing.
- From the Output window, select a task and click the View button. For more information on accessing the File Viewer window from the Output window, see topic 3.2 Working with the Output Window.

From the File Viewer window, you can:

- Copy text to the clipboard with Ctrl-C.
- Go to the start or end of the output file using the Home and End keys when the output text is in focus.
- Scroll through the output by using the horizontal and vertical scroll bars.
- Close the window by pressing the Esc key.

Figure A. View using the File Viewer
Printing, FTPing, and Emailing Output Files

You can print, FTP, or email output from the File Viewer window using the print icons or from the Print menu on those windows. For more information, see topic 3.5 Printing, FTPing, and Emailing Output Files.

Viewing by Page and Line Numbers

You can jump to a specific page and/or line number by entering them into the Page and LineNo fields at the top of the window and clicking the corresponding Go To button or pressing Enter.

Finding Specific Text

To find specific text in the output file:

1. On the File Viewer window, go to the Options menu and select Find.
   Applications Manager displays the Find window shown in Figure B.
2. Enter the text you want to find and click Find Next.
   Check the Match Case check box for case-sensitive searches. Applications Manager searches run from the current location to the end of the file.

Bookmarking Pages

As you view a file, you can bookmark pages for printing by selecting the Mark Page button. Your marked page numbers will display in the Pages box located at the bottom of the screen. When you print the output, only the marked pages will be printed.

Changing Output Formats and Text Size

Applications Manager automatically selects HTML or rich text format styles based on each file’s extension (.htm, .html, .rtf). Other files default to plain text view. When using the plain text view, you can adjust the size of the text used in the display by selecting a value from the Size list box at the bottom of the viewer. This changes the size of the text in the viewer, but it does not impact the size of the text used when the report is printed. Output can be viewed with an alternate viewer if a file association has been defined. For information on setting file associations, see topic 3.6 Opening Output Files with Other Applications.

Viewing the End of Files

To view the end of a text file, go to the Options menu on File Viewer window and select Tail. The tailing option enables operators to observe the most recent end of file every 10 seconds by showing the report as it is being printed to standard output. Use this function, similar to the UNIX tail -f <filename> command, when trying to diagnose problems.
3.5 Printing, FTPing, and Emailing Output Files

To print, FTP, or email output files from a task using the File Viewer, go to the Print menu and select an option.

You can print, FTP, or email output from the Output Files tab of the Task Details window, the File Viewer window, or the Output window using the print icons shown in Figure A or from the Print menu on each window.

**Printing Output Files to an OS Printer**

To print the output to an OS printer:

1. From the File Viewer window, go to the Print menu and select Print, or click the Print icon. Applications Manager opens a Print window.
2. Select the options and click OK.
   - If you have bookmarked one or more pages using the Mark Page button, Applications Manager will only print the marked pages.

**Printing to an Applications Manager Output Device**

To print the output to any output device defined in Applications Manager:

1. From the File Viewer, go to the Print menu and select Send To, or click the Send To icon.
   - Applications Manager displays the Choose an Output Device window shown in Figure B.
2. Select an output device, copies, and output option and click OK.
   - Applications Manager prints to the output device you selected.
   - If you have bookmarked one or more pages using the Mark Page button, Applications Manager will only print the marked pages.

**Note:** To use the system print option, you must have user group access to the output device you wish to print to and at least one output group it is assigned to. If you do not think you have the necessary user group access, see your Applications Manager administrator.

**Previewing a Print Task**

To preview a print task, go to the File menu and select Print Preview, or click the Print Preview icon.
FTPing an Output File

You can send an output file to your client machine or a network location using the FTP function. To FTP a file:

1. From the Actions menu, select FTP or click the FTP icon. Applications Manager displays the FTP window shown in Figure C.
2. Select the directory where you want the file placed.
3. Enter the name you want assigned to the file.
4. To initiate the transfer, click Save.

You cannot FTP files if the FTP Output Files option was not assigned to you by your Applications Manager administrator. For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.

Emailing an Output File

You can email output files without having to define an email output device. To email output files to one or more addressees, go to the Print menu and select Email, or click the Email icon. Applications Manager opens an Email window shown in Figure D.

Separate multiple email addresses with a space or semicolon. To select from emails assigned to Applications Manager users, click the Select button. Applications Manager opens a window where you can select the email addresses. You can decide whether to add the output file as an attachment and include additional text using the box at the bottom of the screen. For information on adding email addresses to Applications Manager users, see topic 3.2 Defining Users in the Administration Guide.

You also have the option to send the output file as an attachment, include it in the message body, attach it as a PDF file, or include it in an attached zip file.

In order to send emails, you must specify email settings for the Applications Manager automation engine/local agent. For information, see topic 4.7 Specifying Email Settings for the Automation Engine in the Administration Guide.
3.6 Opening Output Files with Other Applications

You can associate different types of files with specific applications so that Applications Manager automatically uses the specified application to view certain files. Additionally, you can manually select an application when you want to view any output file if you have specified a file association for it.

There may be times that you want to view output files in a different application rather than in the Applications Manager File Viewer window. To do this you define a file association. You might want to open files in another application if the files are too large to view with the File Viewer window, or if the file includes formatting that only a specific application will recognize. For example, if a report has a .xls extension, you can associate the file with Microsoft Excel. From the associated application, you can save the output file to your PC. You define file associations using the File Association window shown in Figure A.

After you create a file association, files with corresponding names will always, sometimes, or never open with the associated application when you view the output from the Applications Manager client, depending on the file association definition. You will also have the option to open any output file with the application you created the file association for.

The file association(s) you create are associated with your user login on your PC. They are not global settings unless you share file associations for all users as described in topic 3.7 Sharing File Associations with All Applications Manager Users.

Adding File Associations

To add an output file association:

1. On the desktop, go to the Options menu and select File Associations. Applications Manager opens the File Association window shown in Figure A.

2. Enter a file pattern in the Pattern field. The most common pattern for file associations are file extensions (for example .xls). The Pattern field accepts valid regular expressions. Note that regular expressions are case sensitive. For information on syntax accepted by regular expressions, see Appendix A: Regular Expression Tables in the Development Guide.

3. In the Application field, type the name of the executable file for the application you wish to associate with the file type, or use the ... button to browse for it on your PC.
4. Select an option from the **Use** field.

<table>
<thead>
<tr>
<th>To:</th>
<th>Select:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always open file type in the associated file viewer</td>
<td>Always</td>
</tr>
<tr>
<td>Prompt before opening the file in the associated file viewer</td>
<td>Ask</td>
</tr>
<tr>
<td>Never use the associated file viewer or temporarily disable the association</td>
<td>Never</td>
</tr>
</tbody>
</table>

5. Click **Add**.

Applications Manager displays the file association in the table at the top of the screen.

6. When you are finished adding file associations, click **OK** to save them.

**Opening Any Output File with a File Association's Application**

You can manually open any output file from the Applications Manager client by selecting the **Open With** icon from the **Output Files** tab of the **Task Details** window or the **Output** window. In Figure B, the **Open With** icon has been selected, and the **Select Program** window is open. From the **Select Program** window, you can select the application you want to use to view the selected output file.

![Figure B](image)

*Figure B. Click the Open With icon to select an application to use to open the selected output file.*
3.7 Sharing File Associations with All Applications Manager Users

If all users that log into an automation engine need to use the same file associations, you can point them to a common file.

If all users that log into an automation engine need to use the same file associations, you can point them to a common file named `fileassoc.properties`. File associations for individual users are stored in the following file:

\[ C:\Documents and Settings\<user name>\fileassoc.properties \]

To assign a common file to all users, do the following:

1. Add the following line to the Applications Manager automation engine `Options.properties` file, where `N:/uc4/` is a shared directory and `fileassoc.properties` is the name of the file:

   FileAssociations=N:/uc4/fileassoc.properties

   You can use mapped drives or UNC paths.

   For example:

   FileAssociations=//rs62/ndrive/uc4/fileassoc.properties

   Also, / should be used instead of \. Using backslashes will prevent properties from being saved.

   The location for the `Options.properties` file is:

   UNIX: $AW_HOME/web/classes
   Windows: %AW_HOME%\web\classes

2. Log into the Applications Manager client and set up a file association.

Applications Manager will create the file you specified in step 1 in the directory you specified and update it with the file association information. The file association will now be globally changed for all users that have access to the drive you specified.
Monitoring and Managing Tasks in Explorer

4.1 Introduction to Monitoring and Managing Tasks ............................................................ 64
4.2 Using the Explorer Window .......................................................................................... 66
4.3 Working with the Backlog ......................................................................................... 68
4.4 Working with History ................................................................................................. 70
4.5 Backlog and History Column Descriptions ............................................................... 72
4.6 Focusing the Backlog Display with Explorer ............................................................. 74
4.7 Monitoring with the Status Bar and Object Icons ..................................................... 76
4.8 Troubleshooting Failed Tasks .................................................................................... 78
4.9 Taking Actions on Tasks in the Backlog ..................................................................... 80
  4.9.1 Putting Tasks On Hold ..................................................................................... 82
  4.9.2 Killing Tasks ................................................................................................... 84
  4.9.3 Resetting Aborted and On Hold Tasks ........................................................... 86
  4.9.4 Deleting Tasks ................................................................................................. 88
  4.9.5 Removing All Predecessors for Tasks ............................................................ 90
4.10 Viewing and Editing Task Details ............................................................................ 92
  4.10.1 General Task Details: Viewing and Editing .................................................... 94
  4.10.2 Task Prompts: Viewing and Editing ............................................................... 98
  4.10.3 Pending Predecessor Links: Viewing and Removing ...................................... 100
  4.10.4 Successors in the Backlog: Viewing ............................................................... 102
  4.10.5 Task and Predecessors in a Flow Diagram: Viewing, Adding, and Editing 104
  4.10.6 Task Conditions: Viewing and Editing ......................................................... 106
  4.10.7 Task Documentation: Viewing .................................................................... 108
  4.10.8 Task Output Files: Viewing ......................................................................... 110
  4.10.9 Task Comments: Adding and Viewing ........................................................ 112
4.11 Unsatisfying Tasks as External Predecessors in History ............................................. 114
4.12 Managing ZOS Tasks ............................................................................................. 116
4.13 Viewing History in a Gantt Chart .............................................................................. 120
  4.13.1 Comparing Run Times in a Gantt Chart .......................................................... 122
4.14 How Applications Manager Handles System Failures ............................................. 124
4.1 Introduction to Monitoring and Managing Tasks

You can monitor and manage queues, agents, and tasks with the Explorer window. From the Explorer window, you can monitor and manage queues, agents, and tasks. You can check the status of queues, change queue settings, and assign queues to thread schedules to control the number of tasks the queue can process. You can check agent status, and start, stop, idle, or resume agents. You can check the statuses of tasks, restarting or killing the tasks if necessary. A sample Explorer screen displaying the Backlog and History is shown in Figure A.

![Figure A. The Explorer window](image)

The Backlog and History

Two main parts of the Explorer window that allow you to monitor and manage tasks are the Backlog and History. The Backlog is a list of tasks that:

- Are waiting to run.
- Are running.
- Have run and failed, and have stayed in the Backlog for operator intervention.

When a task leaves the Backlog, Applications Manager writes a record for it in History. History is an audit trail of all failed and completed tasks. For more information on the Backlog and History, see topics 4.3 Working with the Backlog and 4.4 Working with History.

Quick Searches for Tasks in the Backlog

You can type the first few letters of a task from the Backlog’s name in the Search field, and Applications Manager will find it. The Search field accepts valid UNIX regular expressions. For example, to search for all tasks starting with the letters A and T, you would enter `[at]` in the Search field. For more information on syntax accepted by regular expressions, see Appendix A: Regular Expression Tables in the Development Guide.
Reading the Status Bar

The status bar is displayed across the bottom of the Explorer window. Its color alerts you to the status of the Applications Manager automation engine, agents, and tasks running in the Backlog. When the Explorer window is minimized, the button on the taskbar uses the same color scheme. For more information, see topic 4.7 Monitoring with the Status Bar and Object Icons.

Customizing Explorer Tables

You can choose the columns you want displayed in the Explorer window and customize their order and names. For more information, see topic 1.8 Customizing Tables.

Viewing Output Files and Task Details

You can view output files and other task details for any task in the Backlog or History. You view the task details for a task by right-clicking it and selecting an option from the pop-up menu. For more information, see topic 4.10 Viewing and Editing Task Details.

Staging Tasks in the Backlog

Staging tasks in the Backlog allows you to edit task details before the tasks are scheduled to run. For more information, see chapter 6: Staging Tasks in the Backlog.

Monitoring and Managing Queues and Agents

Queues control the flow of tasks. All tasks must pass through an Applications Manager queue to be executed.

Agents are instances of Applications Manager; an agent is installed on each machine where tasks are executed. An agent can be an automation engine’s local agent, or a remote agent. The automation engine is also listed along with the agents in the Explorer window. You monitor and manage agents and queues from the Explorer window. For more information, see chapter 7: Working with Agents and Queues.

Monitoring and Managing Tasks in the Gantt View

If you have the add-on Graphical Analysis Package, you can monitor and manage tasks in the Backlog using the Gantt View. For information on using the Gantt View, see chapter 9: Monitoring and Managing Tasks with the Gantt View.
4.2 Using the Explorer Window

Explorer is used to monitor and manage the status of your agents, queues, and tasks running in the Backlog, and to focus the display of tasks in the Backlog.

Use Explorer to monitor and manage the status of your agents, queues, and tasks running in the Backlog, and to focus the display of tasks in the Backlog. You can preview and print the object tree, Backlog, and History.

Opening the Explorer Window

Open the Explorer window shown in Figure A by doing one of the following:

- Open the Activities menu and select Explorer.
- Select the Explorer icon from the toolbar.

Three Adjustable Panes

The Explorer window shown in Figure A includes the following three panes:

- The navigation pane on the left side of the screen provides a tree structure with selectable object icons.
- The content pane on the top right side of the screen displays information based on your selection in the navigation pane. It can show the Backlog (tasks waiting to be processed), a summary of objects selected in the object tree, an application summary, an agent summary, or a queue summary.
- The History pane on the bottom right side of the screen displays records on how tasks ran. The tasks displayed do not depend on your selection in the navigation pane.

Each of the panes can be resized by dragging the splitter bars, or clicking the splitter bar arrows.
Numbers to the right of the label for the Backlog and History indicate the number of rows currently displayed in each. Every row is counted regardless of whether it represents a job, process flow, or historical record. Some tasks may include multiple records in History. For example, a task that aborts and is reset will include two History records.

Explorer Terms

The following Explorer terms are used in this guide:

- **Object tree**: The graphical model displayed on the left pane of the Explorer window.
- **Object icons**: The icons used in the object tree to represent objects such as tasks, process flows, and queues.
- **Object keys**: The icons to the left of the expandable objects in the object tree. You can click the object keys to show and hide objects in the tree.

Printing the Object Tree or a Table

You can preview and/or print the object tree, and the Backlog and History tables by selecting the appropriate options from the **File** menu. Figure B shows the print preview screen for a task in the Backlog in an ABORTED status.

![Figure B. The Print Preview window for the Backlog table.](image)
4.3 Working with the Backlog

Clicking the Backlog object tree icon displays running tasks, aborted tasks, and tasks that have failed and remained in the Backlog for operator intervention.

Two main parts of the Explorer window that allow you to monitor and manage tasks are the Backlog and History.

To view all tasks in the Backlog in the content pane on the top right side of the screen, click the Backlog icon in the object tree shown in Figure A. In the Backlog in Figure A, one task is running, some tasks are waiting in a PRED WAIT status, and one task has aborted.

Whether a task remains in the Backlog when it fails is determined by the Stay in queue on abort setting in its job definition.

Tasks sometimes fail by aborting, timing out, being killed, etc. When a task fails, a record is written to History under the current run ID number. If a failed task remains in the Backlog, its run ID is incremented by .01.

For example, in Figure A, a task with the run ID 73016 aborted and remained in the Backlog. A record of the task aborting is written to History, and the task remains in the Backlog with the run ID 73016.01.
From the Backlog, you can:

- Take actions on tasks (see topic 4.9 Taking Actions on Tasks in the Backlog).
- View and edit task details (see topic 4.10 Viewing and Editing Task Details).

When a task leaves the Backlog, Applications Manager writes a record for it in History.
4.4 Working with History

History is an audit trail of completed and failed tasks displayed on the bottom of the Explorer window.

Two main parts of the Explorer window that allow you to monitor and manage tasks are the Backlog and History.

Numbers to the right of the label for the Backlog and History indicate the number of rows currently displayed in each. Every row is counted regardless of whether it represents a job, process flow, or historical record. Some tasks may include multiple records in History. For example, a task that aborts and is reset will include two History records.

History is an audit trail that includes records for:

- All completed tasks and occurrences of task failure(s).
- RMI servers or agents being started, stopped, or having errors.
- The AgentService processes being stopped.

How long task history records are archived in the Applications Manager database is determined by the prompt setting for the HISTORY_PURGE job, which is part of the SYSTEM process flow. The default value is 60 days. Your Applications Manager administrator is responsible for setting this value.

The Explorer window includes a partial view of History in its lower right pane.

The amount of History displayed when any user logs in to the client is determined by the HistoryRetentionTime setting in the Options.properties file. For more information, see topic 12.4 Options.properties File in the Administration Guide.
How long records are displayed in the History pane while a user is logged into an Applications Manager session is determined by:

- Your **History Display Minutes** desktop setting. For more information, see topic 1.4 Editing General Desktop and ToolBar Settings.
- Whether you have a History query activated. For more information, see 5.2 Querying for Tasks in History.

From History, you can:

- Unsatisfy tasks as predecessors (see topic 4.11 Unsatisfying Tasks as External Predecessors in History).
- View task details (see topic 4.10 Viewing and Editing Task Details).
- Add comments (see topic 4.10.9 Task Comments: Adding and Viewing).
- View History Gantt Views (with the Graphical Analysis Package, see topic 4.13 Viewing History in a Gantt Chart).
- Re-request tasks as described below.

**Re-Requesting Tasks from History**

You can now re-request a single task listed in the History pane of the **Explorer** window. To do so, right-click the entry and select the **Request** option. Applications Manager lists the selected job or process flow on a tab on the **Submit** window.

When you re-request process flow components this way, they will run with the same prompt values as the selected entry in History. All other settings, including alias name, conditions, predecessors, output settings, and queues will use the settings in the job definition.
4.5 Backlog and History Column Descriptions

The default columns in the Backlog and History are described in the table below. You can customize many tables in Applications Manager including the tables in the Backlog and History.

A sample Explorer window showing the Backlog and History is displayed in Figure A.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue</td>
<td>The queue the task is running on, will run on, or has run on.</td>
</tr>
<tr>
<td>Run ID</td>
<td>The unique identification number Applications Manager assigned to the task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Decimal values at the end of Run IDs indicate the number of times a task has either been killed or has aborted and stayed in the Backlog. Each time a task is killed or aborts and stays in the Backlog, .01 is added to the task's Run ID, and a record is added to History using the task's previous run ID.</td>
</tr>
<tr>
<td>C</td>
<td>Uses a Y to identify tasks that include comments.</td>
</tr>
<tr>
<td>D</td>
<td>Uses a Y to identify tasks that include documentation.</td>
</tr>
<tr>
<td>Task Name</td>
<td>The name or alias, if defined, of the task.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date the task started executing or is scheduled to start executing.</td>
</tr>
<tr>
<td>Started</td>
<td>Displayed in the Backlog. The time the task is scheduled to start executing. After a task begins executing, the time it started.</td>
</tr>
</tbody>
</table>

Figure A. The Backlog and History in the Explorer window
You can customize many tables in Applications Manager including the tables in the Backlog and History. When you are working in the Backlog, a pop-up table is displayed when you hover over the Run ID column for a task. These pop-up tables are called Backlog Task Summaries, and you can also customize them. When customizing tables, you determine which columns are listed, what each column is named, and how each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns in the Backlog and History may be different from what is described above. For more information, see topic 1.8 Customizing Tables.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finished</td>
<td>Displayed in History. The time the task finished executing.</td>
</tr>
<tr>
<td>Elapsed</td>
<td>The elapsed time the task ran.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the task. For a list of status values, see Appendix B: Task Status Values. For status detail information that tells you why a task is in a particular status, rest the mouse pointer over the Run ID column for the task and view the Status Detail information in the Backlog Task Summary pop-up table.</td>
</tr>
<tr>
<td>Agent</td>
<td>The agent or agent group where the task will execute (Backlog), or was executed (History). Process flows with ‘No Selection’ set in their Default Agent field will be assigned to the APPWORX_AGENTS agent group, an agent group containing all agents. The process flow itself does not run a program or script; only its components do.</td>
</tr>
<tr>
<td>Requestor</td>
<td>The person that submitted the task or the user entered as the requestor of the ad hoc request or schedule. If nothing is displayed, a Requestor was not specified for a scheduled task.</td>
</tr>
<tr>
<td>Parent</td>
<td>The process flow that contained the component. If the task is not a process flow component, this field will be blank.</td>
</tr>
</tbody>
</table>

Viewing and Customizing Tables and Backlog Task Summaries

Figure B. Backlog Task Summaries display information about the task in a pop-up table including status details.
4.6 Focusing the Backlog Display with Explorer

You can select an icon from the Explorer tree to limit the tasks listed in the Backlog.

Using Explorer, you can limit the tasks listed in the Backlog by selecting an icon from the object tree. You can view a Process Flow Summary listing all process flows with one or more tasks in the Backlog by selecting the Process Flows icon. An example Explorer screen displaying a Process Flow Summary is shown in Figure A.

![Figure A. The Process Flows icon can be selected in the Explorer window to focus on process flows in the Backlog.](image)

The icon you select in the object tree determines the tasks listed in the Backlog.

<table>
<thead>
<tr>
<th>To list:</th>
<th>Select this icon:</th>
</tr>
</thead>
<tbody>
<tr>
<td>All tasks in the Backlog</td>
<td>Backlog</td>
</tr>
<tr>
<td>Tasks submitted using the Requests window</td>
<td>Ad Hoc</td>
</tr>
<tr>
<td>Tasks assigned to a particular agent</td>
<td>The agent</td>
</tr>
<tr>
<td>Tasks in an agent group</td>
<td>The agent group</td>
</tr>
<tr>
<td>Tasks assigned to a particular queue</td>
<td>The queue</td>
</tr>
<tr>
<td>Tasks assigned to a particular queue</td>
<td>The application</td>
</tr>
<tr>
<td>Tasks and history records belonging to a particular process flow</td>
<td>The process flow</td>
</tr>
<tr>
<td>Tasks with a particular task status (WAITING, RUNNING, ABORTED, or HOLD)</td>
<td>The status</td>
</tr>
<tr>
<td>Tasks by agent on a particular machine</td>
<td>The machine and agent</td>
</tr>
</tbody>
</table>

Sorting the Tasks in the Backlog by Status

You can click on the Status column header in the Backlog to display three different sort orders: ascending, descending, and severity of status. When you sort tasks by severity of status, Applications Manager lists the most severe task statuses first.
Customizing Tables

You can customize many tables in Applications Manager. When customizing tables, you determine:

• Which columns are listed.
• What each column is named.
• How each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns displayed in Explorer may be different from what is shown here. For more information, see topic 1.8 Customizing Tables.

Limiting the View of Tasks in the Backlog

To limit the view of tasks in the Backlog by object:

1. If necessary, click the icon’s key to display the child objects. To view tasks in a process flow, you may need to open several icon keys (see Figure B).
2. Select an object from the list of icons.

Applications Manager displays the list of tasks belonging to that object in the upper right pane (see Figure C).

Figure B. Click icon keys to expand icons.

Figure C. Select an icon to view the tasks belonging to it.
4.7 Monitoring with the Status Bar and Object Icons

The status bar is displayed across the bottom of the Explorer window. Its color alerts you to the status of the Applications Manager automation engine, agents, and tasks running in the Backlog. When the Explorer window is minimized, it uses the same color scheme on the taskbar. The object icons help you locate aborted/on hold tasks easily.

The status bar shown in Figure A is displayed across the bottom of the Explorer window. Its color alerts you to the status of the Applications Manager automation engine, agents, and tasks running in the Backlog. When the Explorer window is minimized, the button on the taskbar uses the same color scheme.

For a description of the automation engine/agent status values, see Appendix A: Automation Engine/Agent Status Values. For a description of the task status values, see Appendix B: Task Status Values.

The status bar displays the time that the Explorer window was last refreshed. You can manually refresh by entering Ctrl-R or by clicking the status bar on the Explorer window. The Explorer window is automatically refreshed based on the Explorer Refresh Seconds desktop setting. For information on editing desktop settings, see topic 1.4 Editing General Desktop and ToolBar Settings.

The current date and time of the database are displayed to the right of the status bar.

**Viewing Components in a Process Flow**

Process flow components in the Explorer tree are listed based on the execution order of each tasks’ predecessors. When you select a process flow in the Explorer tree, those same components are displayed in the top right Explorer pane according to your Backlog search criteria (by default this is based on task status). To view the structure of a process flow, right-click and select Flow Diagram.
Managing Task Statuses with the Object Icons

The Explorer icons in the object tree alert you to task status and give you a quick method for finding aborted/on hold tasks.

For example, PROCESS FLOW_1 is in the Backlog. PROCESS FLOW_1 includes four process flow components. The first three icons represent process flows that ran successfully. When the fourth process flow ran, a task aborted, leading to the sequence of events below.

1. When the task aborted, the status bar turned red to alert the user Pat Brown.

2. Pat opened the Explorer window and could see by the red X indicator on the Process Flows icon that one or more tasks in a process flow had aborted.

   Note: Pat could have selected the Backlog, Ad Hoc, or Status icons to find the aborted task, but chose the process flow option out of personal preference.

3. Next, Pat clicked the Process Flows icon key to view a list of running components.

   The icon for PROCESS FLOW_1 had a red X indicator, so Pat knew that this process flow, or a process flow nested therein, contained an aborted task.

4. Pat clicked the PROCESS FLOW_1 icon key to view the list of tasks belonging to PROCESS FLOW_1.

   Pat could see that three process flows had finished successfully because the process flow icons were gray, and that a task had aborted in the other process flow (because the process flow icon had a red X indicator).

   Pat clicked the PROJECTED_NOV icon key to view the components in that process flow.

   Pat could see by the red X symbol as the second task's icon showing that it aborted. A second listing for the task, an orange icon with a circle and a diagonal line notes that a history record of the task aborting was written.

Now Pat could view the task details including the output files for the task to see why it aborted, and reset or delete it. For information on troubleshooting failed tasks, see topic 4.8 Troubleshooting Failed Tasks.
4.8 Troubleshooting Failed Tasks

When tasks fail, view the system output file for information. For additional information, turn on task level debug, reproduce the problem, and view the new system output file.

In Applications Manager, a failed task usually is assigned an ABORTED status. Depending on the circumstances, some tasks fail with a status other than ABORTED. All failed statuses are written in red and brought to the top of the Backlog display. For a list of task status descriptions and actions, see Appendix B: Task Status Values.

When tasks abort, a system output file is generated which is available for viewing from the Applications Manager client. The system output file is an excellent place to start troubleshooting. Along with runtime information and parameters passed to the task, the file includes error messages. A sample system file is shown in Figure A.

To view system output files, you right click the task in the Backlog or History, select Output, then pick the standard output file. In Figure A, a standard output file named o12031.00 is selected in the File Viewer window. From the viewer, you can view, print, FTP, or email the output file.

Figure A. View system output files for failed tasks.
The system output file includes basic information about the task such as:

- The name of the program executed.
- The person who ran the task.
- The Applications Manager run ID assigned to the task.
- The parameters used to run the task.
- A record of the basic steps taken to execute the task.
- Standard error reporting.

**Getting More Information with Task Level Debug**

If the system output file does not provide enough information to solve your problem, you can turn on the task level debug. When task level debug is on, additional information is written to the task’s system output file. If you call UC4 Technical Support to help figure out why a task failed, they will most likely ask you to turn on task level debug, reproduce the problem, and send the log. Doing this ahead of time will speed you along to the quickest possible resolution.

To turn on task level debug, create an empty file named BODY in the debug directory of the automation engine.

Task level debug is just one type of Applications Manager debugging you can set. For more information on setting all forms of debug, see chapter 10: Troubleshooting with Log Files and Debug in the Administration Guide.
4.9 Taking Actions on Tasks in the Backlog

The Backlog shows the tasks being processed in each queue. You can take actions on tasks in the Backlog by right-clicking and selecting an action.

You can select one or more tasks in the Backlog (shown in Figure A) and right-click to:

- Put tasks on hold.
- Kill tasks.
- Reset aborted, killed, or on hold tasks to allow them to run again.
- Delete tasks.
- Remove all predecessors for tasks.

To take an action on one or more tasks in the Backlog, highlight the task(s), right-click and select one of the first five options from the pop-up window.

The number displayed to the right of each of these options tells you how many of the tasks you selected are eligible for that action. If a * is displayed to the right of the number, one or more of the highlighted tasks is a process flow in an INITIATED status.

Applications Manager displays a small animated window while an action is processing.

![Figure A. Right-click to change the status of a task in the Backlog.](image)

Necessary User Access

To take an action on a task, you need:

- The task's job/process flow definition in one of your user groups (with or without Edit authorization).
- The Explorer user authority in a user group with Edit authorization.
To take actions on tasks in the Backlog run by other users, you must have the **Edit Other Users' Tasks** user option. For more information, see your Applications Manager administrator.

**Taking Actions on Process Flows**

Actions affect process flows headers and components differently depending on whether the process flow is in an INITIATED status. Details for each action are described in the table below:

<table>
<thead>
<tr>
<th>Action</th>
<th>When the process flow is not INITIATED</th>
<th>When the process flow is INITIATED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold</td>
<td>Holds the process flow header. Does not affect its components.</td>
<td>Holds all eligible components in the process flow.</td>
</tr>
<tr>
<td>Kill</td>
<td>A Kill cannot be taken against a process flow that is not in an INITIATED status.</td>
<td>Kills all eligible components in the process flow.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the process flow header. Does not affect its components.</td>
<td>Resets all eligible components in the process flow.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the process flow header and all its components.*</td>
<td>Deletes all eligible components in the process flow.*</td>
</tr>
<tr>
<td>Remove all predecessors</td>
<td>Removes all predecessors for the process flow header. Does not affect its components.</td>
<td>Removes all predecessors for the process flow header. Does not affect its components.</td>
</tr>
</tbody>
</table>

When process flows are deleted, skipped, or canceled the following will occur:

- All BEFORE conditions will be canceled.
- The process flow’s children that are unstarted process flows will be initialized.
- All predecessors for the process flow’s children will be removed.

**Subtopics**

Additional information is provided in the following subtopics:

4.9.1 Putting Tasks On Hold
4.9.2 Killing Tasks
4.9.3 Resetting Aborted and On Hold Tasks
4.9.4 Deleting Tasks
4.9.5 Removing All Predecessors for Tasks
4.9 Taking Actions on Tasks in the Backlog

4.9.1 Putting Tasks On Hold

Before a task runs, you can put it on hold. To put one or more tasks on hold, select the task(s) and right-click. Choose the Hold option from the pop-up menu.

If a task is in the Backlog but has not yet started, you can put it on hold. The task will remain in the Backlog in a hold status until you reset it or delete it from the queue. If a task has started running, you cannot put it on hold. However, you can kill a running task. For information on killing a task, see topic 4.9.2 Killing Tasks.

Procedure

To put tasks on hold:

1. Select one or more tasks in the Backlog and right-click.
   Applications Manager displays the pop-up menu shown in Figure A. The number to the right of the Hold, Kill, Reset, and Delete options references the number of tasks you have selected that are eligible for that operation.

2. Select the Hold option.
   Applications Manager displays the Hold confirmation window.

3. Click Yes to hold the task(s).
   Applications Manager closes the confirmation window and displays a small animated window to show you that it is taking the hold action on the task(s).

Figure A. To put a task on hold, right-click the task, select the HOLD option from the pop-up menu.
Result

When you put a task on hold, its status is displayed in a hold status, such as HOLD or HOLD PRED WT. Applications Manager displays the status bar at the bottom of the window in yellow to alert you that one or more tasks are on hold (see Figure B). A record is written to the task’s comment, noting that it was manually put on hold. The task remains on hold until you reset the status or delete the task from the Backlog.

Taking Tasks Off Hold

To take tasks off hold:

1. Select one or more tasks which are on hold in the Backlog and right-click.
2. Click the Reset option.
   
   Applications Manager will display the Reset confirmation window.
3. Click Yes to reset the task(s).
   
   Applications Manager closes the window and changes the task’s status to LAUNCHED.
4.9 Taking Actions on Tasks in the Backlog

4.9.2 Killing Tasks

If a task is running, you can kill it from the Backlog. To kill one or more tasks, select the task(s), right-click, and choose the Kill option from the pop-up menu.

If a task is running, you can kill it by selecting the task and using the Kill command. When you kill a task, it stays in the Backlog until you delete or reset it. When you kill a task, Applications Manager makes an entry in History showing that the task was killed.

Procedure

To kill running tasks:

1. Select one or more running tasks in the Backlog that you wish to kill and right-click. Applications Manager displays the pop-up menu shown in Figure A. The number to the right of the Hold, Kill, Reset, and Delete options references the number of tasks you have selected that are eligible for that operation.

2. Click the Kill option. Applications Manager displays the Kill confirmation window.

3. Click Yes to kill the task(s). Applications Manager closes the confirmation window and displays a small animated window to show you that it is taking the kill action on the task(s). Once the task(s) go into a KILLED status, the Backlog label will be displayed in its default color.

Figure A. If a task is running, you can kill it from the Backlog.
Result

While Applications Manager is killing a task, the task’s status in the Backlog changes briefly to KILL. Once the task is killed its status changes to KILLED, and an entry is made in History to show this (see Figure B). A record is written to the task’s comment, noting that it was manually killed. The killed task stays in the Backlog until you delete it or reset it.

When you kill a task in Applications Manager running in a UNIX environment, Applications Manager issues the `kill -15` UNIX command followed by the `kill -9` UNIX command.

*Figure B. When you kill a task, the process is stopped, the status of the task in the Backlog changes to KILLED, and an entry is made in History showing the task was killed.*
4.9 Taking Actions on Tasks in the Backlog

4.9.3 Resetting Aborted and On Hold Tasks

If a task aborts or is put on hold, you can reset it directly from the Backlog. To reset one or more tasks, select the task(s), and right-click. Choose the Reset option from the pop-up menu.

If a task aborts and remains in the Backlog, is killed, or is put on hold, you can reset it directly from the Explorer window. Before restarting a task, you can review its details including general task details, prompts, and conditions, and correct any problems. When you restart a task that is aborted or on hold, its status changes to LAUNCHED. As soon as a thread becomes available in the queue, the status changes to QUEUED.

An aborted task stays in the Backlog if the Stay in queue on abort option was set when the job was created. If this option was not set, the task is cleared from the Backlog and an entry is displayed in History. You cannot restart a task from the Explorer window once it has been removed from the Backlog. However, you can resubmit the task by going to the Requests window.

**Procedure**

To reset one or more tasks from the Backlog:

1. If appropriate, change the task details.

   For more information on changing task details, see topic 4.10 Viewing and Editing Task Details.
2. Select one or more tasks in the Backlog and right-click. 
   Applications Manager displays the pop-up menu shown in Figure A. The number to the right of the Hold, Kill, Reset, and Delete options references the number of tasks you have selected that are eligible for that operation.

3. Select the Reset option.
   Applications Manager displays the Reset confirmation window.

4. Click Yes to reset the task(s).
   Applications Manager closes the confirmation window and displays a small animated window to show you that it is taking the reset action on the task(s). Once the task(s) go into a LAUNCHED status, the Backlog label will be displayed in its default color.

Result

A record is written to the task’s comment noting that it was manually reset. When a thread becomes available for the queue, Applications Manager will start the task(s).

Figure B. The reset tasks are now in a QUEUED status.
4.9 Taking Actions on Tasks in the Backlog

4.9.4 Deleting Tasks

If a task in the Backlog is in a non-running status, you can delete it from the Backlog. To delete one or more tasks, select the task(s), and right-click. Choose the Delete option from the pop-up menu.

If a task in the Backlog is in a non-running status, you can delete it. For example, tasks with a status of LAUNCHED, PRED WAIT, ABORTED or KILLED can be deleted. You can also delete process flows from the Backlog. If you delete a process flow, all components in the process flow are deleted as well. When you have deleted a task, you cannot reset it from the Explorer window.

Procedure

To delete tasks:

1. Select one or more tasks in the Backlog and right-click.
   Applications Manager displays the pop-up menu shown in Figure A. The number to the right of the Hold, Kill, Reset, and Delete options references the number of tasks you have selected that are eligible for that operation.

2. Select the Delete option.
   Applications Manager displays the Delete confirmation window.

3. Click Yes to delete the task(s).
   Applications Manager closes the confirmation window and displays a small animated window to show you that it is taking the delete action on the task(s). Once the task(s) go into a DELETED status, the Backlog label will be displayed in its default color.

Figure A. You can delete one or more tasks.
Result

When you delete tasks, they are removed from the Backlog. A record of the task deleted from the Backlog is now displayed in History with a DELETED status (see Figure B). An entry is also made in the task’s comment, noting that it was manually deleted. After deleting a task, you cannot reset it from the Explorer window.

Figure B. Tasks deleted from the Backlog are displayed in History with a DELETED status.

How Deleting Process Flow Components Affects Process Flows

When you delete a task from a process flow, Applications Manager handles the predecessor links as follows:

- Internal predecessor links associated with the task are inherited by the next component in the process flow.
- External predecessor links for the task are removed.

If you delete the last internal predecessor link associated with a task, that component is moved to the upper right corner of the process flow and will be eligible to run with any other component that shares its row.
4.9 Taking Actions on Tasks in the Backlog

4.9.5 Removing All Predecessors for Tasks

If a task in the Backlog is waiting for one or more predecessors before it can run, you can remove the predecessor(s) to force it to run. To remove all predecessors for one or more tasks, select the task(s), and right-click. Choose the Remove All Predecessors option from the pop-up menu.

If a task in the Backlog is waiting for one or more predecessors before it can run, you can remove the predecessor(s) to force it to run.

To remove all predecessor links for a task in the Backlog, right-click the task and select Remove All Predecessors from the pop-up menu as shown in Figure A. The task will then be eligible to run as shown in Figure B.

Note: Deleting predecessor links from this tab does not delete tasks from the Backlog.

If you wish to view and remove select predecessors for a task, you can do so on the Predecessors tab of the Task Details window. For more information, see topic 4.10.3 Pending Predecessor Links: Viewing and Removing.

When you remove predecessor links for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow. For more information on predecessor links, see chapter 5: Working with Predecessors in the Development Guide.
Removing External Predecessors by Queue

To remove a task’s external predecessors on insert to the Backlog, assign it to the REMOVE_EXT_PREFS_ON_INSERT queue. You can create the REMOVE_EXT_PREFS_ON_INSERT queue by hand or by importing it. For more information, see topic 7.8 Removing External Predecessors by Queue.
4.10 Viewing and Editing Task Details

You can right-click any task in the Backlog or History and select an option from the pop-up menu to view its task details. Before tasks run, or when they abort or are killed, you can change their parameters in the Backlog. To change a task's parameters, right-click the task and select an option from the pop-up menu. When you change a task's parameters in the Backlog, the changes are applied only to that instance of the task.

You can right-click any task in the Backlog or History and select an option from the pop-up menu (see Figure A) to view its task details. The option you select determines which tab will be active on the Task Details window.

**Figure A.** Right-click Task Details to view the parameters for a task.

**Editing Task Details**

You can alter the details of tasks in a non-running status in the Backlog by doing any of the following:

- Editing general parameters such as a task’s queue, login, or start time.
- Adding, changing, or deleting prompt values and predecessor links.
- Adding, changing, deleting, or copying conditions.

The changes you make apply only to the current instance of the task, and will not affect the task the next time it is submitted.

**Note:** To view the details for tasks submitted by other users, you must have the View Other Users’ Tasks user option assigned to you by your Applications Manager administrator. To edit their details, you must have the Edit Other Users’ Tasks user option. To edit all the details for tasks in the Backlog, you will also need access to the objects assigned to the job/process flow.
For more information on setting user options, see topic 3.2.1 Setting User Options in the Administration Guide.

Understanding Documentation, Output Files, and Task Comments

The following tabs on the Task Details window provide information about the task:

- **Documentation**: Information written by the person who created the job or process flow. Documentation provides relevant information about the processing of a task. It can be comments, suggestions, or instructions. Documentation cannot be altered from the Explorer window.

- **Output Files**: Output files created on the agent machine when the task is run. Output files include system and application files for the task. Output files can be opened for viewing using the File Viewer window.

- **Comments**: Information about the running of a task. Applications Manager automatically creates comments that:
  - Tell about condition actions that affect the running of a task.
  - Detail DELETE, HOLD, RESET, and KILL actions taken by an Applications Manager user.
  - Give details on tasks with a LAUNCH ERR status.

Additionally, you can include your own comments to provide relevant information about the processing of a task. Comments are not files, and should not be confused with documentation or output files.

Subtopics

The following subtopics detail viewing and editing task details.

4.10.1 General Task Details: Viewing and Editing
4.10.2 Task Prompts: Viewing and Editing
4.10.3 Pending Predecessor Links: Viewing and Removing
4.10.5 Task and Predecessors in a Flow Diagram: Viewing, Adding, and Editing
4.10.6 Task Conditions: Viewing and Editing
4.10.7 Task Documentation: Viewing
4.10.8 Task Output Files: Viewing
4.10.9 Task Comments: Adding and Viewing
4.10 Viewing and Editing Task Details

4.10.1 General Task Details: Viewing and Editing

To view the general task details of a task in the Backlog or History, right-click the task and choose the Task Details option from the pop-up menu. You can edit the fields on the right side of the General tab for tasks in the Backlog. When you edit task details for a job or process flow in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow.

General task details determine how and where a task runs, and with what options. When you edit task details for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow.

**Editing General Task Details in the Backlog**

To change the parameters associated with a task in the Backlog:

1. Right-click the task and select **Task Details** from the pop-up menu.
2. Applications Manager displays the **Task Details** window with the **General** tab selected (see Figure A).
3. Make the desired changes on the **General** tab.
4. You can select the other tabs to view and/or edit additional details for the task.
5. To accept the changes on all tabs, click **OK**.
Table A. View-only fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>The alias name for the job/process flow. You can specify an alias name when the job or process flow is: • Added to a process flow as a process flow component. • Requested with the REQUEST JOB condition action. • Requested using a task name suffix. • Requested with awrun.</td>
</tr>
<tr>
<td>Job</td>
<td>The name of the job or process flow set in the job/process flow definitions.</td>
</tr>
<tr>
<td>User</td>
<td>The user or requestor assigned to the task. Users and requestors are the same thing. They are set for a job or process flow in a schedule or requests. Requestors can be set to ‘No Selection’ in schedules, in which case no user will be listed.</td>
</tr>
<tr>
<td>Run ID</td>
<td>A unique number assigned to a task by Applications Manager at the time the task runs.</td>
</tr>
<tr>
<td>Process Flow Name</td>
<td>The parent process flow, if this task is a process flow component.</td>
</tr>
<tr>
<td>Process Flow Order No.</td>
<td>The order number of the task in its process flow, if the task is a process flow component.</td>
</tr>
<tr>
<td>Request Date</td>
<td>The actual time that the task was placed into the Backlog. Corresponds to the so_request_date database field.</td>
</tr>
<tr>
<td>Started</td>
<td>The actual time that the task was started by the automation engine and processed by the agent. Corresponds to the so_job_started database field.</td>
</tr>
<tr>
<td>Ended</td>
<td>The actual time the task finished processing on the agent. Corresponds to the so_job_ended database field.</td>
</tr>
<tr>
<td>Status</td>
<td>The task status. For a description of the task status values, see Appendix B: Task Status Values.</td>
</tr>
<tr>
<td>Process ID</td>
<td>A unique number assigned to a task by the operating system.</td>
</tr>
<tr>
<td>Status Detail</td>
<td>Details that give additional information on the reason for a task’s status.</td>
</tr>
<tr>
<td>Other Details</td>
<td>When clicked displays a pop-up window with the application status and reference fields. These are used with the PeopleSoft extension and some custom solutions.</td>
</tr>
<tr>
<td>Notification, Output Scan, Environment Variables</td>
<td>Lists the notification, output scan, and environment variable objects assigned to the task and where they are assigned.</td>
</tr>
</tbody>
</table>
### Table B. Editable fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Run Time</td>
<td>Used to prevent runaway programs. It determines how long the program can run before timing out (DDD:HH:MI). A time of 0 lets the task run forever. If a task times out, it is given a status of TIMEOUT.</td>
</tr>
<tr>
<td>Priority</td>
<td>Determines when a job is run in relation to other tasks in the same queue. A task with a lower priority number will be run before tasks with higher numbers. The range is 1–99. The default priority is 50. Tasks submitted with 0 priority will have the status of NO PRIORITY in the Backlog and will not run. The execution order of tasks waiting to run in a QUEUED status is decided in the following order: 1. Queue priority 2. Job priority 3. Start date and time Therefore, if two tasks are waiting to run in different queues, and those queues have the same priority, the jobs’ priorities are checked. If queue and job priorities are the same, their start date and times are compared.</td>
</tr>
<tr>
<td>Login</td>
<td>The login the system will use when the task is executed. Logins allow operators and programmers to run programs that access a database or host without having to know the login and password. Primary and secondary logins can be specified for jobs. The primary login can be overridden (if one is defined for the job) by: • Jobs requested with the REQUEST JOB condition action. • Process flow components.</td>
</tr>
<tr>
<td>Queue</td>
<td>The Applications Manager queue the task will run through. Queues are assigned to jobs and process flows. If a schedule is defined for a job or process flow, and the schedule is assigned to a queue, the schedule’s queue will override the jobs or process flow’s queue. The queue setting for a process flow does not affect its components, unless the <strong>Insert components into process flow’s queue</strong> automation engine option is turned on. The process flow’s queue is used for components only when the <strong>Insert components into process flow’s queue</strong> automation engine option is turned on. Queues can be specified for requests (as long as the Request Queues user option is assigned).</td>
</tr>
<tr>
<td>Agent</td>
<td>The agent where the program is stored and run.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The time that the task was scheduled to start. Corresponds to the <strong>so_start_date</strong> database field. Start dates for tasks in the Backlog are determined by either: • Requests (may be post-dated). • Schedules for jobs and process flows. • The schedule of a component's process flow.</td>
</tr>
<tr>
<td>Send To</td>
<td>Specifies the output device or set of devices where the output will be sent (for example: EMAIL, ACCOUNTING LASER, ATLANTA LASER).</td>
</tr>
</tbody>
</table>
Output Option

- Used for specifying dynamic output options for the selected output device.
- This value or list of values is defined by the output interface assigned to the output device.

Output Function

- Determines how output is handled. There are three choices:
  - LOG: Legacy setting, should not be used unless you need to use the Output window rather than the Explorer window.
  - PRINT: The output is printed.
  - STORE: The output is not printed.

Copies

- Sets the default number of copies to be printed.

Restart once on abort

- When selected, Applications Manager will automatically restart a task the first time it aborts, but will not restart it if it aborts a second time.
- When this option and the Stay in queue on abort option are both set, and the task aborts, you will see three listings for it in the Explorer window:
  - The original listing for the Run ID `<run_id>` in History shows that the task ran.
  - A second listing `<run_id>.01` in History shows that it aborted.
  - The current listing `<run_id>.02` in the Backlog represents the restarted task.

The Restart once on abort setting is specified in each task’s definition, and can be overridden with a condition.
4.10 Viewing and Editing Task Details

4.10.2 Task Prompts: Viewing and Editing

To view the prompts of a task in the Backlog or History, right-click the task and choose the Prompts option from the pop-up menu. You can edit the prompts for tasks in the Backlog. When you edit prompts for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow.

Prompts pass user input to the program run by a task. Prompts for a task, either a job or a process flow, can be viewed and edited from the Backlog and viewed from History. Prompts are defined by the individual that created the job or process flow.

Viewing Prompts

To view the prompts for a task, right-click a task in the Backlog or History and choose Prompts. Applications Manager displays the Task Details window with the Prompts tab selected (see Figure A).

![Figure A. The Prompts tab](image)

Editing Prompts in the Backlog

To edit the prompts for a task in the Backlog:

1. Right-click the task and choose Prompts from the pop-up menu.
   Applications Manager displays the Task Details window with the Prompts tab selected (see Figure A).
2. Click to select a prompt.
3. You can edit the prompt values for each task.
   When you edit prompts for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow.
   You can select the other tabs to view and/or edit additional details for the task.
4. Click OK to accept the changes and exit to the Explorer window.
4.10 Viewing and Editing Task Details

4.10.3 Pending Predecessor Links: Viewing and Removing

To view the pending predecessors for a task in the Backlog, right-click the task and choose the Predecessors option from the pop-up menu. When viewing pending predecessors for a task, you can delete predecessor links or view the referenced tasks’ details.

Applications Manager controls task flow with predecessors. When a task is waiting to run due to predecessor requirements, you can view its pending predecessors. If you want to run the task immediately, you can remove the pending predecessor links.

**Viewing Pending Predecessors**

To view pending predecessors for a task, right-click the task and select **Predecessors** from the pop-up menu. Applications Manager displays a table listing each task that is a predecessor (see Figure A). The **Predecessors** tab is divided into two panes:

- **The External Scheduled Predecessors** pane in the upper part of the tab lists the tasks which are predecessors of the selected task and are not in the Backlog. If tasks are not in the Backlog, but are scheduled to run in the current virtual day, their scheduled start time will be shown in the Schedule column.

- **The Predecessors in Backlog** pane in the lower part of the tab lists the tasks which are predecessors of the selected task and are currently in the Backlog.

To view the predecessor statement for a task, select the task and click the **Pred statement** button. Applications Manager displays the predecessor statement in the **Predecessor Expression** window shown in Figure B.

To view the task details for a task in the table, right-click the task and select an option.

**Understanding Predecessor Link Types**

Descriptions for each link type are given below:

- **Started**: Predecessor must have started or been skipped. Represented by a solid yellow line.
• **Success since last run**: For external predecessors only. Predecessor must complete with a status of FINISHED since the last time this job ran. Represented by a dashed blue line.

• **Success** (default): Predecessor must complete with a status of FINISHED or be removed from the Backlog. Represented by a solid green line.

• **Success only when FINISHED**: For external predecessors only. Predecessor must complete with a status of FINISHED. Represented by a solid blue line.

• **Success (skip on failure)**: Predecessor must complete with a status of FINISHED. If status is ABORTED, DIED, or TIMEDOUT, the component is skipped. Represented by a dashed green line.

• **Failure**: Predecessor must complete with a status of ABORTED, DIED, or TIMEDOUT. Represented by a solid red line.

• **Failure (skip on success)**: Predecessor must complete with a status of ABORTED, DIED, or TIMEDOUT. If status is FINISHED, the component is skipped. Represented by a dashed red line.

• **Complete**: Predecessor completes with any status including FINISHED, DIED, or ABORTED. Represented by a solid black line. Predecessor links to a process flow must use this predecessor link type or the Success link type.

More details on the requirements to satisfy each link type are described in topic 5.3 Understanding Predecessor Execution Rules in the Development Guide.

### Removing Predecessor Links

To remove predecessor links from either pane of the Pending Predecessors window, check the box in the Remove column for the task and click the Apply button. Applications Manager deletes the predecessor link. If there are no other predecessor links, the task should run. This has the same effect as deleting a predecessor link from the referenced task’s Flow Diagram tab.

**Note**: Deleting predecessor links from this tab does not delete tasks from the Backlog.

If you wish to remove all predecessor links for a task in the Backlog, you can do so by right-clicking and selecting the Remove All Predecessors option from the pop-up menu. For more information, see topic 4.9.5 Removing All Predecessors for Tasks.

When you remove predecessor links for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow. For more information on predecessor links, see chapter 5: Working with Predecessors in the Development Guide.

### Removing External Predecessors by Queue

To remove a task’s external predecessor links on insert to the Backlog, assign it to the REMOVE_EXT_PREFS_ON_INSERT queue. You can create the REMOVE_EXT_PREFS_ON_INSERT queue by hand or by exporting it. For more information, see topic 7.8 Removing External Predecessors by Queue.
4.10 Viewing and Editing Task Details

4.10.4 Successors in the Backlog: Viewing

To view the pending successors to other tasks for a task in the Backlog, right-click the task and choose the Successors option from the pop-up menu. When viewing successors for a task, you can right-click to view the referenced tasks’ details.

When a task is in the Backlog, it may be a predecessor to other tasks. Other tasks that have predecessor links to a task are called its successors.

Viewing Successors

To view successors for a task, right-click the task and select Successors from the pop-up menu. Applications Manager displays a table listing each successor as shown in Figure A.

![Figure A](image)

Figure A. Removing pending predecessor links to make a task eligible to run

To view the task details for a task in the table, right-click the task and select an option.
4.10 Viewing and Editing Task Details
4.10.5 Task and Predecessors in a Flow Diagram: Viewing, Adding, and Editing

To view, add, or edit predecessor links for a task in the Backlog in a flow diagram (or to view them in a flow diagram for a task in History), right-click the task and choose Flow Diagram from the pop-up menu.

Predecessors must be met before a task will be eligible to run. They are evaluated prior to any BEFORE conditions the task might have. They can be viewed from the Backlog and History.

The Flow Diagram tab shown in Figure A has a left pane where the process flow or job is displayed, and a right pane where the Predecessor Editor is displayed. Process flow components in the Predecessor Editor box will be written in the format <process flow name>/ <component name>. You can right-click a predecessor in the Predecessor Editor box to change or edit it. You can resize the panes by dragging the splitter bar, and minimize or maximize the panes using the arrows at the top of the splitter bar.

From the Flow Diagram tab, you can monitor and manage objects in much the same way as from Explorer. You can edit predecessor links as well as take actions on tasks such as delete, hold, restart, and kill.

Viewing Predecessor Links in a Flow Diagram

To view the predecessor links for a task in a flow diagram, right-click the task and select Flow Diagram from the pop-up menu. Applications Manager displays the Task Details window with the Flow Diagram tab selected (see Figure A).
External references to scheduled tasks that are not yet in the Backlog will have a dashed border.

**Adding and Editing Predecessor Links in a Flow Diagram**

You can add, edit, or delete internal and external predecessor links for non-running tasks in the Backlog. An internal predecessor link is a link to a component within the parent process flow. An external predecessor is a link to a component outside the parent process flow. When you edit a link, you can change the link type, redirect the link to another component, or delete the link. You can also add external predecessor links for these tasks. You cannot add components to a process flow from the Backlog.

When you add, edit, or delete predecessor links for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow. For more information on predecessor links, see chapter 5: *Working with Predecessors* in the Development Guide.

You can select the other tabs to view and edit the task’s general task details, prompts, documentation, output, and more.

**Disabling Pop-Up Tables**

You can disable the pop-up tables by unchecking the *Show status info* option under the Options menu. The *Show status info* setting can be saved for your workstation by selecting Save Preferences from the File menu. For more information, see topic 5.10 Saving Preferences for Creating Predecessors in the Development Guide.

**Taking Actions on Tasks and Viewing or Editing Task Details**

You can right-click tasks in the Flow Diagram tab to take actions on them or to view or edit their task details the same way you would in the Explorer window. For more information on taking actions on tasks, see topic 4.9 Taking Actions on Tasks in the Backlog. For more information on viewing and editing task details, see topic 4.10 Viewing and Editing Task Details.
4.10 Viewing and Editing Task Details

4.10.6 Task Conditions: Viewing and Editing

To view the conditions of a task in the Backlog or History, right-click the task and choose the Conditions option from the pop-up menu. When you add, edit, or delete conditions for a job (job or process flow) in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow.

Conditions control the execution of tasks. They can be evaluated before, during, and after a task executes, and after a task is deleted. Conditions for a task can be viewed from the Backlog and History. Conditions can be added, edited, or deleted from tasks in the Backlog for a single running of the task.

Procedure

To view the conditions for a task, right-click the task and select Conditions from the pop-up menu. Applications Manager displays the Task Details window with the Conditions tab selected (see Figure A).

To add, edit, delete, or copy a condition for a task in the Backlog, select the appropriate button. When you make changes to conditions for a task in the Backlog, the changes are applied only to that instance of the task. They do not affect the definition of the job or process flow. For more information on defining conditions, see chapter 8: Working with Conditions in the Development Guide. You can select the other tabs to view or edit the task’s general task details, prompts, documentation, output, and more.

Figure A. The Conditions tab
Where Conditions Are Defined

Conditions can be defined for jobs, process flows, and process flow components. The conditions are not included when the job/process flow is assigned to a process flow unless the **Use Job Conditions** option is checked for the component.
4.10 Viewing and Editing Task Details

4.10.7 Task Documentation: Viewing

To view documentation for a task in the Backlog or History, right-click the task and choose the Documentation option from the pop-up menu. If Documentation is grayed out on the pop-up menu, the task has no documentation.

Documentation is written by the person who created the job or process flow. It provides relevant information about the processing of a task. Documentation can be comments, suggestions, or instructions. You can access documentation from the Backlog or History, when it has been included.

Documentation Assigned to Objects

Documentation can be assigned to three different objects in Applications Manager:

- **Jobs**: Job documentation is used when a job is going to be requested ad hoc, or when the documentation for a job would be useful—regardless of how it is invoked.
- **Process Flows**: Process flow documentation is used to provide information about the entire process flow.
- **Process Flow Components**: Process flow component documentation is used to provide information that is specific to a process flow component.

All documentation for a task is displayed on the Documentation tab of the Task Details window.

Types of Documentation

There are two types of documentation: abort and general. Abort documentation provides instruction or information for when the task aborts. General documentation provides information about the function of the job or process flow. Both types of documentation are available for viewing at all times regardless of task status.

Procedure

To view the documentation for a task in the Backlog or History:

1. Right-click the task in the Backlog or History and select Documentation from the pop-up menu. If Documentation is grayed out on the pop-up menu, the task has no documentation.

   **Note**: You can right-click process flow components in the Backlog or History panes or in the icon tree.

   Applications Manager displays the Task Details window with the Documentation tab selected (see Figure A).
2. In the top portion of the window, select the type of documentation you wish to view. Applications Manager displays the documentation you selected in the bottom portion of the window.

You can select the other tabs to view and/or edit additional details for the task.

3. Click OK to close the window.

For information on adding documentation to jobs, process flows, and process flow components, see topic 2.8 Adding Job Documentation in the Development Guide.
4.10 Viewing and Editing Task Details

4.10.8 Task Output Files: Viewing

To view the output files for task in the Backlog or History, right-click the task and choose the Output Files option from the pop-up menu. Click View on the Output Files tab to view the task’s output files in the File Viewer window.

After a task finishes executing, it is moved into History. You can see how the task was executed by viewing the task’s standard output file. This can be useful for troubleshooting tasks that fail. You can also view output files generated by the task.

Procedure

To view the output files generated by a task after it completes executing:

1. Right-click the task and choose Output Files from the pop-up menu.
   Applications Manager lists the system and application output files for the task on the Output Files tab of the Task Details window.
   When job definitions include program types that ship with Applications Manager, standard output and error file names begin with an ‘o’. Output files generated by the task begin with a ‘b’ (see Figure A). If custom program types are assigned to your jobs, their output files may be named differently.
   The list for process flows will include the output files of all its components.

2. To print an output file without opening the File Viewer window, select a task and click the Print button or one of the Print icons. For more information on printing output files, see topic 3.5 Printing, FTPing, and Emailing Output Files.

3. To view a file, select the file and click View.
   Applications Manager displays the File Viewer window. For information on using the File Viewer window and printing output files, see topic 3.4 Viewing Output Files with the File Viewer.
   You can select the other tabs to view and/or edit additional details for the task.
Figure A. From the Output Files tab on the Task Details window, you can access the File Viewer to view task output files.
4.10 Viewing and Editing Task Details

4.10.9 Task Comments: Adding and Viewing

To view or add comments for tasks in the Backlog or History, right-click the task and choose Comment from the pop-up menu. You can search for comments from previous runs of a task or for other jobs and process flows using the Comments Query tab on the Task Details window.

Task comments provide information about the running of a task. Applications Manager automatically creates comments that:

- Detail actions taken by an Applications Manager user.
- Tell about condition actions that affect the running of a task.
- Give output scan details when rules are met.
- Give details on tasks with a LAUNCH ERR status.

Additionally, you can include your own comments to provide relevant information about the processing of a task. You access, add, and query comments from the Backlog or History.

Viewing and Adding Comments for a Task

To view comments and add an comment to a task:

1. Right-click the task and choose Comments from the pop-up menu.

Applications Manager opens the Task Details window with the Comments tab selected (see Figure A). If there are any entries for the task, they are displayed in the Log box.

Each entry includes the user name of the person who wrote the comment, and the date and time it was submitted. In Figure A, there are two entries associated with this task.

2. To add an entry to the task, enter text in the New Entry box at the top of the window and click Add.

Applications Manager adds the entry to the Comment box.

3. To save the entry and keep the window open, click Apply.

4. To save the entry and close the window, click OK.

After you have added an comment entry, you cannot change it. It becomes a permanent part of the task’s history.

Figure A. View or add current comments for a task.
Querying Comments for Other Tasks

To view comments for another task:

1. From the Task Details window, select the Comment Query tab. The table on the top of the screen displays all previous comments for the selected job or process flow (Figure B).

2. Select a comment from the table to view its text below.

3. To view comments for other jobs/process flows, select the job/process flow from the Job drop-down box. You can also query by keywords in the text.

Viewing a Comment Report

To view a report of comments, select Explorer Reports from the Reports menu on the Explorer window. This will open the Reports window with the Explorer reports selected. Select the AW_OPERATOR_LOGS report and click Show.
4.11 Unsatisfying Tasks as External Predecessors in History

To unsatisfy a task as a predecessor for all potential predecessor links, right-click the task listing in History and select Unsatisfy for Predecessors. The predecessor links of other tasks need to be satisfied by another running of this task.

There may be times when you run a task that serves as an external predecessor to one or more other tasks, and you need to rerun the task. This may happen when the task completes successfully, but is run with incomplete data.

To disallow predecessor links to this task, you must unsatisfy it as a predecessor. Once a task is unsatisfied as a predecessor, it is as if it did not run. All predecessor links to it will not be satisfied until the job, process flow, or process flow component runs again.

Figure A. You can unsatisfy this run of a task as a predecessor for all potential predecessor links from History.
**Procedure**

To unsatisfy a task as a predecessor for all potential predecessor links, right-click the task listing in History and select *Unsatisfy for Predecessors* from the pop-up menu as shown in Figure A. Applications Manager changes the task's status to UNSAT-FINISH and unsatisfies this running of the task as a predecessor for all predecessor links which reference it, as shown in Figure B. The predecessor links of other tasks will now need to be satisfied by another instance of this job, process flow, or process flow component.

![Figure B. A task in an UNSAT-FINISH status](image)
4.12 Managing ZOS Tasks

ZOS tasks include ZOS and JCL Editor tabs. You can edit information on both tabs for tasks in the Backlog. You can edit the JCL for tasks regardless of whether they reside in the Operations Manager database or OS/390 system.

ZOS tasks include **ZOS** and **JCL Editor** tabs. You can edit the information on either (or any other tab) to make changes to the task.

*Figure A. The ZOS tab shown in the task details for a ZOS task.*
Viewing and Editing Information on the ZOS Tab

The ZOS tab includes the following information that can be edited for tasks in the Backlog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Determines where the JCL will reside:</td>
</tr>
<tr>
<td>Contained in the Operations Manager database: The task information will be stored in the Operations Manager database. When this option is checked, you can use the JCL Editor tab to customize the JCL for the task. For more information on the JCL Editor tab, see Editing the JCL later in this topic.</td>
<td></td>
</tr>
<tr>
<td>JCL from OS/390: The JCL comes from OS/390. When this option is selected, you select a library and program from the General tab of the job's definition.</td>
<td></td>
</tr>
<tr>
<td>JCL include Jobcard from OS/390: The JCL includes a Jobcard from OS/390. When this option is selected, you select a library and program from the General tab of the job's definition.</td>
<td></td>
</tr>
<tr>
<td>Sysout</td>
<td>Determines how output in handled:</td>
</tr>
<tr>
<td>Database: The SYSOUT protocol is managed by UC4. It consists of the JES statistics and the complete Job output, as long as the Job output is not excluded by an entry in the INI file. After the Job execution, the SYSOUT protocol is transferred to the UC4 database via FileTransfer.</td>
<td></td>
</tr>
<tr>
<td>File: The SYSOUT protocol is managed by UC4. After the Job execution, the SYSOUT protocol is available as a file in the target system.</td>
<td></td>
</tr>
<tr>
<td>On error only: In case of Job interruption, the SYSOUT protocol is saved in the UC4 database and/or a file in the target system. This is only available when &quot;Database&quot; and/or &quot;File&quot; have been selected.</td>
<td></td>
</tr>
<tr>
<td>Jobname</td>
<td>The Job name.</td>
</tr>
<tr>
<td>Job Class</td>
<td>Specification of the Job class in which the Job should run.</td>
</tr>
<tr>
<td>Priority</td>
<td>Specification of the Job's priority. A value between 0 and 15 may be entered for priority.</td>
</tr>
<tr>
<td>Programmer name</td>
<td>Identifies the programmer who owns the job or its group. The name is recorded in the job card of the job.</td>
</tr>
<tr>
<td>Account</td>
<td>Accounting information on the job.</td>
</tr>
<tr>
<td>MsgClass</td>
<td>Assignment of the task log's message class.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**MsgLevel** | Trace option for the task log. Possibly a numerical value for command and message separated by a comma. Permitted formats:
• `<command number>,<message number>`
• `,<message number>`
• `<command number>`
Permitted values for outputting commands:
• **0** - Output only commands.
• **1** - All job commands, JES2 or JES3 control commands, procedure commands and all IEF653I messages.
• **2** - Only all job commands (JCL) and the JES2 or JES3 control commands.
Permitted value for outputting messages:
• **0** - Only JCL messages. For cancels, also JES control commands and operator messages. For SMS errors, also the corresponding messages.
• **1** - All JCL, JES, operator and SMS messages.

**Notify** | Specification of a notify on OS/390.

**Job parameters** | Optional parameters for the job. You can enter commands such as `RESTART=P020` to restart at a command number.

**Max return code** | Allows the task to succeed with any return code up to a given number. Entering a value here deactivates the **Step Return Codes** table.

**Step Return Codes** | Optionally determine whether the task should succeed or fail based on specific return adding step conditions to the **Step Return Codes** table. You add step conditions by entering values in the **Step name**, **Return code**, and **Job entered OK** fields and clicking **Add step condition**.
The **Return code** field allows for comma separated values or range of values written with a - between them. The step return codes are evaluated in the order they are listed.
Editing the JCL

You can edit the JCL for tasks regardless of whether they reside in the Operations Manager database or OS/390 system with the JCL Editor tab shown in Figure B. Changes to the JCL are made only to this run of the task. You can use the ISPF editor by keeping the ISPF Editor box checked. To turn it off, simply uncheck the box.

To check the type run scan, click the Type run scan button. When errors occur, details are displayed in the Type run scan results box on the bottom of the tab.

![Figure B. The JCL Editor tab shown in the task details for a ZOS task.](image)


4.13 Viewing History in a Gantt Chart

To view one or more tasks in History in a Gantt chart format, select the tasks, right-click and choose the History Gantt view option. If you select process flows or process flow components, Applications Manager displays all tasks in the corresponding process flow(s).

The History Gantt view is part of the Graphical Analysis Package add-on product of Applications Manager. You use it to display tasks in History in a Gantt chart format.

Procedure

To view one or more tasks in History in a Gantt chart format:

1. Select one or more tasks in History.
2. Right-click and choose the History Gantt view option as shown in Figure B. Applications Manager opens the History Gantt view window shown in Figure A.
   If you select process flows or process flow components, Applications Manager displays all tasks in the corresponding process flow(s).
   For detailed information on the features available in all Gantt windows, see chapter 9: Monitoring and Managing Tasks with the Gantt View.
3. If you wish, you can right-click a task and select Flow Diagram to view its predecessors in a flowchart view.
Subtopic

The following subtopic explains how to compare run times of tasks in History using the **History Gantt view** window.

4.13.1 Comparing Run Times in a Gantt Chart
4.13 Viewing History in a Gantt Chart

4.13.1 Comparing Run Times in a Gantt Chart

You can graphically compare run times of tasks in History. To do this, run a History query on a job or process flow, then view the queried tasks in the History Gantt view window. In the History Gantt view window, select Set start times to midnight from the Actions menu.

Using a History query and the History Gantt view window, you can compare run times of tasks in History.

Procedure

To compare run times of tasks in History:

1. Select two or more records for jobs and/or process flows in History that you want to compare.

You may want to run a History query of the tasks you wish to compare. For information on running History queries, see 5.2 Querying for Tasks in History.

In Figure A, two instances of the INV_STATUS job are selected.
2. Right-click the **History Gantt view** option from the pop-up window. Applications Manager opens the **History Gantt view** window shown in Figure B.

![History Gantt view window with process flows displayed](image)

*Figure B. The History Gantt view window with process flows displayed*

3. In the **History Gantt view** window, select **Set start times to midnight** from the **Actions** menu.

4. Applications Manager displays all start times as midnight so you can compare run times as shown in Figure C.

![History Gantt view window with midnight start times](image)

*Figure C. All start times are shown as midnight for easy comparisons.*
4.14 How Applications Manager Handles System Failures

The Applications Manager object-oriented architecture ensures orderly recovery after system failures.

If your system should fail for minutes, hours, or days, the Applications Manager modular process flows ensure orderly recovery. Applications Manager keeps a record in its Oracle database of each task and the task’s status. When you bring your system back up, Applications Manager restores each task to the status it had at the time the system went down.

How Applications Manager Handles Tasks in the Backlog

If the machine where the Applications Manager automation engine is installed goes down, Applications Manager goes through a recovery procedure when the machine comes back up. The table below describes how Applications Manager handles tasks that have already been submitted and are displayed in the Backlog.

<table>
<thead>
<tr>
<th>Task status at time of crash</th>
<th>Task status after recovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting or Running</td>
<td>Applications Manager checks to see if the task process ID exists. If it exists, the status will be RUNNING. If the task process ID does not exist, the status will be DIED. You can restart the task from the Backlog.</td>
</tr>
<tr>
<td>Thread Wait</td>
<td>Status will be THREAD WAIT.</td>
</tr>
<tr>
<td>Date Pending</td>
<td>If the scheduled start date is still in the future, the status will be DATE PENDING. If the start date has passed, Applications Manager will launch the task as soon as possible after the system is brought back online.</td>
</tr>
<tr>
<td>Finished</td>
<td>The task will be moved to History with a status of FINISHED.</td>
</tr>
<tr>
<td>Aborted</td>
<td>If the Restart once on abort option is selected for the job, and this is the first time the task has aborted, Applications Manager will run the task as soon as possible after the system is brought back online.</td>
</tr>
</tbody>
</table>
The Effect of Agent and Network Failures

The following table describes what happens when a task is running and the agent, agent machine, or network goes down.

<table>
<thead>
<tr>
<th>When a task is running and the agent</th>
<th>AND the machine running the agent</th>
<th>AND the network</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>is up</td>
<td>is up</td>
<td>is up</td>
<td>The status is RUNNING.</td>
</tr>
<tr>
<td></td>
<td>goes down</td>
<td></td>
<td>The status of the task in the Backlog is not changed, however the agent will continue to monitor the task. When the network comes back up, Applications Manager checks with the agent and updates the status as RUNNING, FINISHED, or ABORTED.</td>
</tr>
<tr>
<td>goes down</td>
<td>is up</td>
<td></td>
<td>The status of the task in the Backlog is not changed. When the machine and agent come back up, Applications Manager marks the task as DEAD. You can restart the task from Applications Manager.</td>
</tr>
<tr>
<td>goes down</td>
<td>is up</td>
<td>is up</td>
<td>The status of the task in the Backlog is not changed. When the agent comes back up, Applications Manager checks if the task completed. If the task completed, Applications Manager reports the status. If the task did not complete, Applications Manager will look for the task’s PID. If it finds the PID, it will mark the status as RUNNING. If it does not find the PID, it will mark the status as DEAD.</td>
</tr>
</tbody>
</table>

How Schedules Impact Recovery

Jobs and process flows scheduled to run during the down time will run once when the system is brought back up. They will then return to their normal schedule. It does not matter how many times the job or process flow was scheduled to run during the down time. Each job or process flow will run only one time before returning to its normal schedule, unless a date was entered in the Reschedule from field. For information on schedules, see chapter 9: Scheduling Jobs and Process Flows in the Development Guide.

If the Oracle Tables Are Lost

If the Applications Manager Oracle tables are lost as a result of the system failure, all status information will be lost. You will need to restore the Oracle database and let Applications Manager resume processing based on the schedule information restored by the backup.
Chapter 4: Monitoring and Managing Tasks in Explorer
5

Querying and Filtering Explorer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Introduction to Querying and Filtering Explorer</td>
<td>128</td>
</tr>
<tr>
<td>5.2 Querying for Tasks in History</td>
<td>130</td>
</tr>
<tr>
<td>5.3 Filtering the Backlog and History</td>
<td>134</td>
</tr>
</tbody>
</table>
5.1 Introduction to Querying and Filtering Explorer

You run History queries and Backlog & History filters by picking an option from the Filter menu on the Explorer window.

History queries help you find records in the Applications Manager database for tasks that have run and agent/RMI statuses that have changed. Results for History queries are displayed in the History pane of the Explorer window. When a History query is active, the History pane is not refreshed. If you want to view updated query results, you must re-run the query.

Backlog & History filters allow you to limit the entries in the Backlog and History displays on the Explorer window. Results from Backlog & History filters are limited to the tasks and records currently in the Backlog and History display. When a Backlog & History filter is active, the lists in the Backlog and History panes on the Explorer window continue to refresh.

You run History queries and Backlog & History filters by picking an option from the Filter menu on the Explorer window as shown in Figure A.

---

**Figure A.** Run History queries and Backlog & History filters by picking an option from the Filter menu on the Explorer window.
What is the Backlog?

The Backlog is a list of tasks that:

- Are waiting to run.
- Are running.
- Have run and failed, and have stayed in the Backlog for operator intervention.

To view all tasks in the Backlog in the content pane on the top right side of the screen, click the Backlog icon in the object tree shown in Figure A. In the Backlog in Figure A, some tasks are running, some are waiting in a PRED WAIT status, and one task has aborted.

Whether a task remains in the Backlog when it fails is determined by the Stay in queue on abort setting in its job definition.

You can type the first few letters of an task from the Backlog’s name in the Search field, and Applications Manager will find it. The Search field accepts valid UNIX regular expressions. For example, to search for all jobs starting with the letters A and T, you would enter [at] in the Search field. For more information on syntax accepted by regular expressions, see Appendix A: Regular Expression Tables in the Development Guide.

What is History?

History is an audit trail including records for:

- All completed tasks and occurrences of task failure(s).
- RMI servers or agents being started, stopped, or having errors.
- AgentService processes being stopped.

How long task history records are archived in the Applications Manager database is determined by the prompt setting for the HISTORY_PURGE job, which is part of the SYSTEM process flow. The default value is 60 days. Your Applications Manager administrator is responsible for setting this value.

The Explorer window includes a partial view of History in its lower right pane.

The amount of History displayed when any user logs in to the client is determined by the HistoryRetentionTime setting in the Options.properties file. For more information, see topic 12.4 Options.properties File in the Administration Guide.

How long records are displayed in the History pane while you are logged into an Applications Manager session is determined by:

- Your History Display Minutes desktop setting. For more information, see topic 1.4 Editing General Desktop and ToolBar Settings.
- Whether you have a History query activated.
To search for specific records in History, go to the Filter menu and select History Query. You can query by queues, jobs, process flows, task statuses, agents, requestors, start times, and run IDs. You can decide whether to limit the viewable History to the results of the query, or add the query results to the current History display. History query settings can be saved and used again.

To perform a History query for the Explorer window, open the Filter menu and choose History Query. Applications Manager displays the History Query window shown in Figure A.

You select search criteria for your query. You can query by one or more options by entering values in as many fields as you like. Fill in the fields by doing one or both of the following:

- Typing in values
- Selecting values from a list

You may select a default sort order for the query by selecting a Sort option at the end of a field. The sort order can be overridden from the History pane by selecting a different column name.

When you are through defining the query, click OK. Applications Manager displays a small animated window as it processes the query. Once the query is processed, Applications Manager displays the results in the History pane of the Explorer window.

Field descriptions for the History Query window are described in Table A. Directions for the two methods of filling in the fields follow.

![Figure A. You can limit the tasks listed in History using the History Query window.](#)

### Table A. History query options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs</td>
<td>Searches for any task assigned to the specified job(s). To query for a task run under an alias, enter the alias name.</td>
</tr>
<tr>
<td>Process flows</td>
<td>Searches for process flow(s) and components.</td>
</tr>
<tr>
<td>Applications</td>
<td>Searches for any task assigned to the specified application(s).</td>
</tr>
<tr>
<td>Agents</td>
<td>Searches for any task run on the specified agent(s).</td>
</tr>
<tr>
<td>Queues</td>
<td>Searches for any task run on the specified queue(s).</td>
</tr>
<tr>
<td>Requestors</td>
<td>Searches for any task run by the specified requestor(s).</td>
</tr>
</tbody>
</table>
Typing in Values

You can type comma-separated names in the fields. These fields also allow the use of:

- **Wildcards:** The _ wildcard is used to represent a single character, and the '%' wildcard represents an unlimited number of characters.

- **Negative filters:** The ! character is used as a negative filter to exclude tasks from the search. For example, entering IAW% will exclude tasks with the letters AW together in their name.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Searches for any task assigned the specified task status(es). For a description of the task status values, see Appendix B: Task Status Values.</td>
</tr>
<tr>
<td>From start time</td>
<td>These fields accept date/time information. If the Current day option is selected, the From start time and To start time fields will be inactive. If you save a query for tasks run in the last two days, it will always run a query for the tasks in the last two days. There is no way to save a query from a specific date.</td>
</tr>
<tr>
<td>To start time</td>
<td></td>
</tr>
<tr>
<td>Run ID</td>
<td>This field references the unique number assigned to each task by Applications Manager. When using this field do not include the decimal values.</td>
</tr>
<tr>
<td>Current day</td>
<td>The default is to query by the current day. All tasks run from midnight to the current time will be included. If you save a query with this option checked, it will be applied each time you run the saved query. If you uncheck the option, the From start time and To start time fields become active. You can then enter specific dates and times for the query.</td>
</tr>
</tbody>
</table>

Selecting Values from a List

When you click on an icon at the end of one of the applicable fields in the **History query** window, Applications Manager displays the object assignment window where you can pick one or more objects. The windows will list only the objects to which you have user group access. Use the arrow buttons to move objects between the **Unassigned** and **Assigned** tables. For information on assigning objects, see topic 1.3 Working in the Applications Manager Windows.

Use the **Search** field to query the **Unassigned** table. You can apply the search criteria to the **Assigned** column as well by unselecting the **Show all assigned** option.

You can use negative filters to exclude tasks from the search based on the items you select by checking the **Negative Filter** box before assigning objects. When an object is added as a negative filter, it will have the ! character before its name in the **Assigned** table.
Use the Other filters field to type in comma-separated names. This field allows for wildcards and negative filters as described in the “Typing in Values” section above.

Any text entered in the Other filters field will be included in the appropriate field on the Select filters window.

Adding the Queried Results to History

By default Applications Manager limits the records in the History pane to the results of the query. If you would rather add the queried results to the current History display, click the Add to Current History box on the History Query window.

When you add the queried results to the current History display, the records will be added to the History pane and the Apply Query box on the Explorer window will not be checked. The records added from the query will remain in History for the number of minutes you have defined in your History Display Minutes desktop setting. To see them again, you can run another query. For more information on the History Display Minutes desktop setting, see topic 1.4 Editing General Desktop and ToolBar Settings.

Saving a Query

You may also optionally save a History query to use later by entering a name in the Filter name drop-down box. The History query will be saved when you click OK.

Saved History queries can be recalled from the Filter name drop-down box for History queries, Output queries, and filters of the Backlog and History.

You can delete a saved query by selecting it and clicking Delete.
Viewing Query Results

When you run a query, the **Apply Query** check box will be selected and the column headers will be displayed with a light orange background (see Figure C).

![Figure C. The History is queried. The Apply Query box is checked and the column headers for History are displayed with light orange backgrounds.](image)

Applications Manager will not refresh the query’s results. If you want to view updated query results, you must re-run the query.

To view the unqueried History, uncheck the **Apply Query** box. You can view the queried results again by rechecking the **Apply Query** box. If you select the **History Query** menu item again, Applications Manager returns you to the **Query Definition** window. Applications Manager displays the search criteria you defined on your last query. To run a new query, select new data and click **OK**.
5.3 Filtering the Backlog and History

You can limit the tasks shown in the Backlog and History by opening the Filter menu and choosing Filter Backlog and History. You can filter by queues, jobs, process flows, task statuses, agents, requestors, start times, and run IDs. Filter settings can be saved and used again.

Backlog & History filters allow you to limit the entries in the Backlog and History displays on the Explorer window. Results from Backlog & History filters are limited to the tasks and records currently in the Backlog and History display.

To perform a Backlog & History filter of the Explorer window, open the Filter menu and choose Filter Backlog and History. Applications Manager displays the Select filters window shown in Figure A.

You select search criteria for your filter. You can filter by one or more options by entering values in as many fields as you like. Fill in these fields by doing one or both of the following:

- Typing in values
- Selecting values from a list

You may select a default sort order for the query by selecting a Sort option at the end of a field. The sort order can be overridden from the Backlog or History panes by selecting a different column name.

When you are through defining the filter, click OK. Applications Manager displays a small animated window as it processes the filter. Once the filter is processed, Applications Manager displays the results in the Backlog and History panes of the Explorer window.

Field descriptions for the Select filter window are described in Table A. Directions for the two methods of filling in the fields follow.
**Table A. Backlog and History filter options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs</td>
<td>Searches for tasks assigned to the specified job(s), including tasks running the job under an alias name. To query for a task run under an alias, enter the alias name.</td>
</tr>
<tr>
<td>Process flows</td>
<td>Searches for the selected process flow(s) and their components.</td>
</tr>
<tr>
<td>Applications</td>
<td>Searches for any task assigned to the specified application(s).</td>
</tr>
<tr>
<td>Agents</td>
<td>Searches for any task run on the specified agent(s).</td>
</tr>
<tr>
<td>Queues</td>
<td>Searches for any task run on the specified queue(s).</td>
</tr>
<tr>
<td>Requestors</td>
<td>Searches for any task run by the specified requestor(s).</td>
</tr>
<tr>
<td>Status</td>
<td>Searches for any task assigned the specified task status(es). For a description of the task status values, see Appendix B: Task Status Values. This is a common field where negative filters are used. For example, if IST% is entered in this field, Applications Manager will not display components in various staged statuses in the Backlog including: STAGED, STG SKIP, STAGED HOLD, STG_PW HOLD, and STAGED_PW.</td>
</tr>
<tr>
<td>From start time</td>
<td>These fields accept date/time information. If the Current day option is selected, the From start time and To start time fields will be inactive. If you save a filter for tasks run in the last two days, it will always run a filter for the tasks in the last two days. There is no way to save a filter from a specific date.</td>
</tr>
<tr>
<td>To start time</td>
<td></td>
</tr>
<tr>
<td>Run ID</td>
<td>This field references the unique number assigned to each task by Applications Manager. When using this field do not include the decimal values.</td>
</tr>
<tr>
<td>Current day</td>
<td>The default is to query by the current day. All tasks run from midnight to the current time will be included. If you save a query with this option checked, it will be applied each time you run the saved query. If you uncheck this option, the From start time and To start time fields become active. You then can enter specific dates and times for the query.</td>
</tr>
<tr>
<td>Future Hours</td>
<td>This field is used to look ahead X number of hours for staged tasks and requested tasks with a start date/time in the future. It works in conjunction with the From start time and To start time fields, with Applications Manager calculating the greatest time span based on both criteria.</td>
</tr>
</tbody>
</table>
Typing in Values

You can type in comma-separated names in the fields. These fields also allow the use of:

- **Wildcards**: The `_` wildcard is used to represent a single character, and the `%` wildcard to represent an unlimited number of characters.
- **Negative filters**: The `!` character is used as a negative filter to exclude tasks from the search. For example, entering `!AW%` will exclude tasks with the letters `AW` together in their name.

Selecting Values from a List

When you click on an icon at the end of one of the applicable fields in the History query window, Applications Manager displays the object assignment window where you can pick one or more objects. The windows will list only the objects to which you have user group access. Use the arrow buttons to move objects between the Unassigned and Assigned tables. For information on assigning objects, see topic 1.3 Working in the Applications Manager Windows.

Use the Search field to query the Unassigned table. You can apply the search criteria to the Assigned column as well by unselecting the Show all assigned option.

You can use negative filters to exclude tasks from the search based on the items you select by checking the Negative Filter box before assigning objects. When an object is added as a negative filter, it will have the `!` character before its name in the Assigned table.

![Object assignment window for jobs](image)

**Figure B. Object assignment window for jobs**

Use the Other filters field to type in comma-separated names. This field allows for wildcards and negative filters as described in the “Typing in Values” section above.

Any text entered in the Other filters field will be included in the appropriate field on the Select filters window.
Viewing Filter Results

Applications Manager runs the search and displays the filtered results. The Apply Filter check box will be selected and the column headers will be displayed with an orange background (see Figure C). To view the unfiltered Backlog and History, uncheck the Apply Filter box. You can view the filtered results again by rechecking the Apply Filter box. If you select the Filter Backlog & History menu item again, Applications Manager returns you to the Select filters window. Applications Manager displays the search criteria you defined on your last filter. To run a new filter, select new data and click OK. To select a saved filter, select it from the drop-down box between the two check boxes in the History pane.

![Figure C. The Backlog and History are filtered. The Apply Filter box is checked and the column headers are displayed with light orange backgrounds.](image-url)
Chapter 5: Querying and Filtering Explorer
Staging Tasks in the Backlog

6.1 Introduction to Staging Tasks in the Backlog ......................................................... 140
6.2 Staging Tasks ......................................................................................................... 142
6.3 Managing Staged Tasks ......................................................................................... 144
6.1 Introduction to Staging Tasks in the Backlog

Staging tasks in the Backlog allows you to edit task details in the Backlog without waiting until they are ready to run.

By default, scheduled tasks appear in the Backlog when they are ready to run. To bring them into the Backlog ahead of time, you can stage tasks up to 48 hours in the future.

Staging tasks in the Backlog gives you the opportunity to:

- View scheduled tasks in the Backlog before they run.
- Alter a task's details before it runs.
- Delete a task before it runs.

For information on altering task details, see topic 4.10 Viewing and Editing Task Details.

How Tasks Are Staged

Tasks are staged by running the either the STAGING or STAGING_BY_SCHEDULE jobs. When you run one of these jobs, you tell Applications Manager which tasks to stage by specifying prompt values. They can be scheduled or requested ad hoc. For more information, see topic 6.2 Staging Tasks.

Staging and the Virtual Day

The virtual workday is a point in time each day that limits how far back Applications Manager will search in the Backlog and History for a predecessor. When a task is staged, its virtual day is set based on its start time. For more information on predecessors and the virtual day, see chapter 5: Working with Predecessors in the Development Guide.
Lights Out vs. Operations-Intensive

There are two basic Applications Manager environments:

- **Lights out**: No one monitors Applications Manager. Tasks run based on their schedules, predecessor links, and conditions. An email or page is sent out when tasks or agents have trouble.

- **Operations-intensive**: Operators monitor and manage Applications Manager. Some tasks are scheduled, while others are requested ad hoc. Operators are often called to change runtimes of tasks or to edit tasks before they run.

Most customers function somewhere in the middle.

Staging for Lights Out Shops

If you are strictly a lights out shop, there is little need to stage tasks. You would not need to schedule the STAGING or STAGING_BY_SCHEDULE jobs. In the rare cases when you need to make changes for the running of a task, you could request one of them ad hoc for one task only.

Staging for Operations-Intensive Shops

If you are an operations-intensive shop, you may want to stage tasks in a few different ways. One would be to stage all tasks that will run during each operator's shift. All tasks for an eight hour period would be listed in the Backlog. This way operators can see everything that is going to run and quickly edit tasks when they are instructed to. A second method would be to stage only particular tasks. You might do this if several tasks are scheduled, but only a few typically need to be edited. A third method would be to only stage tasks when changes need to be made. Operators might do this if they do not want a lot of scheduled tasks shown in the Backlog.
6.2 Staging Tasks

Applications Manager staging allows you to edit tasks before they run. You stage tasks by running either the STAGING or STAGING_BY_SCHEDULE job. You tell Applications Manager which tasks to stage by specifying prompt values.

You tell Applications Manager which tasks to stage by specifying prompt values and running either the STAGING or STAGING_BY_SCHEDULE job. These jobs can be scheduled or requested on an ad hoc basis. Jobs and process flows should not be edited, and you should not run exports or imports while these jobs are running.

Two Staging Jobs

The STAGING and STAGING_BY_SCHEDULE jobs both ship with Applications Manager. They allow you to stage jobs and process flows. The difference between the two jobs is their second prompt.

Which staging job you want to run depends on whether you want to stage jobs and process flows based on all of their schedules or some of their schedules. For example, you may want to stage a job that includes two schedules that run with different prompt values for different departments. To make sure you stage the correct task, you would stage the job by running STAGING_BY_SCHEDULE.
Prompt Values

The staging jobs include the following prompts.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications to be Staged</td>
<td>Use the Select button to select one or more Applications Manager applications.</td>
</tr>
<tr>
<td>Process Flows/ Jobs</td>
<td>Use the Select button to select:</td>
</tr>
<tr>
<td>Process Flows/ Jobs-&gt;Schedule Name</td>
<td>• For STAGING: individual jobs and process flows with schedules from the application(s) selected in the first prompt.</td>
</tr>
<tr>
<td></td>
<td>• For STAGING_BY_SCHEDULE: schedules from jobs and process flows with schedules from the application(s) selected in the first prompt.</td>
</tr>
<tr>
<td></td>
<td>If one or more applications are selected, but no process flows or jobs, then all process flows/jobs of the selected applications will be staged. Any scheduled process flows or jobs not staged will be inserted in the Backlog at their regularly scheduled time.</td>
</tr>
<tr>
<td>Include Hour/ Minute Schedules</td>
<td>Determine whether you wish to include process flows/jobs with Hours or Minutes selected in their schedule’s Units box.</td>
</tr>
<tr>
<td>Hours ahead to be staged</td>
<td>Determine the number of hours ahead you want to stage tasks. By default, this prompt has a maximum value of 48 hours. This is so no one accidentally stages out too far. If you wish to stage tasks out longer, you must edit the prompts in the job’s definition. If the Use virtual day for process flow component days of week option is selected for the automation engine, tasks cannot be staged beyond 24 hours from the start of the virtual day. Warning! Staging tens of thousands of tasks can affect Backlog performance.</td>
</tr>
</tbody>
</table>

When you stage a task, the value in its schedule’s Next run date field will be updated to its next run. For more information on the Next run date field, see topic 9.3 Entering General Information for Schedules in the Development Guide.

Creating Multiple Schedules

You can create multiple schedules for these jobs that use different prompt values. For example, you might create the following schedules:

- WORKDAY: Runs Monday through Friday at 9:00 A.M. and lists all process flows and jobs for 8 hours without including hour/minute schedules.
- EVERY_HOUR: Runs every hour and lists all process flows and jobs including hour/minute schedules.
6.3 Managing Staged Tasks

Staged jobs and process flows are shown in the Backlog in a DATE PENDING status. Process flow components are in a STAGED status. You can edit staged tasks exactly the same way you would edit any other non-running task in the Backlog.

Staged jobs and process flows in the Backlog are shown in a DATE PENDING status as shown in Figure A. Components of a process flow in DATE PENDING status will show one of the following statuses:

- STAGED: The component will stay in a staged status until its process flow is initiated.
- STAGED_PW: The component has been staged and is waiting for one or more predecessor requirements to be met. It will not be eligible to run until its parent process flow is initiated and its predecessor requirement are met.
- STG SKIP: The component is part of a process flow but is not eligible to run. This happens when a day of the week is unchecked or a skip calendar is selected in the Schedule box on the component’s General sub-tab. For more information, see topic 4.2 Specifying Calendars and Eligible Run Days in the Development Guide.

You can filter staged tasks in the Backlog using the Future Hours field for a Backlog & History filter. For more information, see 5.3 Filtering the Backlog and History.

Editing Staged Tasks

Staging tasks in the Backlog gives you the opportunity to alter a task's details before it runs. Editing staged tasks is exactly the same as editing any other non-running task in the Backlog. For information on altering task details, see topic 4.10 Viewing and Editing Task Details.
Chapter 6: Staging Tasks in the Backlog
# Working with Agents and Queues

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Introduction to Monitoring and Managing Agents and Queues</td>
<td>148</td>
</tr>
<tr>
<td>7.2</td>
<td>Monitoring Agents</td>
<td>150</td>
</tr>
<tr>
<td>7.3</td>
<td>Managing Agents</td>
<td>152</td>
</tr>
<tr>
<td>7.4</td>
<td>Viewing and Printing Automation Engine and Agent Logs</td>
<td>154</td>
</tr>
<tr>
<td>7.5</td>
<td>Monitoring Queues</td>
<td>156</td>
</tr>
<tr>
<td>7.6</td>
<td>Changing Queue Settings</td>
<td>158</td>
</tr>
<tr>
<td>7.7</td>
<td>Administering Queues</td>
<td>160</td>
</tr>
<tr>
<td>7.7.1</td>
<td>Defining Queues</td>
<td>162</td>
</tr>
<tr>
<td>7.7.2</td>
<td>Defining Thread Schedules</td>
<td>164</td>
</tr>
<tr>
<td>7.8</td>
<td>Removing External Predecessors by Queue</td>
<td>166</td>
</tr>
</tbody>
</table>
7.1 Introduction to Monitoring and Managing Agents and Queues

You can monitor and manage agents and queues from the Explorer window. You can add, edit, or delete queues and thread schedules from the Object Admin menu.

Queues control the flow of tasks. All tasks must pass through an Applications Manager queue to be executed. You control queue throughput by assigning a queue to a thread schedule. You can define an unlimited number of queues.

Agents are instances of Applications Manager; an agent is installed on each machine where tasks are executed. An agent can be an automation engine’s local agent, or a remote agent. The automation engine is also listed along with the agents in the Explorer window. The automation engine schedules and controls task execution on all the agents assigned to it.

You monitor and manage agents and queues from the Explorer window.

Monitoring and Managing Agents

From the Explorer window, you can:

• View information in the Agent Summary including the status of the automation engine and agent(s). An Agent Summary is shown in Figure A.
• View tasks by automation engine, agent, or agent group.
• View agents by machine.
• Start, stop, idle, or resume the automation engine and/or agent(s).
• Reset an agent in a BUSY or TROUBLE status to display a STOPPED status if you do not want its status to affect the status bar.
• Assign thread schedules to the automation engine and agent(s).
• View and print automation engine and agent log files.
• Rollover the log file for the AgentService process.

Figure A. You can manage agents and queues from the Explorer window.

Defining Agents

Agents are created using the Agents window. For detailed information, see topic 4.2 Defining Remote Agents in the Administration Guide.
Activating/Inactivating Agents

When an agent is not active, the status of the agent is INACTIVE. All tasks in the Backlog and newly submitted tasks to the agent will move to History with a status of INACTIVE. You activate or inactivate an agent by checking or unchecking the Active box in that agent’s definition.

Monitoring and Managing Queues

From the Explorer window, you can:

- View information about all queues in the Queue Summary. A Queue Summary is shown in Figure B.
- View tasks by queue.
- Activate or inactivate multiple queues.
- Change a queue’s priority.
- Assign queues to thread schedules to control the number of threads the queue reserves and the number of tasks it can run concurrently.

![Figure B. You can manage queues from the Explorer window.](image)

Defining Queues

Queues are created using the Queues window. For detailed information, see topic 7.7.1 Defining Queues.
7.2 Monitoring Agents

You can view an Agent Summary by clicking the Agents icon from the object tree.

Agents are installed on each machine where tasks are executed. For more information on agents, see chapter 4: Working with the Automation Engine and Agents in the Administration Guide.

Each automation engine has one local agent and can control numerous remote agents and application agents. Several agents are defined and the remote agent NT4 is selected in Figure A. From the Explorer window you can view:

- An agent summary by clicking the Agents icon in the object tree.
- Agents in agent groups by clicking an agent group under the Agent Groups icon in the object tree.
- All agents on a machine by clicking the machine name under the Machines icon in the object tree.
- Agent status based on icons in the Explorer tree and descriptions in the Agent Summary.

Figure A. The Agent Summary
Column Descriptions for the Agent Summary

The Agent Summary displays the status of each agent. The columns are described below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Displays the:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Name of the agent, agent group, or automation engine.</td>
</tr>
<tr>
<td>Status</td>
<td>Current status of the agent. For information on possible status values, see Appendix A: Automation Engine/Agent Status Values.</td>
</tr>
<tr>
<td>Type</td>
<td>Designates each listing as an automation engine or agent type. Note: Although the automation engine and its local agent are defined as a single object in Applications Manager, they are listed separately in the Agent Summary, and separate actions can be taken on them.</td>
</tr>
<tr>
<td>Elapsed</td>
<td>Elapsed time of the agent status.</td>
</tr>
<tr>
<td>CPU</td>
<td>Percentage of CPU usage on the agent machine. The CPU usage is updated about once every minute for each agent and the automation engine. CPU percentages are rounded to the nearest five percent.</td>
</tr>
<tr>
<td>Max Tasks</td>
<td>Number of threads available for the agent.</td>
</tr>
<tr>
<td>Bklg</td>
<td>Number of tasks in the Backlog.</td>
</tr>
<tr>
<td>Run</td>
<td>Number of tasks RUNNING.</td>
</tr>
<tr>
<td>Hold</td>
<td>Number of tasks on HOLD.</td>
</tr>
<tr>
<td>Abtd</td>
<td>Number of tasks ABORTED in the Backlog.</td>
</tr>
<tr>
<td>Process Flow</td>
<td>Number of process flows in the Backlog.</td>
</tr>
</tbody>
</table>

You can customize many tables in Applications Manager, including the Agent Summary. When customizing tables, you determine:

- Which columns are listed.
- What each column is named.
- How each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns in the Agent Summary may be different from what is described above. For more information, see topic 1.8 Customizing Tables.
7.3 Managing Agents

You can start, stop, idle, resume, or reset the automation engine or agents, and edit an agent’s threads by selecting one or more agents (or the automation engine), right-clicking, and selecting from the menu.

You manage the automation engine and its agents in several ways. From the Explorer window you can:

- Take an action on a single agent or automation engine by right-clicking an agent’s icon in the object tree or by right-clicking a listing in the Agent Summary.
- Take an action on one or more agents or the automation engine by highlighting them in the Agent Summary and right-clicking.
- Take an action on all agents and the automation engine by right-clicking the Agents icon in the object tree.
- Take an action on all agents on a machine by right-clicking the machine name under the Machines icon in the object tree.
- Change an agent or automation engine’s thread schedule by right-clicking the agent or automation engine.

Actions you can take on agents are start, stop, idle, resume, and reset. These actions can be taken on the automation engine as well. Each action is described below.

Note: To manage agents, you must have the Take Actions on Agents user option assigned to you by your Applications Manager administrator. For more information on user options, see topic 3.2.1 Setting User Options in the Administration Guide.
Idling and Resuming Agents or the Automation Engine

If you want to stop processing newly submitted tasks through an agent you can idle it. The agent will go to an Idled status and the icon for the agent will be displayed with a yellow triangle over it in the Explorer tree. Tasks in the Backlog set to run on an agent in an Idled status will have a task status of AGENT WAIT. To take the agent out of the idle status, you resume it.

Starting Agents or the Automation Engine

Starting an agent will start processes on that agent if they are stopped and change the agent’s status to Running. The agent may change to an interim Starting status before it moves to Running. Starting an agent is equivalent to issuing the `startso <agent name>` command. It may take some time to update the status when starting agents or the automation engine.

Stopping Agents or the Automation Engine

You should generally idle agents rather than stop them if you want to stop processing tasks on a particular machine. Stopping an agent will put it into a Stopped status, but it will not stop any processes. If an OAE or PEOPLESOFT agent is stopped, Applications Manager won’t poll the application for task status updates. Stopping an agent is equivalent to issuing the `stopso <agent name>` command. It may take some time to update the status when stopping agents or the automation engine. When stopped, agents show a Stopped status and the icon for the agent in the Explorer tree is gray. Tasks in the Backlog set to run on an agent in a Stopped status will have a task status of AGENT WAIT.

Showing BUSY or TROUBLE Agents as Stopped by Resetting

There are times when the machine where an agent is installed is taken down for maintenance. When this happens, the agent will go into a BUSY or TROUBLE status in the Applications Manager client. If you know why the agent is in one of these statuses, and there is no need for action, you may not want the agent’s status to affect the color of the status bar. You can right-click it and choose Reset from the pop-up menu. Resetting an agent only changes its viewable status to Stopped. The reset agent will have no effect on the status bar.

Changing Thread Schedules for the Automation Engine and its Agents

Automation engine and agent thread schedules set the maximum number of concurrent tasks that can run through any combination of queues. To change an automation engine or agent’s thread schedule, right-click the agent icon and select Threads from the pop-up menu. Applications Manager displays the Threads window shown in Figure B where you select a thread schedule. Thread schedules are assigned to automation engines, agents, and queues. You can also specify a local or remote agent’s thread schedule in its definition. For information on defining thread schedules, see topic 7.7.2 Defining Thread Schedules
7.4 Viewing and Printing Automation Engine and Agent Logs

To view the process logs for an automation engine or agent in the File Viewer window, right-click an agent and select View Log from the pop-up menu. You can also roll over AgentService.log files for agents or the RmiServer.log file for the automation engine by right-clicking the agent or automation engine and selecting Agent Log Rollover or RmiServer Log Rollover from the pop-up menu.

The automation engine and agent logs in the log directory are the primary source of information used for diagnosing database and network connection errors, and for checking agent status. The log directory also contains server, import, install, and Applications Manager executable logs.

Viewing Automation Engine/Agent Logs

To view the process logs for an automation engine or agent from Explorer:

1. Right-click on the automation engine or an agent and select View Log from the pop-up menu.
   Applications Manager opens the Agent logs window. All logs will be displayed for the selected agent. Only RmiServer.log files will be displayed for the automation engine.

2. Select the log you wish to view.
   You can limit the list using the Search field or by selecting a log type from the drop-down list.
3. Click the View button.
   The log will display in the File Viewer window. For detailed information using the File Viewer window, see topic 3.4 Viewing Output Files with the File Viewer.
   For information on automation engine/agent processes, see chapter 8: Applications Manager Processes in the Administration Guide.

Printing, FTPing, and Emailing Logs
To print, FTP, or email a log file without opening the file viewer, select a task and select an option from the Print menu or one of the Print icons. For more information on printing output, see topic 3.5 Printing, FTPing, and Emailing Output Files.

Zipping Log Files
You can zip log files to compress them by selecting the file and clicking the Zip button. When the file is zipped, you will still be able to view it from the Applications Manager File Viewer window.
Note: You cannot zip current log files that are still receiving information.

Rolling Over AgentService.log and RmiServer.log Files
You can roll over the current file to create new AgentService.log files for agents or the RmiServer.log files for the automation engine. To rollover one of these logs, right-click on an agent or automation engine and select Agent Log Rollover or RmiServer Log Rollover. You might want to rollover a log file when debug is turned on and you want to isolate what is written in a log. You may also need to rollover the AgentService.log file to view current information for a VMS agent. You cannot read from the current AgentService.log file for a VMS agent without doing this because it is constantly being written to and VMS does not allow you to read and write to the log at the same time.

Customizing the Agent Logs Table
You can customize many tables in Applications Manager, including the table in the Agent logs window. When customizing tables, you determine:
• Which columns are listed.
• What each column is named.
• How each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns in the Agent logs window may be different from what is shown above. For more information, see topic 1.8 Customizing Tables.
7.5 Monitoring Queues

You can view the Queue Summary in Explorer.

Controlling the load on your system is critical. In Applications Manager, you control the workload by setting the number of concurrent tasks that can pass through the queues.

Viewing the Queue Summary

You can view queue status based on icons in the Explorer tree and descriptions in the Queue Summary. To view a Queue Summary, select the Queues icon from the object tree. Applications Manager displays a list of queues in the upper right pane (see Figure A).
Column Descriptions for the Queue Summary

The queue summary displays the status of each queue. The columns are described below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays whether the queue is active or inactive. Active queues apply the thread settings. When you inactivate a queue, no tasks will be processed through it. The tasks will remain in the Backlog with a QUEUE WAIT status until the queue is activated. <strong>Note:</strong> The object tree icons for inactive queues will be covered by a yellow triangle.</td>
</tr>
<tr>
<td>Pri</td>
<td>The priority assigned to the queue. Priority defines the order in which the queue is scanned for task initiation. Tasks in a higher priority queue will be processed before tasks in a lower priority queue. The lower the number you assign to a queue, the higher priority it will have to run tasks. If all threads in a high priority queue are being used, Applications Manager will process tasks in lower priority queues until the maximum number of threads is reached. You can control the load on your system and the availability of computing resources by giving careful thought to how you prioritize queues and set their thread limits. For information on queue priorities, see topic 7.7 Administering Queues.</td>
</tr>
<tr>
<td>Threads</td>
<td>Number of threads assigned to the thread schedule displayed in the Schedule column.</td>
</tr>
<tr>
<td>Bklg</td>
<td>The number of tasks in the Backlog waiting to run on the queue.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The thread schedule assigned to a queue. Thread schedules control the maximum number of concurrent tasks that can run through the queue at any given time. For information on defining queues and thread schedules, see topic 7.7 Administering Queues.</td>
</tr>
</tbody>
</table>

You can customize many tables in Applications Manager, including the Agent Summary. When customizing tables, you determine:

- Which columns are listed.
- What each column is named.
- How each column is displayed.

Your Applications Manager administrator can set default values for tables. Therefore, the columns in the Queue Summary may be different from what is described above. For more information, see topic 1.8 Customizing Tables.
7.6 Changing Queue Settings

You can control the flow of tasks submitted to your system by assigning different thread schedules and priorities to your queues. You can also inactivate one or more queues.

You can control the number of tasks that flow through a queue in several ways:

- Select a thread schedule for the queue based on the **Min Thread** and **Max Thread** values.

  Minimum threads ensure that you always have a specified number of 'standby' threads available for priority 'rush' tasks. Maximum threads control the maximum number of tasks that can run concurrently in the queue. For more information on thread schedules, see topic 7.7.2 Defining Thread Schedules.

- Set a priority for each queue.

Changing Queue Settings

To change a queue's settings, select the queue, right-click, and select **Change** from the pop-up menu (see Figure A). Edit the fields using the information provided in Table A. You can also activate or inactivate one or more queues from the Queue Summary by highlighting the queues, right-clicking, and selecting the appropriate option. When you change queue settings from the Queue Summary, the queue definition is altered in the database.

**Note:** Applications Manager user groups allow you to edit queues. If you cannot edit them, see your Applications Manager administrator.
Creating Queues

Queues are created using the Queues window. For detailed information, see topic 7.7.1 Defining Queues.

### Table A. Change Queue fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This non-editable field displays the name of the queue.</td>
</tr>
<tr>
<td>Thread Schedule</td>
<td>The thread schedule controls the maximum number of concurrent tasks that can run through the queue and the number of threads that are reserved for the queue at any given time. For more information, see topic 7.7.2 Defining Thread Schedules.</td>
</tr>
<tr>
<td>Priority</td>
<td>Defines the order in which each queue is scanned for task execution if the maximum number of threads for an agent is reached. Queues are scanned starting with the number 1 and ending with 99. Execution order of tasks within a queue is determined by the priorities assigned to their job definitions. For more information on setting job priorities, see topic 2.6 Entering Execution Options for Jobs in the Development Guide.</td>
</tr>
<tr>
<td>Active</td>
<td>Click this check box to activate the queue. Active queues apply the thread settings. When you inactivate a queue, no tasks will be processed through it. The tasks will remain in the Backlog with a QUEUE WAIT status until the queue is activated.</td>
</tr>
</tbody>
</table>
7.7 Administering Queues

You control the flow of tasks to servers by using Applications Manager queues. All tasks pass through an Applications Manager queue to get to a server. You control queue throughput by assigning each queue to a thread schedule. You can define an unlimited number and type of queues.

You control the flow of tasks to servers by using Applications Manager queues. All tasks pass through an Applications Manager queue to get to a server. You control queue throughput by assigning each queue to a thread schedule. You can define an unlimited number and type of queues.

Thread schedules control the number of concurrent tasks that can run through a queue. When you define a thread schedule, you specify the number of threads, the minimum threads, and the start and stop times for the schedule. A thread schedule can be divided into sub schedules, letting you change the number of threads for different times of the day.

For example, you might assign only one thread from midnight to 6:00 A.M., four threads from 6:00 A.M. to 5:00 P.M., and two threads from 5:00 P.M. to midnight. This gives you the ability to fine-tune workloads on your system. The Queue Summary displays the current schedule in the Threads column (see Figure A).

![Figure A. The Queue Summary on the Explorer window](image)

- **Figure A. The Queue Summary on the Explorer window**

Figure B shows several different queues. Queue 1 has zero threads from midnight to 8:00 A.M., three threads from 8:00 A.M. to 4:00 P.M., and one thread from 4:00 P.M. to 23:59:59. Queue 2 has one thread from midnight to 8:00 A.M., and three threads for the rest of the day.

![Figure B. You can balance the workload with queues.](image)
When Threads Are Set to Zero

If the thread setting for a queue is zero, any tasks scheduled to run through that queue will not be launched. The tasks will be displayed in the Backlog with a status of QUEUE WAIT.

Example: You can set threads to zero to prevent end-user submissions from overwhelming the system during the working day. To do this, set up a queue with a schedule that includes zero threads from 7 A.M. to 6 P.M., and 10 threads at all other times. End-users would be able to submit tasks into the queue during the normal business day, but the tasks would simply be held until 6 P.M. when the queue opens up. This way, all tasks submitted during one day could be run overnight and made available the following day.

Selecting Minimum Threads with Thread Schedules

You can assign a minimum thread value to a thread schedule. Any queue assigned to a thread schedule will be able to have at least that number of threads available in 'standby' mode.

For example, QUEUE_A (shown in the table below) is guaranteed to have two available threads regardless of any tasks requested or scheduled in other queues. If the total threads for the agent is set to 10, that would mean a maximum of 8 tasks could run at any time through all the other queues.

<table>
<thead>
<tr>
<th>Queue</th>
<th>Priority</th>
<th>Max threads</th>
<th>Min threads</th>
<th>Cumulative</th>
<th>Running</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUEUE_A</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>QUEUE_B</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>QUEUE_C</td>
<td>2</td>
<td>8</td>
<td>3</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>QUEUE_D</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>QUEUE_E</td>
<td>3</td>
<td>10</td>
<td>0</td>
<td>7</td>
<td>3</td>
</tr>
<tr>
<td>QUEUE_F</td>
<td>3</td>
<td>10</td>
<td>0</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

Queues are grouped and run by priority. For example, in the table above you have two queues in each of the three priority levels (1, 2, 3). If the Agent Thread limit is set to 10, and the minimum thread limit is set to 2 for Queue_A and 1 for Queue_B, that leaves only seven threads available to queues with other priorities. Based on the queues used in the example table above, if Queue_F were the only queue running tasks, only three tasks would be allowed to run because seven min threads with a higher priority level are already reserved.

Subtopics

The following topics explain how to define queues and thread schedules:

7.7.1 Defining Queues

7.7.2 Defining Thread Schedules
7.7 Administering Queues

7.7.1 Defining Queues

To define a queue, you must name the queue, assign it to a thread schedule, set its priority, and make the queue active or inactive.

You control the flow of tasks to servers by using Applications Manager queues. All tasks pass through an Applications Manager queue to get to a server. You control queue throughput by assigning each queue to a thread schedule.

Note: Applications Manager user groups control access to queues. If you do not have access to them, see your Applications Manager administrator.

Procedure

To add a queue:

1. From the Queues Selector window, click New.
   
   Applications Manager opens the Queues window shown in Figure A.
   
   For information on using selector windows, see topic 1.5 Adding, Editing, and Deleting Applications Manager Objects in the Development Guide.
   
2. Complete the fields using the information in Table A.
Table A. The Queues window fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name may be up to 30 characters long.</td>
</tr>
<tr>
<td>Thread Schedule</td>
<td>The thread schedule controls the maximum number of concurrent tasks that can run through the queue and the number of threads that are reserved for the queue at any given time. For more information, see topic 7.7.2 Defining Thread Schedules.</td>
</tr>
<tr>
<td>Priority</td>
<td>Defines the order in which each queue is scanned for task execution if the maximum number of threads for an agent is reached. Queues are scanned starting with the number 1 and ending with 99. The execution order of tasks waiting to run in a QUEUED status is decided in the following order: 1. Queue priority 2. Job priority 3. Start date and time Therefore, if two tasks are waiting to run in different queues, and those queues have the same priority, the jobs' priority is checked. If queue and job priorities are the same, their start date and times are compared. For more information on setting job priorities, see topic 2.6 Entering Execution Options for Jobs in the Development Guide.</td>
</tr>
<tr>
<td>Active</td>
<td>Click the <strong>Active</strong> check box to activate the queue. Active queues apply the thread settings. When you inactivate a queue, no tasks will be processed through it. The tasks will remain in the Backlog with a QUEUE WAIT status until the queue is activated.</td>
</tr>
</tbody>
</table>

**Editing Queues in Explorer**

Applications Manager operators with the necessary user group access can alter queue definitions from Explorer. For more information, see topic 7.6 Changing Queue Settings.
7.7 Administering Queues

7.7.2 Defining Thread Schedules

A thread schedule defines the number of concurrent tasks that can run through a queue during a specified period of time. You can set different minimum reserved and maximum thread limits for different periods of time during the day.

A thread schedule is assigned to each Applications Manager queue. Thread schedules determine the number of:

- Minimum reserved threads for a queue.
- Maximum threads that can run concurrently through a queue.

You can divide a thread schedule to cover different time periods during a day. For example, during normal work hours you may want to limit a queue to two concurrent tasks, then in the evening reset the queue to 10 concurrent tasks. Each thread schedule must cover the full 24 hours in a day.

![Figure A. To add an entry to thread schedule, click New.](image)

**Note:** Applications Manager user groups control access to thread schedules. If you do not have access to them, see your Applications Manager administrator.

**Procedure**

To define a thread schedule:

1. From the **Thread Schedules Selector** window, click **New**.
   
   Applications Manager opens the **Thread Schedules** window shown in Figure A.
   
   For information on using selector windows, see topic 1.5 Adding, Editing, and Deleting Applications Manager Objects in the Development Guide.
2. Enter a name and description for the thread schedule on the **General** tab of the **Thread Schedules** window shown in Figure A.

   Note that there is one entry in the table on the **General** tab.

3. If you wish to specify times to set specific minimum and maximum threads, click **New**. Applications Manager opens the **Thread schedule details** window where you can specify the details for each entry in your schedule.

4. Complete the fields on the **Thread schedule details** window using the information in Table A and click **OK**. Applications Manager adds a new entry to the table with the values you specified. You can add as many entries to the table as needed to set different minimum and maximum values for different times of the day.

### Table A. **Thread Schedules window fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>The start time for this entry (hh:mm).</td>
</tr>
<tr>
<td>Stop Time</td>
<td>The stop time for this entry (hh:mm).</td>
</tr>
<tr>
<td>Min Thread</td>
<td>The number of the automation engine's threads you wish to reserve for a queue. The values can range between 0 and the maximum number of threads available on the automation engine. If one or more minimum threads are assigned to a queue's thread schedule, then even higher priority queues (queues with a lower number set in their <strong>Priority</strong> field) will have this many fewer threads available to them. This is even true when no tasks are running in the queue that is reserving the threads.</td>
</tr>
<tr>
<td>Max Thread</td>
<td>The maximum number of tasks that can run concurrently in the queue. The value can be between 0 and 9999. If you set the value to 0, the queue will not accept any tasks during the time period specified. Tasks assigned to this queue will show a QUEUE WAIT status. Only tasks in a RUNNING status count toward the Max thread setting.</td>
</tr>
</tbody>
</table>

#### Updating and Deleting Thread Schedule Entries

To update or delete a thread schedule entry, select the entry in the table and select **Edit** or **Delete**.

#### Selecting Thread Schedules for Agents

You can select a thread schedule for an agent to specify the maximum number of concurrent tasks that can run on that agent at one time in all queues. For more information, see topic 4.2 **Defining Remote Agents** in the Administration Guide.
7.8 Removing External Predecessors by Queue

To remove a job or process flow header’s external predecessors in the Backlog, assign it to the REMOVE_EXT_preds_ON_INSERT queue. You can create the REMOVE_EXT_preds_ON_INSERT queue by hand or by importing it.

If you want to remove a job or process flow header’s external predecessors on insert to the Backlog, you can assign it to the REMOVE_EXT_preds_ON_INSERT queue. The predecessors will not be shown in the task details or evaluated. If components in a process flow that is assigned to the REMOVE_EXT_preds_ON_INSERT queue have internal or external predecessors, they are evaluated normally.

It does not matter how the REMOVE_EXT_preds_ON_INSERT queue gets assigned to the job or process flow. It can be:

• The default queue of the job or process flow definition.
• Assigned in a schedule.
• Selected for an ad hoc request on the Submit window.

If a task is inserted into the Backlog in the REMOVE_EXT_preds_ON_INSERT queue, and you reassign it to another queue, the external predecessors are still removed. You cannot change a task’s queue from any other queue to the REMOVE_EXT_preds_ON_INSERT queue.

Creating the REMOVE_EXT_preds_ON_INSERT Queue

The REMOVE_EXT_preds_ON_INSERT does not ship with Applications Manager. If you wish to use it you can create it by hand or run an Applications Manager import and select REMOVE_EXT_preds_ON_INSERT. The REMOVE_EXT_preds_ON_INSERT.exp file ships in the import directory.
8

Viewing Forecasts and Monitoring System Performance

8.1 Introduction to Viewing Forecasts and Monitoring System Performance ................. 170
8.2 Viewing Forecasts .................................................................................................. 172
8.3 Viewing Graphical Forecasts ................................................................................ 174
8.4 Setting the FORECAST Job Parameters ............................................................... 176
8.5 Generating Production Schedules ....................................................................... 178
8.6 Monitoring System Performance with the Dashboard ............................................ 180
8.7 Editing Dashboard Properties ............................................................................. 182
8.1 Introduction to Viewing Forecasts and Monitoring System Performance

With the Forecast, Graphical Forecast, and Production Schedule features, you can view process flows and their components in the Backlog and History and view a list of scheduled jobs and process flows. Using the Dashboard, you can monitor system performance.

Viewing Forecasts and Graphical Forecasts

Using the Forecast feature, you can view a list of scheduled jobs and process flows. An example forecast is shown in Figure A.

If you have the Graphical Analysis Package, you can view a graphical forecast of scheduled jobs and process flows. Graphical forecasts are displayed in the **Forecasted Gantt view** window shown in Figure B. For more information on graphical forecasts, see topic 8.3 Viewing Graphical Forecasts.

The data displayed in forecasts is generated and loaded into Applications Manager by running the FORECAST job. When you create a schedule for the FORECAST job, you determine the time frame of the forecast and how often it is run. For more information on running the FORECAST job, see topic 8.4 Setting the FORECAST Job Parameters.

---

**Figure A. The Forecast window**

**Figure B. The Forecasted Gantt view window**
Running a Production Schedule

You can get a more detailed look at tasks that are scheduled to run by generating a production schedule. An example production schedule is shown below.

```
Skip {Process Flow}Report Name
---- -------------------------------
Saturday  Feb 23 2002 00:00
{SYSTEM}Saturday Feb 23 2002 00:00
{SYSTEM}DELEDEFAULT
NDOW {SYSTEM}HISTORY_PURGE

Monday  Feb 25 2002 00:00
{SALES_REPORTS}Monday FEB 25 2002 00:30
{SALES_REPORTS}REGION_A
   B If CURRENT TIME > 06:00:00 then SKIP TASK
{SALES_REPORTS}REGION_B
   B If CHECK FILE NO /reports/region_b.dat
{SALES_REPORTS}REGION_C
```

Monitoring System Performance with the Dashboard

If you have the Graphical Analysis Package, you can monitor system performance with the Dashboard shown on the bottom of the Applications Manager desktop in Figure C. For more information on the Dashboard, see topic 8.6 Monitoring System Performance with the Dashboard.

![Figure C](image.png)

*Figure C. Monitor system performance using the Dashboard.*
8.2 Viewing Forecasts

To view a list of scheduled jobs and process flows, go to the Activities menu and select Forecast.

The Forecast window shows you a list of scheduled jobs and process flows.

![Figure A. The Forecast window](image)

**Procedure**

To open the Forecast window shown in Figure A, do one of the following:

- Open the Activities menu and select Forecast.
- Select the Forecast icon from the toolbar.

Applications Manager displays a list of forecasted jobs and process flows (see Figure A). Each scheduled job/process flow includes the start date and time and the job or process flow’s name. Process flows also include a key icon used to expand or collapse them.

To view the jobs within a process flow, click the process flow’s key. To expand all keys for a process flow and its children, select the process flow, go to the View menu and select **Expand Process Flows**. To expand the keys in all process flows, choose **Expand All**. To print or preview a forecast, use the print buttons.

**Viewing Predecessors in a Forecast**

Process flow components are listed based on the execution order of each tasks’ predecessors. If you want to view their process flow’s structure, right-click a component and select **Graphical Predecessors** from the pop-up window. Applications Manager displays a flow diagram for the predecessors as shown in Figure B.
You can also select Predecessor Statement to only view the predecessor statement(s) for a job, process flow, or process flow component as shown in Figure C. For more information on predecessor links, see chapter 5: Working with Predecessors in the Development Guide.

Running the FORECAST Job

Data displayed in forecasts is generated and loaded into Applications Manager by running the FORECAST job. When you create a schedule for the FORECAST job, you determine the time frame of the forecast and how often it is run. For more information on running the FORECAST job, see topic 8.4 Setting the FORECAST Job Parameters.
8.3 Viewing Graphical Forecasts

To view scheduled jobs and process flows in a Gantt view, go to the Activities menu and select Graphical Forecast. The Graphical Forecast is part of the Graphical Analysis Package, an add-on product that can be purchased for Applications Manager.

The **Forecasted Gantt view** window shows you a list of scheduled jobs and process flows in a Gantt chart format. The Graphical Forecast is part of the Graphical Analysis Package, an add-on product that can be purchased for Applications Manager.

![Figure A. The Forecasted Gantt view window](image)

**Procedure**

To open the **Forecasted Gantt view** window shown in Figure A:

1. Do one of the following:
   - Open the **Activities** menu and select **Graphical Forecast**.
   - Select the Graphical Forecast icon from the toolbar.

   Applications Manager displays the **Forecast filter** window shown in Figure B.

2. If you wish to filter the tasks displayed in the **Forecasted Gantt view** window, edit the options described in the table below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Limits the display of data from the FORECAST job to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Tasks scheduled after this start date.</td>
</tr>
<tr>
<td>End date</td>
<td>Tasks scheduled before this start date.</td>
</tr>
<tr>
<td>Sub levels</td>
<td>Process flow components within a maximum nested depth.</td>
</tr>
<tr>
<td>Include minute</td>
<td>Not include tasks that are scheduled by minutes or hours (when unchecked).</td>
</tr>
<tr>
<td>Include hour</td>
<td></td>
</tr>
</tbody>
</table>

Data displayed in the **Forecasted Gantt view** window is generated and loaded into Applications Manager by running the FORECAST job. When you create a schedule for
the FORECAST job, you determine the time frame of the forecast and how often it is run. For more information on running the FORECAST job, see topic 8.4 Setting the FORECAST Job Parameters.

By entering information into the fields on the Forecast filter window, you are filtering beginning with the next scheduled task and ending with the last scheduled task loaded by running the FORECAST job. You cannot enter a date/time beyond the setting from the last run of the FORECAST job.

The Forecasts Gantt view window will not include any tasks that are currently in the Backlog, even if the tasks are staged. For more information on staging tasks, see chapter 6: Staging Tasks in the Backlog.

3. Click OK.

Applications Manager displays a small animated window as the tasks are loaded for the Forecasts Gantt View window.

Applications Manager displays the graphical forecast in the Forecasts Gantt view window. For information on reading Gantt windows, see topic 9.2 Reading the Gantt View Window.

4. If you wish, you can right-click a task and select Graphical Predecessors to view its predecessor links in a flow diagram.

Gantt Legend

The legend describes the graphics used in the Gantt view windows. To display the legend, click the Legend button in the menu bar. The Legend includes some symbols not used on the Forecasts Gantt view window. To close the Gantt Legend window, click the X in the title bar.
8.4 Setting the FORECAST Job Parameters

The data displayed in a forecast is generated and loaded into Applications Manager by running the FORECAST job.

The data displayed in a forecast (see Figure A) is generated and loaded into Applications Manager by running the FORECAST job. When you create a schedule for the FORECAST job, you determine the time frame of the forecast and how often it is run.

Depending on your organization’s needs, you can schedule this job to run every day, or several times each day.

Additionally, if you want to set the forecast on an ad hoc basis, you can submit the job as shown in Figure B.

The FORECAST job includes the following prompts.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
</table>
| Start Date Time               | The start date and time for the forecast. The default value for the prompt is a series of numbers created using the #aw_now substitution variable. They represent the current date and time. In Figure B, the default value is 20090211105811. This translates to:  
  • Year: 2009  
  • Month: February (02)  
  • Day of month: 11th  
  • Time: 10:58:11 A.M. |
| End Date Time (default is 1 day past start date) | The end date and time for the forecast. If no value is entered for this prompt, the default value is 24 hours past the start date. You can enter a different date using the same format as the Start Date Time prompt. (Hint: cut and paste the number from the Start Date Time field and modify.) |
| Max Depth                     | The levels of sub process flows you wish to show in the forecast.           |
| Minimum Schedule Units        | Select whether you want to limit the forecast to list tasks by day, hour, or minute. |
Figure B. You submit the FORECAST job to generate the forecast data.
8.5 Generating Production Schedules

To generate a production schedule report, run the PRODSCH process flow and view its output.

If you want to see a report of all jobs and process flows that are scheduled to run between specified dates, you can run the PRODSCH process flow. The process flow runs two jobs: SCHCREATE and SCHPRINT. The output for the SCHPRINT job reports the tasks by date and time. It includes the following information:

- The date and time each job and process flow is scheduled to run
- The name of each component in each process flow
- The conditions associated with each component

The report can show only the tasks that will run, or all tasks that will run and all tasks that are eligible to run but will not run due to conditions defined for the job or process flow. The sample production schedule report shown in this topic displays two process flows: SYSTEM and SALES_REPORTS. The Skip column in the analyst’s report displays an abbreviation indicating why the job will not be run. Notice that NDOW displays for HISTORY_PURGE. Process flow names are in {braces}. Job names follow the process flow names. The SALES_REPORTS process flow runs three jobs: REGION_A, REGION_B, and REGION_C. The first two jobs each have a BEFORE condition.

Generating a Production Schedule

To generate a production schedule report:

1. Request and submit the PRODSCH process flow and enter the start and end dates.
2. Choose Yes or No for the analyst’s status values. Choose Y to show all tasks including those that will not run due to the days of the week settings and conditions. This is useful for analysts that are reviewing schedules to make sure they will do what was intended. Choose N to display only those tasks that will run. This report is most useful for operators who are monitoring the system.
3. Enter the minimum schedule number.

<table>
<thead>
<tr>
<th>To display</th>
<th>Use this value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks scheduled to run daily</td>
<td>-3</td>
</tr>
<tr>
<td>Tasks scheduled to run hourly</td>
<td>-4</td>
</tr>
<tr>
<td>Tasks scheduled to run on minute intervals</td>
<td>-5</td>
</tr>
</tbody>
</table>

Note: If selecting an interval other than -3, you should review your start and end dates because the shorter interval settings will produce larger reports.

4. Submit the job and view the output for the SCHPRINT job.

Sample Production Schedule

<table>
<thead>
<tr>
<th>Skip (Process Flow)Report Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sat 02/23/09 00:00</td>
</tr>
</tbody>
</table>
Production Schedule Output Abbreviations

The five abbreviations used in the Skip column of the production schedule are described below.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NACT</td>
<td>Not active</td>
</tr>
<tr>
<td>NDOW</td>
<td>Not run, day of week</td>
</tr>
<tr>
<td>SONNHD</td>
<td>Skip, not in calendar (being run using a calendar and it is not in the calendar)</td>
</tr>
<tr>
<td>RONHD</td>
<td>Run, in calendar (being run using a calendar and it is in the calendar)</td>
</tr>
<tr>
<td>SONHD</td>
<td>Skip, in calendar (skip using a skip calendar)</td>
</tr>
</tbody>
</table>
8.6 Monitoring System Performance with the Dashboard

The Dashboard provides information about system performance.

If you want to monitor system performance, activate the Dashboard shown in Figure A. The Dashboard is included in the add-on Graphical Analysis Package product.

Displaying the Dashboard

To display the Dashboard on the bottom of the Applications Manager desktop, do one of the following:

- Open the Activities menu and select Dashboard.
- Select the Dashboard icon from the toolbar.

When the Dashboard is displayed at on the bottom of the Applications Manager desktop, some windows such as the Process Flows window may not fit on the viewable screen without scrolling.
**Viewing Dashboard Windows**

To enlarge a dashboard window, double-click the item in the Dashboard.

The information displayed in the Dashboard is described in the table below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlog Distribution</td>
<td>Percentage of tasks in the Backlog by status. Each task status is color-coded. ToolTips provide status names, number of tasks per status and total tasks when you rest the mouse pointer over a segment of the pie chart.</td>
</tr>
<tr>
<td>Workload Balancing</td>
<td>Percentage of running tasks by agent. ToolTips provide agent names, number of tasks per agent and total tasks when you rest the mouse pointer over an agent.</td>
</tr>
<tr>
<td>Progress of Day</td>
<td>Number of finished tasks for the day and the number tasks currently in the Backlog.</td>
</tr>
<tr>
<td>Agent Loading</td>
<td>Total task count and thread capacity used for each agent. Agents are color-coded to show yellow for caution and red for alert based on their capacity. ToolTips provide the number of tasks on each agent when you rest the mouse pointer over an agent.</td>
</tr>
<tr>
<td>Queue Loading</td>
<td>Total task count and thread capacity used for each queue. Agents are color-coded to show yellow for caution and red for alert based on their capacity. ToolTips provide the number of tasks running on each queue when you rest the mouse pointer over a queue.</td>
</tr>
<tr>
<td>Daily Activity</td>
<td>Graph of the number of tasks running and waiting throughout the day. <strong>Black:</strong> Resource-dependent tasks waiting with PRED WAIT, STAGED, and DATE PENDING statuses. Also includes all tasks listed below. <strong>Blue:</strong> Resource-dependent tasks waiting with AGENT WAIT, QUEUE WAIT, or CONDITN WAIT statuses. Also includes running tasks. <strong>Green:</strong> Running tasks. You can right-click in this box and select Properties to set an option to zoom in or out of this window’s display.</td>
</tr>
</tbody>
</table>

**Displaying Dashboard Windows on Top of Other Windows**

You can keep your dashboard windows above other Applications Manager windows on the desktop by right-clicking the window and selecting **Always on Top**.

**Editing Dashboard Properties**

You can edit the dashboard properties by selecting **Dashboard Properties** from the Options menu. For more information see topic 8.7 Editing Dashboard Properties.
8.7 Editing Dashboard Properties

Dashboard properties allow you to customize the display of the Dashboard. To edit the dashboard properties, right-click the Dashboard or one of the Dashboard windows.

You can use Dashboard properties to customize the display of the Dashboard.

![Dashboard Properties Window](image)

**Figure A. The five tabs of the Dashboard Properties window**

**Procedure**

To edit the dashboard properties:

1. Right-click the Dashboard or one of the Dashboard windows.
   - Applications Manager displays the Dashboard Properties window with the appropriate tab selected.
2. Select settings on the tab using the information included in this topic.
3. If you wish, you can edit the information on the other tabs in the Dashboard Properties window at this time.
4. Click **Apply** to save the changes, or **OK** to save the changes and close the Dashboard Properties window.
Selecting Task Statuses for Backlog Distribution
Uncheck the task statuses groups on the Backlog Distribution tab that you wish to exclude from the Task Statuses window.

Setting Agent Colors for Workload Balancing
Double-click an agent name on the Workload Balancing tab to assign it a particular color in the Workload Balancing window.

Setting Agent Loading Levels
Uncheck the Only Show Agents with Backlog box on the Agent Loading tab to show agents with no running tasks in the Backlog in the Agent Loading window. Also, select what percent of your agents' thread capacity you want to use to trigger a change in the color of their bars in the Agent Loading window. When the percent of in-use threads is greater than or equal to the setting in the Caution Level field, Applications Manager displays the agent's bar in yellow. When the percent of in-use threads is greater than or equal to the setting in the Alert Level field, Applications Manager displays the agent's bar in red.

Setting Agent Loading Levels
Uncheck the Only Show Queues with Backlog box on the Queue Loading tab to show agents with no running tasks in the Backlog in the Queue Loading window. Also, select what percent of your queues' thread capacity you want to use to trigger a change in the color of their bars in the Queue Loading window. When the percent of in-use threads is greater than or equal to the setting in the Caution Level field, Applications Manager displays the queue's bar in yellow. When the percent of in-use threads is greater than or equal to the setting in the Alert Level field, Applications Manager displays the queue's bar in red.

Setting Daily Activity Options
Select the time frame on the Daily Activity tab for the Daily Activity window. Also, uncheck the task status groups you wish to exclude from the Daily Activity window. Unchecking status groups from the Backlog Graph list will remove those groups from the Backlog graph list. Unchecking status groups from the Eligible Graph list will remove the resource-dependent and/or ready-to-run listings from their graphs.
9

Monitoring and Managing Tasks with the Gantt View

9.1 Introduction to Monitoring and Managing Tasks with the Gantt View ....................... 186
9.2 Reading the Gantt View Window ................................................................................. 188
9.3 Interpreting Adjusted Start and End Times .............................................................. 190
9.4 Finding Tasks in the Gantt View Window ................................................................. 192
9.5 Setting the Gantt View Preferences .......................................................................... 194
9.6 Printing from the Gantt View .................................................................................... 196
9.1 Introduction to Monitoring and Managing Tasks with the Gantt View

The Gantt view displays the contents of the Backlog in a Gantt chart format. All actions that can be taken against tasks in the Backlog can be taken against tasks in the Gantt view.

The Gantt view is part of the Graphical Analysis Package add-on product for Applications Manager. It displays the contents of the Backlog in a Gantt chart format. It is real-time and updated based on the **Explorer Refresh Seconds** setting. All actions that can be taken against tasks in the Backlog can be taken against tasks in the Gantt view.

The **Backlog Gantt view** window displays an expandable task tree on the left, and the Gantt chart on the right. You can change the size of the two panes by dragging the vertical splitter bar that divides the panes.

Each task (job or process flow) is displayed on its own row. Rectangles represent the expected run times of the tasks: black for process flows and blue for jobs. Arrows drawn between the rectangles indicate predecessor links.

### Displaying the Gantt View

To open the **Backlog Gantt view** window shown in Figure A, do one of the following:

- Open the **Activities** menu and select **Backlog Gantt view**.
- Select the Backlog Gantt view icon from the toolbar.

Applications Manager displays a small animated window as the tasks are loaded for the **Backlog Gantt view** window.

### Finding Tasks in the Gantt View

You can find a task in the **Backlog Gantt view** window by going to the **Actions** menu and selecting **Find**. Regular expression searches help you find jobs and process flows by name. For more information, see topic 9.4 **Finding Tasks in the Gantt View Window**.
Gantt Legend
The legend describes the graphics used in the Gantt view. To display the legend, go to the Actions menu and click the Legend.

Taking Actions on Tasks and Viewing/Editing Task Details
You can right-click tasks in the Backlog Gantt view window to take actions on them or to view or edit their task details the same way you would in the Explorer window. For more information on taking actions on tasks, see topic 4.9 Taking Actions on Tasks in the Backlog. For more information on viewing and editing task details, see topic 4.10 Viewing and Editing Task Details.

Displaying Gantt Task Summaries
When you are working in the Backlog Gantt view window, a pop-up menu is displayed when you hover over a task as shown in Figure C. You can customize the information displayed in this menu by selecting Tables from the Options menu and picking the Gantt task summary option. For more information, see topic 1.8 Customizing Tables.

Figure B. Hovering the mouse pointer over an object in the tree displays information about the object in a pop-up window.
9.2 Reading the Gantt View Window

The Gantt view window displays tasks in chronological order with time displayed horizontally.

The Gantt view provides a good deal of information about the tasks running in the Backlog.

Process Flows

Process flows are represented by a rectangle with a black border. The rectangle extends from the scheduled start time to the scheduled completion time based on the average run time for the process flow. The average run time is based on the sum of the average run times of all tasks in the process flow.

When a process flow is initiated, a green bar is displayed in the rectangle. The green bar indicates the current run time for the process flow. The green bar is displayed until the process flow completes or is killed. When a process flow completes, the run time bar turns black.

If a task in a process flow aborts, a red X is placed over the process flow name in the task tree. Note a process flow never aborts, only the components in a process flow.

From an operations standpoint, you can display only the unexpanded process flows in the Gantt chart and easily monitor the system. If a problem arises with a process flow, or you want to see more details about individual components in a process flow, you can expand the process flow.
Jobs

Jobs are represented by a rectangle with a blue border. The rectangle extends from the scheduled start time to the completion time based on the average run time for the job.

Actual run times for process flows and jobs are represented by solid bars running through the center of the rectangles. The color of the bar indicates the status of the task.

<table>
<thead>
<tr>
<th>Bar Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No color bar</td>
<td>Task is waiting to run.</td>
</tr>
<tr>
<td>Green</td>
<td>Task is running.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Task is on hold.</td>
</tr>
<tr>
<td>Red</td>
<td>Task has aborted.</td>
</tr>
<tr>
<td>Black</td>
<td>Task has completed successfully.</td>
</tr>
</tbody>
</table>

Adjusted Start and End Times

Adjusted start and end times for process flows and jobs are represented by the Start [ and End ] symbols. Before the time a task is scheduled to run, these symbols will align with the start and end times of a process flow or job. If a process flow or job starts earlier or later than scheduled, these symbols move to reflect the difference in times. For a complete discussion of the adjusted start and end times, see topic 9.3 Interpreting Adjusted Start and End Times.

Displaying Predecessor Links

You can display predecessor links for a task in the Gantt view by hovering the mouse pointer over the task’s bar in the Gantt chart as shown in Figure B.

![Figure B. To see the predecessor links for a task, hover the mouse pointer over the task’s bar in the Gantt chart.](image-url)
9.3 Interpreting Adjusted Start and End Times

Adjusted start and end times show you calculated start and end times based on the current information available to Applications Manager.

The Gantt view represents planned start and end times with rectangles: black for process flows, blue for jobs. If a process flow is running ahead or behind schedule, the adjusted start and end times are indicated by the symbols shown below:

- **Adjusted start time:** [ ]
- **Adjusted end time:** ]

These same symbols apply to jobs.

**Process Flow Examples**

To help you interpret the start and end time symbols as they relate to process flows, several examples are given below.

<table>
<thead>
<tr>
<th>When a process flow is:</th>
<th>The bar looks like this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting to run and is still on schedule</td>
<td>[ ]</td>
</tr>
<tr>
<td>Waiting to run and is expected to start ahead of schedule</td>
<td>] [</td>
</tr>
<tr>
<td>Waiting to run, but is behind schedule</td>
<td>] [</td>
</tr>
<tr>
<td>Running on schedule</td>
<td>] [</td>
</tr>
<tr>
<td>Running ahead of schedule</td>
<td>] [</td>
</tr>
<tr>
<td>Running behind schedule</td>
<td>] [</td>
</tr>
</tbody>
</table>
Job Examples

To help you interpret the start and end time symbols as they relate to jobs, several examples are given below.

<table>
<thead>
<tr>
<th>When a job is:</th>
<th>The bar looks like this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting to run and is still on schedule</td>
<td>🟦🟦🟦🟦🟦🟦</td>
</tr>
<tr>
<td>Waiting to run and is expected to start ahead of schedule</td>
<td>🟦🟦🟦🟦🟦🟦🟦</td>
</tr>
<tr>
<td>Waiting to run, but is behind schedule</td>
<td>🟦🟦🟦🟦🟦黄色</td>
</tr>
<tr>
<td>Running on schedule</td>
<td>🟦🟦🟦黄色</td>
</tr>
<tr>
<td>Running ahead of schedule</td>
<td>🟦🟦🟦黄色</td>
</tr>
<tr>
<td>Running behind schedule</td>
<td>🟦黄色</td>
</tr>
</tbody>
</table>
9.4 Finding Tasks in the Gantt View Window

You can find a task in the Backlog Gantt view window by going to the Actions menu and selecting Find. Regular expression searches help you find jobs and process flows by name.

The Find feature of the Backlog Gantt view window allows you to easily find any task in the Backlog.

Procedure

To find a task in the Backlog Gantt view window:

1. Go to the Actions menu and select Find.

   Applications Manager opens the Find component window shown in Figure A. The Find component window lists all jobs and process flows alphabetically. Process flow components including sub process flows are listed starting with their initial parent process flow.

   You can enter a valid UNIX regular expression in the Search field to have Applications Manager filter the list of tasks. In Figure A, "DAT" is entered in the Search field to limit the list of tasks to ones with the letters 'DAT' in their name. For information on syntax accepted by regular expressions, see Appendix A: Regular Expression Tables in the Development Guide.

2. Select a task from the Find component window.

   Applications Manager highlights the task in the Backlog Gantt view window.
9.5 Setting the Gantt View Preferences

Use the options under the Preferences menu to customize the Gantt chart.

You can customize the Gantt chart by selecting the options under the Preferences menu.

**Keep History**

When selected, this option will keep completed process flows in the Gantt view. Normally, completed process flows are not displayed in the view. The process flows will remain in the Gantt view until you close the Gantt view window.

**Show Horizontal Lines**

When selected, this option displays horizontal lines across the Gantt view.

![Figure A. Gantt view with horizontal lines displayed](image)

**Show All Predecessors**

When selected, predecessor links are shown at all times.

**Show Only Selected Predecessors**

When selected, you must select a task from the tree to show its predecessor links.

**Show Predecessors When Dragged Over**

When selected, you must drag the mouse over a task's bar in the Gantt view to display its predecessor links.
9.6 Printing from the Gantt View

You can print the Gantt chart, preview it before printing, and set page options.

Using the commands under the Print menu on the Gantt view window, you can set page options, preview the printed chart, and print the chart.

**Page Setup**

The Page Setup command will display a dialog similar to the one shown in Figure A. Use this dialog to set the paper size, orientation, and margins.

![Figure A. Page setup options](image)

**Print Preview**

The Print Preview command displays the dialog shown in Figure B. You can print directly from this dialog if you wish.

![Figure B. You can preview the printed Gantt chart.](image)
Print Gantt

The **Print Gantt** command displays the standard Windows print window shown in Figure C where you can set various output options.

![Print window](image)

*Figure C. Print window*
10.1 Introduction to Monitoring with AppMaster

AppMaster monitors two or more Applications Manager automation engines on different hosts. AppMaster is an add-on product for Applications Manager.

AppMaster is an add-on product for the Applications Manager product. From the AppMaster window, you monitor one or more views of any combination of the following as defined in your system:

- Automation engines
- Agents
- Tasks by application

An AppMaster window is shown in Figure A.

Figure A. You can view multiple automation engines from a single AppMaster client.

Note: To use AppMaster, you must have the same version of Applications Manager on all automation engines.

In the views, links to other views, automation engines, agents, and tasks by application are represented by icons. Automation engine, agent, and view icons change to indicate status. Clicking on an automation engine, agent, or application icon will launch the Applications
Manager client for the appropriate automation engine. From there you can perform all Applications Manager operations functions.

**Launching the AppMaster Client**

You launch the AppMaster client by going to the Applications Manager intro page and clicking the AppMaster link for use with Java Web Start or the Java Plug-in. For more information, see topic 1.12 Launching the Applications Manager Client.

**Creating AppMaster Views**

AppMaster views are created by using the AppMaster Administration window. The views can be geographical, logical, architectural, or any other design. The AppMaster views must be created in collector automation engine's client (under AppMaster Administration), and that view must have icons that have the correct properties. For more information, see chapter 12: Host and Client Customization in the Administration Guide.

**Prerequisites**

To use AppMaster, you must have the same version of Applications Manager on all automation engines and all processes must be running for all automation engines. Additionally, the Masters.properties file must be configured for each automation engine you wish to work with. For more information, see topic 12.6 Configuring Masters.properties for AppMaster in the Administration Guide.
10.2 Monitoring AppMaster Views

The AppMaster client includes two panes that display a selectable list of views on the left, and the selected view on the right.

The AppMaster client includes two panes that display:
- A selectable list of views on the left. The default sort order for the views is by status.
- The selected view on the right. A view is comprised of a background image with icons placed on top of the image.

To display a view, select its name from the list on the left. The panes can be expanded by dragging the splitter bar, or clicking the splitter bars arrows.

Figure A. AppMaster displays a list of views on the left, and the selected view on the right.

Note: Applications Manager user groups control access to AppMaster. If you do not have access to it, see your Applications Manager administrator.
Automation Engine, Agent, and View Icons

Views include icons that link to automation engines, agents, or other views. Icons can be small, medium or large based on how they were defined when the view was created.

Sorting Columns and Changing Column Order

You can display the items in the columns in a preferred order. Click the header of a desired column to view its jobs in descending order. Click a second time to view the jobs in ascending order. Notice that the arrow to the left of the column name reflects this change. You can also change a column’s width by dragging the column’s header.

To change the order of the columns, move the mouse cursor over the header of the column you want to move, hold down the left mouse button, and drop the column where you want it.
10.3 Viewing the Agent Summary or Properties for an Icon

You can view an agent summary for automation engine and agent icons by hovering the mouse cursor over them. You can view an icon’s properties by right-clicking the icon and selecting Properties.

Viewing an Agent Summary for an Icon

You can view an agent summary for automation engine and agent icons by hovering the mouse cursor over them as shown in Figure A.

![Figure A](image)

*Figure A. You can view an agent status tooltip for each automation engine or agent by hovering the mouse cursor over its icon.*

The agent summary columns are described below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Displays the name of the agent.</td>
</tr>
</tbody>
</table>
Viewing an Icon’s Properties

You can view an icon’s properties by right-clicking the icon and selecting Properties. AppMaster displays the **Icon Properties** window shown in Figure B.

![Figure B. The Icon Properties window](image)

Each of the fields is described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the icon</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the icon</td>
</tr>
<tr>
<td>Link</td>
<td>The view this icon links to (if applicable)</td>
</tr>
<tr>
<td>Automation Engine</td>
<td>The automation engine this icon links to (if applicable)</td>
</tr>
<tr>
<td>Agent</td>
<td>The agent this icon links to (if applicable)</td>
</tr>
<tr>
<td>Application</td>
<td>The Applications Manager application this icon links to (if applicable)</td>
</tr>
<tr>
<td>X and Y</td>
<td>Displays the coordinate points of the icon on the view</td>
</tr>
</tbody>
</table>
10.4 Monitoring Statuses with AppMaster

You can monitor task status using the status bar, icons in the Status column, and automation engine, agent and view icons on AppMaster views.

In AppMaster, you can monitor task statuses by viewing:
- The status bar
- Icons in the Status column
- Icons for automation engines, agents and views on an AppMaster view

Using the Status Bar

The status bar is displayed across the bottom of the AppMaster screen. Its color alerts you to the status of all agents and tasks running on any of the automation engines that AppMaster is monitoring.

The status bar colors and descriptions are described in the table below.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>All automation engines, agents and tasks are running satisfactorily.</td>
</tr>
<tr>
<td>Yellow</td>
<td>An automation engine or agent is idled, or a task is on hold. <strong>Note:</strong> If the requirements for both a yellow and red status bar are met, the status bar will be red.</td>
</tr>
<tr>
<td>Red</td>
<td>An automation engine or agent has stopped due to a BUSY or TROUBLE status, or a task has aborted or otherwise not completed with a status of FINISHED.</td>
</tr>
</tbody>
</table>

For descriptions of the agent and task status values, see Appendix A: Automation Engine/Agent Status Values and Appendix B: Task Status Values in the User Guide.

Viewing the Status Column

Just as the status bar displays the rolled-up status of all views, the icons in the status column display the rolled-up status of all automation engines, agents, and views that are children (or sub-children) of that view.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Icon]</td>
<td>All automation engines, agents and tasks in this view are running satisfactorily.</td>
</tr>
<tr>
<td>![Yellow Icon]</td>
<td>An automation Engine or agent is idled, or a task is on hold in this view. <strong>Note:</strong> If the requirements for both a yellow and red status are met, the icon will be red.</td>
</tr>
</tbody>
</table>
Linking and Drilling Down with Icons

AppMaster icons change to reflect their status. You can double-click any AppMaster icon to drill down to additional views or clients.

Logging into Operations Clients from AppMaster

To drill down to an Operations client:

1. From the AppMaster view, double-click an automation engine or agent icon. AppMaster displays the Login window shown in Figure A.

   ![Login window](image)

   \textit{Figure A. The Login window.}

2. Enter your name and password and click OK. Applications Manager opens the Applications Manager client for the automation engine or agent.

   If you log into the Applications Manager client again during the same AppMaster session, you will not be required to enter your name and password again.

Clearing Logins

If you log into an Applications Manager client and do not want AppMaster to remember your name and password, select Clear Login from the Options menu. AppMaster clears all stored logins.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>An automation engine or agent has stopped due to a BUSY or TROUBLE status, or a task has aborted or otherwise not completed with a status of FINISHED.</td>
</tr>
</tbody>
</table>
Appendices

Appendix A: Automation Engine/Agent Status Values .......................................................... 210
Appendix B: Task Status Values ...................................................................................... 213
## Appendix A: Automation Engine/Agent Status Values

The possible agent status values are listed, along with a description of the status and a suggested course of action.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
</table>
| BUSY       | **Description**: The automation engine died abnormally. The automation engine and/or agent(s) may go into BUSY status from time to time when there is high Applications Manager activity or the system is experiencing high loads. An agent might also go into a BUSY status if the file system is full.  
**Action**: If the automation engine/agent(s) stay in BUSY statuses for extended periods when the system load is low and the Applications Manager activity is low, the logs of each should probably be reviewed for any exceptions. Also, check to see if the RMI server process is running. If the RMI server is not running, look at the automation engine log file before restarting. |
| CHECK LOG  | **Description**: The automation engine or an agent has an error.  
**Action**: Check the automation engine or agent’s log file for detailed information.                                                      |
| CPU WAIT   | **Description**: The automation engine or agent does not have enough CPU capacity available to process additional tasks. The CPU capacity is set for the automation engine and each agent with the CPU Limit setting. For more information, see topic 4.2 Defining Remote Agents in the Administration Guide.  
**Action**: Task will be processed as soon as there is available CPU capacity. |
| Unavailable| **Description**: An agent encountered an error while running.  
**Action**: Look at the agent log files in log directory. Check the files for errors and verify that all parameters are set correctly for the agent. |
| IDLED      | **Description**: The agent is running but not processing.  
**Action**: To allow processing to continue, right-click the agent and select the Resume option.                                                   |
| INACTIVE   | **Description**: The agent is inactivated; all tasks will go to History with an INACTIVE task status.  
**Action**: To set tasks to run normally again, check the Active field in the automation engine or agent definition. For more information, see topic 4.2 Defining Remote Agents in the Administration Guide. |
| MGRSTOPPED | **Description**: The agent processes of a Java agent have been stopped by the AgentService process.  
**Action**: You can restart the Java agent from Explorer, or from the command line by issuing the startso <agent name> command. |
<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No_Service</td>
<td><strong>Description:</strong> The AgentService process is down and the agent has been stopped.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Restart the agent from the command line.</td>
</tr>
<tr>
<td>Running</td>
<td><strong>Description:</strong> The automation engine or agent is presently executing on the system.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> No action is required.</td>
</tr>
<tr>
<td>START_ERROR</td>
<td><strong>Description:</strong> The process necessary to run tasks could not be launched.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Check that there are adequate system processes and disk space where Applications Manager is installed. Also, check for adequate disk space in the /temp directory. Check ulimit to ensure that the Applications Manager user account does not have a process limit assigned to it (UNIX only).</td>
</tr>
<tr>
<td>START_FAILED</td>
<td><strong>Description:</strong> The agent did not get a response indicating that a task was launched successfully (no Process ID was returned).</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Possible error with pm file. Check that there are adequate system processes and disk space where Applications Manager is installed. Also, check for adequate disk space in the /temp directory (UNIX only).</td>
</tr>
<tr>
<td>STARTING</td>
<td><strong>Description:</strong> The automation engine or agent is starting on the system. This is an interim status that will change to RUNNING.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> No action is required.</td>
</tr>
<tr>
<td>Stopped</td>
<td><strong>Description:</strong> The automation engine or agent is stopped. This does not mean that RmiServer, AgentService or any other process is stopped, only that the thread for the automation engine or agent is stopped.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> You can restart the automation engine or agent from Explorer, or from the command line, by issuing startso &lt;agent name&gt; for an agent or startso &lt;automation engine&gt; for the automation engine.</td>
</tr>
<tr>
<td>Srvc_Down</td>
<td><strong>Description:</strong> The AgentService process went down while the agent was running.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Stop and restart the AgentService process with a startso agentservice command from the command line.</td>
</tr>
</tbody>
</table>
### Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
</table>
| TROUBLE  | **Description:** Set by the automation engine when it decides that the agent is not doing its task (for example, the automation engine sent it a task to start 5 minutes ago, but the agent never started it). The `so_back_process.so_last_activity` has not been updated for the amount set in the **Sleep time** field + 60 seconds.

In the case of a Zeke agent, it indicates the zabroker is down.

**Action:**
- Check the following:
  - Make sure the RMI server is running.
  - Automation engine: Locked row in database. May need to run `listpids.sql` to find any hung Oracle processes and stop them.
  - Agent: Verify that there is adequate disk space.
  - Look at the automation engine and agent log files in `log` directory. Check the files for errors and verify that all parameters are set correctly for the agent.
  - Look into system CPU and memory usage for other processes that might be impacting Applications Manager operation. |
| Unavailable | **Description:** An agent encountered an error when starting up. |
|             | **Action:** Look at the agent log files in `log` directory. Check the files for errors and verify that all parameters are set correctly for the agent. |
## Appendix B: Task Status Values

The possible task status values are listed, along with a description of the status and a suggested course of action. Statuses that are unique to a particular extension are described in that extension’s documentation. Be aware, too, that statuses may be renamed by some condition actions and run time scripts.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
</table>
| ABORTD     | **Description:** The task has terminated in an unsuccessful manner on the agent. This is an interim status that will change almost immediately to ABORTED.  
 **Action:** Wait for the status to change to ABORTED.                                      |
| ABORTED    | **Description:** Applications Manager has processed the task and it terminated unsuccessfully.  
 **Action:** To see why the task aborted, check the system output file and view/edit the task details in the Backlog. |
| AGENT WAIT | **Description:** The task is assigned to an agent that does not have enough threads or CPU available to process the task.  
 **Action:** The task will be processed as soon as there are available threads/CPU capacity. If this status occurs often, you may want to change the thread schedule assigned to the agent. |
| BAD BATCH  | **Description:** There is no defined application information for BATCH registered in Applications Manager.  
 **Action:** Define a BATCH application.                                                    |
| BAD CONDITN| **Description:** A SQL statement or check file BEFORE or AFTER condition has returned an error in the task.  
 **Action:** Edit the conditions and/or their SQL statements for the task in the Backlog and in the job/process flow definition. Make sure you have sufficient tablespace where applicable. |
| BAD CONNECT| **Description:** The host login and password combination that is specified for the task is in error.  
 **Action:** Check the login and password assigned to the job or process flow component.   |
| BAD DATE PRM| **Description:** The date format required by the argument type is incompatible with the prompt.  
 **Action:** Check the dates entered for a prompt if one exists, or check the dates passed to a prompt or condition by a substitution variable. |
| BAD LIBR   | **Description:** The library associated with this job includes a path that cannot be found.  
 **Action:** Edit the library’s path.                                                        |
| BAD LOGIN  | **Description:** The login specified for the task is invalid.  
 **Action:** There may be a database problem. Check with your DBA to make sure the correct Database ID is specified in the job definition. |
<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAD MJN</td>
<td><strong>Description:</strong> The task’s job sequence number is incorrect and does not match the currently registered job known to Applications Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Have your DBA check the Applications Manager database to see if there is a bad entry in the <code>so_job_table</code> table.</td>
</tr>
<tr>
<td>BAD MODULE</td>
<td><strong>Description:</strong> A bad job name was entered for a REQUEST JOB action in a condition.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Edit the condition that generated the entry in the Backlog.</td>
</tr>
<tr>
<td>BAD QUEUE</td>
<td><strong>Description:</strong> A condition with the CHANGE QUEUE action has been met. The designated alternate queue, however, does not exist in Applications Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Edit the condition that generated the entry in the Backlog.</td>
</tr>
<tr>
<td>BAD SQL STMT</td>
<td><strong>Description:</strong> A SQL statement associated with a dynamic substitution variable used by this task is incorrect.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Dynamic substitution variables can be used in prompts and conditions. Check what substitution variables are used in the prompts and conditions for this job or process flow.</td>
</tr>
<tr>
<td>BAD TYPE</td>
<td><strong>Description:</strong> The data type specified for the task is incorrect.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Check the data type definition assigned to the prompt.</td>
</tr>
<tr>
<td>BAD_AGENT</td>
<td><strong>Description:</strong> The agent assigned to the job does not exist. This status will only occur if the agent was defined through a direct entry into the Applications Manager database.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Select an agent for the job.</td>
</tr>
<tr>
<td>CANCELLED</td>
<td><strong>Description:</strong> A condition on this task, or on a previous component in the process flow, has canceled the remaining process flow components.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Check the conditions specified in the components of this process flow.</td>
</tr>
<tr>
<td>CONDITN WAIT</td>
<td><strong>Description:</strong> The task is waiting for a condition to be met before executing.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> No action is required. You can check the conditions for this task in the Backlog.</td>
</tr>
<tr>
<td>DATE PENDING</td>
<td><strong>Description:</strong> This task is not yet ready to run. Tasks are not ready to run if:</td>
</tr>
<tr>
<td></td>
<td>• They have been staged by running either the STAGING or STAGING_BY_SCHEDULE jobs and selecting prompts.</td>
</tr>
<tr>
<td></td>
<td>• Someone post-dated the start date/time for a job or process flow when requesting it.</td>
</tr>
<tr>
<td></td>
<td>• A condition with a DELAY TASK action prohibits the task from running.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> No action is required. The task will run when its reaches its start date and time, or when its conditions allow it to. You can edit the task details of the job or process flow in the Backlog.</td>
</tr>
<tr>
<td>Status</td>
<td>Description/Action</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| DB ERROR | **Description**: An internal database error has occurred while processing this task. Possible causes include:  
- Subvars in prompts or conditions that use SQL have returned an error when run from the command line, such as SQL with a bad database link.  
- The inability of the Applications Manager processes were unable to connect to the automation engine’s database (network problems).  
- A database or database server crashed.  
**Action**: Try resetting the task—if that works, then the error was resolved prior to the reset. Useful troubleshooting information can be found in the following locations:  
- The system output file (viewable from the Output Files tab of the Task Details window).  
- The comments (viewable from the Comments tab of the Task Details window).  
- The `AgentService` and `RmiServer` process logs in the `log` directory. |
| DEAD     | **Description**: The process associated with this task can no longer be found on the host system. This is an interim status that will change almost immediately to DIED.  
**Action**: Wait for the status to change to DIED. |
| DELETED  | **Description**: The task has been deleted from the Backlog.  
**Action**: Find out why the operator deleted the task and resubmit the task if necessary. |
| DIED     | **Description**: The process associated with this task can no longer be found on the host system. This happens if a process takes more than five minutes to begin execution after initiation. Usually there is a problem with the agent that prevents the task from executing.  
If the task's status is still RUNNING at the time that the process disappears from the host system, the task may have been killed from the operating system.  
**Action**: Check to see if the agent is running. Check to see if the task was killed from the operating system. |
| ERRORS   | **Description**: If you see this status in the Backlog, Applications Manager detected an error in a condition. You may also see listings for the RMI server or your agents in History with an ERRORS status. These are informational only. For more information, see the status of your automation engine and agents.  
**Action**: To see why the task with a bad condition went into this status, check the system output file and view/edit the task details in the Backlog. |
| FILE ERROR | **Description**: The `tmp` file could not be created.  
**Action**: Check that the disk is not full or for improper file and directory permissions. |
<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
</table>
| FINISHED       | **Description:** The task has successfully completed its operation.  
**Action:** No action required.                                                                                                                    |
| HOLD           | **Description:** The task has had its execution delayed indefinitely because:  
- The task has a condition with a HOLD TASK action.  
- The Hold Task box was checked for a job/process flow that was requested on an ad hoc basis.  
- The task in the Backlog has been put on hold.  
**Action:** The task will remain on hold until the status is changed by an action associated with another condition or by a user. |
| HOLD PRED WT   | **Description:** The task is on hold and is waiting for one or more predecessor requirements to be met.  
**Action:** The task will not be eligible to run until both of the following occur:  
- The hold status is changed by an action associated with another condition or by a user.  
- The predecessor requirements for the task are met.                                                                                           |
| HOST FAILURE   | **Description:** An error occurred when the host attempted to execute the command required to perform the task. This usually indicates a lack of process slots on the system or an inadequate sub process limit for the Applications Manager account.  
**Action:** Check with your Applications Manager administrator.                                                                                  |
| INACTIVE       | **Description:** This task was skipped because the Active option in its job or process flow definition is unchecked.  
**Action:** No action required. For information on inactivating jobs, see topic 2.6 Entering Execution Options for Jobs in the Development Guide. |
| INITIATED      | **Description:** One or more of the components in this process flow have been initiated and all the components in the process flow have not yet finished.  
**Action:** No action required.                                                                                                                   |
| KILL           | **Description:** A request to terminate the task while it was executing on the host was issued by a user or by an action associated with a condition. This is an interim status that changes almost immediately to KILLED.  
**Action:** See the explanation for the KILLED status.                                                                                             |
| KILL1          | **Description:** Used by the OAE extension when the automation engine is evaluating a task that is being killed. When the agent successfully kills the task, it sets the task’s status to KILL. The automation engine evaluates any post-processing conditions and sets its status to KILLED.  
**Action:** See the explanation for the KILLED status. If you wish, you can resubmit the task.                                                  |
<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>KILLED</td>
<td><strong>Description:</strong> Applications Manager has processed the task after a request for termination has been made for it. The task has therefore been removed from the host system. <strong>Action:</strong> If the task is still in the Backlog, you can reset it.</td>
</tr>
<tr>
<td>KILLING</td>
<td><strong>Description:</strong> Used by the OAE extension when the automation engine has sent the command to the agent. When the agent successfully kills the task, it sets the status to KILL. The automation engine evaluates any post-processing conditions and sets the status to KILLED. <strong>Action:</strong> See the explanation for the KILLED status. If you wish, you can resubmit the task.</td>
</tr>
</tbody>
</table>
| LAUNCH ERR | **Description:** The automation engine had an error launching the task. Possible causes include:  
- Oracle errors when launching the task  
- Machine disk space issues  
- Machine performance issues, or network issues (such as a hung port, network slowness, or firewall changes)  
With regard to network issues, LAUNCH ERR can mean that the task start command didn't reach the agent (automation engine--->|agent), or it can mean that the agent didn't respond back (automation engine|<--agent). **Action:** Before calling UC4 support, check the following for errors:  
- Task's comments (in the Backlog or History, right-click the task and go to Comments)  
- Unregistered task log files on the machine. (Check in the out directory on the machine where the task was supposed to run. It may have started running, but couldn't register the output.)  
- The RmiServer.<time stamp>.log file in the automation engine’s log directory. This file may include errors starting with AwE.  
- The latest AgentService log files for the local or remote agent. These may include errors starting with ERR. If you find errors, search for them in the Knowledge Base on the UC4 Support Web site or call Support. Before contacting Support, have the log files listed above ready to send. |
| LAUNCH ERROR | **Description:** The task has been launched, but its status has not yet been determined. **Action:** No action required. |
| MAX RESTARTS | **Description:** The task has been restarted 99 times. This is the maximum number of times a task can be restarted. **Action:** To run the task, delete and resubmit. |
| MGRSTOPPED | **Description:** This status is displayed only in History. It is associated with the agents. It indicates the date and time the AgentService process stopped. **Action:** No action required. This is only a historical record. |
### Status Description/Action

<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
</table>
| Min Run Time | **Description:** The task finished more quickly than the time specified in the *Min run time* field of the job's definition. Applications Manager developers specify a min run time when they expect a job to run for at least the time they specify.  
  **Action:** Investigate why the task finished so quickly. |
| NO PRIORITY  | **Description:** This task has been scheduled with a priority of zero. Since no priority has been assigned to the task, it cannot be executed until a priority is set.  
  **Action:** Change the priority for the task in the Backlog and/or edit the job/process flow definition. |
| PRED WAIT    | **Description:** The task is waiting for a predecessor requirement to be met before executing.  
  **Action:** No action required. Predecessors can be edited for the running of a task in the Backlog if the task is in a non-running status.  
  For a list of predecessor execution rules for tasks in a PRED WAIT status, see topic 5.3 Understanding Predecessor Execution Rules in the Development Guide. |
| PW-DELETE    | **Description:** The component in a process flow was waiting for a predecessor requirement to be met before executing and it has been deleted. The component remains in the Backlog as a placeholder for predecessor inheritance.  
  **Action:** No action required. |
| PW-SKIP      | **Description:** The task was waiting for a predecessor requirement to be met before executing and it has been skipped.  
  **Action:** No action required. |
| QUEUE WAIT   | **Description:** The job is assigned to a queue that does not have enough threads available to process the task.  
  **Action:** The task will be processed as soon as there is an available thread. If this task should be running, make sure that:  
  • The queue has not been inactivated.  
  • The thread schedule assigned to the queue has an adequate number of threads in its *Max run time* setting to allow the appropriate number of concurrently running tasks.  
  Queue definitions can be altered from the Explorer window or from the Queues window.  
  You can change the queue for the particular running of a task in the Backlog on the Task Details window. |
### Status Description/Action

#### QUEUED
**Description:** The task has been sent to an Applications Manager queue, but has not been processed by the automation engine to determine execution eligibility. The status should quickly be updated.

The execution order of tasks waiting to run in a QUEUED status is decided in the following order:

1. Queue priority
2. Job priority
3. Start date and time

Therefore, if two tasks are waiting to run in different queues, and those queues have the same priority, the jobs’ priorities are checked. If queue and job priorities are the same, their start dates and times are compared.

**Action:** No action required.

#### RECURSIVE
**Description:** The components within this process flow are recursive, calling one another in an infinite loop. This only happens in process flows that were created in a previous Applications Manager version.

**Action:** Edit the process flow to change its components’ predecessor requirements.

#### RESV THRDS
**Description:** The job’s queue has reserved threads but none are available.

**Action:** The task will be processed as soon as there is available threads.

#### SELF WAIT
**Description:** The Single run option is set for the job or process flow, and there is another instance of the task running. The first must complete before the second instance will be initiated.

**Action:** No action required. If you want to allow two instances of the task to run concurrently (even within a process flow), uncheck the Single run option in the job/process flow definition.

#### Skip!Active
**Description:** This process flow component was skipped because its Component active option is unchecked.

**Action:** No action required. For information on inactivating process flow components, see chapter 4: Editing Process Flow Component Information in the Development Guide.

#### Skip!DayofWk
**Description:** This process flow component was skipped because the corresponding day of the week was not assigned to it.

**Action:** No action required. For information on selecting days of the week for process flow components, see topic 4.2 Specifying Calendars and Eligible Run Days in the Development Guide.
<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip!RunCal</td>
<td><strong>Description:</strong> This process flow component was skipped because a run calendar assigned to it did not include this day. <strong>Action:</strong> No action required. For information on removing or editing the run calendars for process flow components, see topic 4.2 Specifying Calendars and Eligible Run Days in the Development Guide.</td>
</tr>
<tr>
<td>SkipCal</td>
<td><strong>Description:</strong> This process flow component was skipped because a skip calendar including this day was assigned to it. <strong>Action:</strong> No action required. For information on removing or editing the skip calendars for process flow components, see topic 4.2 Specifying Calendars and Eligible Run Days in the Development Guide.</td>
</tr>
<tr>
<td>SkipCond</td>
<td><strong>Description:</strong> The task will not be run because an action associated with a condition has specified that the task be skipped. <strong>Action:</strong> Check the conditions for the job/process flow.</td>
</tr>
<tr>
<td>STAGED</td>
<td><strong>Description:</strong> This process flow component is part of a process flow that has been staged. Tasks are staged by: • Running either the STAGING or STAGING_BY_SCHEDULE jobs and selecting prompts. • Post-dating the start date/time for a job or process flow when requesting it on an ad hoc basis. The components will stay in a staged status until their process flow is initiated. Staged and post-dated jobs and process flows in the Backlog will be shown in a DATE PENDING status. <strong>Action:</strong> No action is required. The task will run when its reaches its start date and time. You can edit the task details of the process flow or its components in the Backlog.</td>
</tr>
<tr>
<td>STAGED HOLD</td>
<td><strong>Description:</strong> This process flow component is on hold and has been staged. <strong>Action:</strong> The task will not be eligible to run until both of the following occur: • The hold status is changed by an action associated with another condition or by a user. • The task reaches its start date and time.</td>
</tr>
<tr>
<td>STAGED_PW</td>
<td><strong>Description:</strong> This process flow component has been staged and is waiting for one or more predecessor requirements to be met. <strong>Action:</strong> The task will not be eligible to run until both of the following occur: • The task reaches its start date and time. • The predecessor requirements for the task are met.</td>
</tr>
</tbody>
</table>
### Status Description/Action

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
</table>
| STARTED     | **Description:** This status is displayed only in History. It is associated with the RMI server or an agent. It indicates the date and time the RMI server or agent started.  
**Action:** No action required. This is only a historical record. |                                |
| STG_SKIP    | **Description:** This process flow component has been staged and is being skipped in the process flow. This happens when a day of the week is unchecked or a skip calendar is selected in the Schedule box on the component's General sub-tab. For more information, see topic 4.2 Specifying Calendars and Eligible Run Days in the Development Guide. When its process flow runs, this task will move to History with a Skip!Active status.  
**Action:** No action required. |                                |
| STG_PW_HOLD | **Description:** This process flow component is on hold and is waiting for one or more predecessor requirements to be met.  
**Action:** The task will not be eligible to run until all of the following occur:  
• The hold status is changed by an action associated with another condition or by a user.  
• The task reaches its start date and time.  
• The predecessor requirements for the task are met. |                                |
| STOPPED     | **Description:** This status is displayed only in History. It is associated with the RMI server or an agent. It indicates the date and time the RMI server or agent stopped.  
**Action:** No action required. This is only a historical record. |                                |
| TIMEDOUT    | **Description:** The automation engine has processed the task after it has exceeded its permitted run-time allotment.  
**Action:** Determine why the task was taking so long to run. If appropriate, change the maximum run time for the job, or change the task's conditions. |                                |
| TIME-OUT    | **Description:** The task has taken longer than the maximum run-time period specified in the job definition or a maximum run-time period specified in a condition. This is an interim status that should change quickly to TIMEDOUT.  
**Action:** See TIMEDOUT for actions. |                                |
| UNAVAILABLE | **Description:** The required agent is not running.  
**Action:** Start the agent. |                                |
| UNSAT-FINISH| **Description:** Someone has removed this task as a predecessor to all referenced tasks. The predecessor links of other tasks need to be satisfied by another running of this task. For more information, see topic 4.11 Unsatisfying Tasks as External Predecessors in History in the User Guide.  
**Action:** No action required. |                                |
An Applications Manager run-time extension changed the status of a job to WARNING. Usually this status is assigned to a task that has errors but has gone to completion.

**Action:** Check the log for the task to see what errors occurred.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>WARNING</td>
<td><strong>Description:</strong> An Applications Manager run-time extension changed the status of a job to WARNING. Usually this status is assigned to a task that has errors but has gone to completion. <strong>Action:</strong> Check the log for the task to see what errors occurred.</td>
</tr>
</tbody>
</table>
Index

Symbols

.netrc file
  description, A-17
  using, D-398
.profile file description, A-17

-A-

Abort if no output option, setting for jobs, D-70
ABORT TASK, value for condition action, D-292
ABORTD task status, U-213
ABORTED task status, U-213
aborted tasks
  resetting to run again, U-86
  settings alerts for, U-10
aborting tasks, with conditions, D-310
Action field
  using arguments with, D-292
  values available for conditions, D-292
action timing, setting for condition actions, D-296
actions, taking multiple actions for a condition, D-283
activating/inactivating
  agents, A-102
  jobs, D-38
  process flow components, D-143
  process flows, D-107
  queues, U-163
  schedules, D-331
  users, A-49
ad hoc jobs and process flows, requesting, U-38
adding objects. See individual object names.
adding, editing, and deleting Web Service methods, D-520
adjusted start and end times, viewing in the Backlog Gantt view window, U-189
AFTER conditions, defining, D-287
AFTER timing, setting for conditions, D-287
agent groups
  adding, editing, and deleting, A-116
  assigning agents to agent groups, A-117
  dynamic load balancing, A-118
  load factor for agents in an agent group, setting, A-118
  multi-execution agent groups, A-117
  priority for agents in an agent group, setting, A-118
  Use Task Count Load Balancing vs. CPU% setting for agents, A-102
agent icons, adding to an AppMaster view, A-306
Agent Logs, customizing table columns for the Agent Logs window, U-18
agent status values (status and description/action), U-210
Agent Summary
  column descriptions, U-151
  customizing table columns for, U-18
agent variable, A-288
AGENT WAIT task status, U-213
AgentClientPort, description, A-288
agents
  {agent} replacement value, D-256
  {node} replacement value, D-257
  {operator} replacement value, D-257
  activating/inactivating agents, A-102
  ad hoc requests, selecting for, U-41
  agent groups, adding, A-116
  agent loading, monitoring with the dashboard, U-181
  assigning thread schedules to thread schedules, A-101
  assigning to
    agent groups, A-117
    jobs, D-37
    process flow components, D-146
    schedules, D-331
automation engine’s time zone, setting, A-106
BUSY or TROUBLE agent, taking offline, U-153
changing
status colors for agents, U-20
status colors for agents (for all users), A-57
thread schedules for agents and automation engines, U-153
configuring, A-98
connections, viewing reports of agents connected to an automation engine, A-9
CPU Limit, setting, A-101
debugging, A-102
dynamic load balancing, A-118
filtering the Backlog and History for agents, U-135
idling and resuming, U-152
IP address, setting, A-101
log listings for agents, viewing, U-154
logging agent events, A-166
multi-execution agent groups, A-117
OS type, setting, A-101
output directory, setting, A-102
querying
History for, U-130
Output window for, U-51
remote agents, adding, A-100
resetting, U-153
sleep time, setting, A-101
starting and stopping, U-152
status, viewing, U-151
thread schedules, adding to agents, U-164
Use Task Count Load Balancing vs. CPU%, setting, A-102
viewing and editing for tasks, U-96
agents, assigning users to agents, A-102
agents, naming conventions, A-258
AgentService process
description, A-190
details, A-208
AHA reports running, A-154
alerts, setting for
aborted tasks, U-10
agents in TROUBLE status, U-10
on hold tasks, U-10
aliases
{module} replacement value, D-257
{task} replacement value, D-258
process flow components, using in, D-270
setting for process flow components, D-142
Allow aborted task to block single threaded queue option, setting for the automation engine, A-110
Allow changes option, setting for prompts, D-222
Allow deleted status to satisfy Success since last run option, setting for the automation engine, A-110
Allow requests from non active users option, setting for the automation engine, A-111
alternate device, setting, A-23
alternative viewers
sharing for all users, U-60
using, U-58
Always evaluate subvars in process flow prompts at component run times, setting for the automation engine, A-112
ALWAYS TRUE, value for conditions, selecting, D-288
AND/OR logic, changing for predecessors, D-196
app_path environment variable, D-442
application environment variable, D-442
Application Summaries, viewing all running tasks by application, U-74
applications
{application} replacement value, D-256
adding, editing, and deleting, D-40
assigning to
environment variables, D-40
jobs, D-37
notifications, D-40
process flows, D-102
filtering the Backlog and History for applications, U-135
querying History for applications, U-130
Applications Manager
administrative tasks, A-256
customizing, A-56
launching, U-26
reserved words, D-446
security, working with user groups, A-64
shutting down with SUSOSHUTP, D-510
Technical Support, contacting, A-4
Web site, connecting from Applications Manager, U-25
Applications Manager directories, introduction to, A-16
Applications Manager Help window, changing size and location, A-318
Applications Manager History Analysis reports, running, A-154
AppMaster
  configuring collectors, A-298
  configuring distributors, A-298
  features, U-30
  viewing the Masters.properties file from the Applications Manager client, A-11
AppMaster Administration, A-300
appworx command line interface, using, D-478
appworx_port variable, A-289
appworxj, launching Applications Manager from the command line, U-27
arranging internal predecessor links, D-172
assigned objects, viewing, A-14
assigning objects to user groups, A-68
associated file viewers
  sharing for all users, U-60
  using, U-58
audio alerts, setting for tasks and agents, U-10
auditing
  Applications Manager objects, A-114
  imports, D-378
audits, assigning user login audits to enforce rules for selecting passwords, A-58
Authentication mechanism, LDAP option, setting for the automation engine, A-113
authoriz.lis file
  assigning ownership, D-455
  creating, D-454
auto output options, setting, A-23
Automatically assign new user group objects to themselves option, setting for the automation engine, A-110
automation engine
  {engine} replacement value, D-256
  agent groups, assigning to, A-117
  configuring, A-98
  deferring schedules, D-358
  dynamic load balancing, A-118
  logging on to a automation engine, U-28
  options, setting, A-106
  process logs
    file naming conventions, A-238
    rollover interval, A-239
  remote agents, adding to, A-100
  RMI server, adding to, A-10
  role
    after program executes, A-230
    in task execution, A-220
setting
  Allow requests from non active users option, A-111
  Disable clearing of login passwords on re-login option, A-111
  Force password change if reset by another user option, A-111
  load factor for agents (including the automation engine) in an agent group, A-118
  login type, A-108
  priority for agents (including the automation engine) in an agent group, A-118
  Require password length of 6 characters option, A-111
  time zones, A-106
  thread schedules, changing, U-153
Automation Engine Debug option, setting for the automation engine, A-109
automation engine icons, adding to an AppMaster view, A-306
automation engine process logs, retention days, A-239
Ave run time option
  calculating, D-66
  setting for jobs, D-49
  process flow components, D-147
  process flows, D-107
aw_audit_table, creating for Applications Manager audits, A-114
AW_HOME environment variable, D-444
awcomm process
  description, A-190
AWCOMM process, details, A-206
AWCOMM_PORT, description, A-289
awenv.ini environment initialization file, A-286
awexe
  command line syntax, D-468
  process details, A-214
  range, setting for users, A-50
awexe process description, A-191
AWFILES.Z file description, A-17
AWJAVA program type interface script, explanation of, D-512
awop_api.awrun
  procedure for requesting tasks through Oracle, D-556
AWOS400CMD program type, using, D-86
awrun
  AWRUN_NO_PASSWORD, using to run without a password, D-467
  command line syntax, D-464
  examples, D-467
  procedure for requesting tasks through Oracle, D-556
  security, D-466
  supported options, D-464
awrun process description, A-191
AWRUN_NO_PASSWORD, using to run awrun without a password, D-467
AWS400PGM program type, using, D-86
AWTCPD process
  configuring, A-208

-B-
background images (custom), adding, A-304
Background Manager variables
  DURING_WAIT, A-284
  JOB_START_LIMIT, A-284
  SOSTOP, A-284
Backlog
  customizing table columns for the Backlog, U-18
  jobs
  deleting, U-88
  killing tasks, U-84
  limiting the list of tasks, U-74
  removing all predecessors for a task in the Backlog, U-90
  reviewing tasks waiting in each queue, U-68, U-70
  staging tasks, U-140
  status values (status and description/action), U-213
  taking actions with predecessors, U-104
  tasks
  resetting, U-86
  using, U-68, U-70
Backlog distribution, monitoring with the dashboard, U-181
Backlog task summaries
  customizing table columns for in the pop-up table, U-18
  viewing, U-73
BAD BATCH task status, U-213
bad conditions, evaluating, D-279
BAD CONDITN task status, U-213
BAD CONNECT task status, U-213
BAD DATE PRM task status, U-213
BAD LIBR task status, U-213
BAD LOGIN task status, U-213
BAD MJN task status, U-214
BAD MODULE task status, U-214
BAD QUEUE task status, U-214
BAD SQL STMT task status, U-214
BAD TYPE task status, U-214
BAD_AGENT task status, U-214
balancing loads, A-118
BEFORE conditions, defining, D-286
BEFORE timing, setting for conditions, D-286
best practices, naming conventions, D-8
BODY script, role in
  task execution, A-224
  task execution after program executes, A-229
BODY.bat, A-224
bookmarking output pages for printing, U-55
break, setting for report columns, A-135
broadcasts, sending broadcast messages to users, A-7
browsing the Applications Manager database from the client, A-156
BULK_CHANGES job, changing job/process flow characteristics, D-82
BUSY, automation engine/agent status, U-210

-C-
CALC_AVE_RUN job, running, D-66
CALC_HISTORY_STATISTICS job, running, A-154
calendars
    adding, editing, and deleting, D-346
    assigning to
        jobs and process flows, D-333
        process flow components, D-144
CANCEL PROCESS FLOW condition
    action, D-292
CANCEL SUB PROCESS FLOW condition
    action, D-292
CANCELLED task status, U-214
capacity, setting the factor for agents in an
    agent group, A-118
chain ID, {chain_id} replacement value,
    D-256
chain sequence number, {chain_seq}
    replacement value, D-256
chain_id environment variable, D-442
chain_seq environment variable, D-442
CHANGE Q value for condition action,
    D-292
change revisions, implementing for
    process flow components, D-134
changes, updating unsaved changes, D-20
characteristics, changing bulk job/process
    flow characteristics, D-82
CHECK CONNECTION condition,
    description, D-288
CHECK FILE condition
    description, D-288
    example, D-304
CHECK FILE FTP condition
    description, D-288
CHECK HISTORY condition
    description, D-289
    example, D-316
CHECK LOG automation engine/agent
    status, description, U-210
CHECK PROCESS condition, description,
    D-289
Check SQL option for
    data types, D-228
substitution variables, D-251
CHECK_FILE {file_line} replacement
    value, D-257
check_interval variable, A-289
CLEAN environment variable, using to
delete process files when the process
exists, D-442
close option, for adding components to a
    process flow, D-127
closing windows, U-5
COBOL programs, running with the
    SOCOBOL program type interface script,
    D-504
CollectorMaster, configuring for the
    Masters.properties file, A-296
collectors
    configuring for the Masters.properties file,
    A-297
    defining for AppMaster, A-298
color descriptions for status bar in
    AppMaster, U-206
    Explorer, U-76
column order, changing, U-6
columns
    customizing tables in Applications Manager
        windows, U-18
    customizing tables in Applications Manager
        windows (for all users), A-57
    order, changing, U-6
    reports, adding to, A-132
    reports, editing in, A-134
    sorting, U-6
Comma Separated, setting for prompts,
    D-221
command environment variable, D-442
command line
    interface
        setting the awexe range for a user,
        A-50
        using, D-478
    launching Applications Manager, U-27
command path
    {command_path} replacement value, D-256
    program types, assigning to, D-46
command, setting for output interfaces,
    A-29
command_dir environment variable, D-442
comments
querying, U-112
viewing for tasks, U-112
complete predecessors, description of, D-163
completion run-time extension, D-438
component groups, creating, D-130
components, maximum number in a process flow, D-100

conditions
Action field, using arguments with, D-292
adding, editing, and deleting, D-282
AFTER timing, setting, D-287
BEFORE timing, setting, D-286
continuous setting for actions, D-296
copying, D-298
DELETED timing, setting, D-287
DURING timing, setting, D-287
DURING_WAIT variable setting, D-280
editing in the Backlog, U-106
evaluating bad conditions, D-279
qualifier value, D-290
setting
timing for conditions, D-286
static substitution variables, defining with a SET SUBVAR action, D-249
taking more than one action for a condition, D-283
types available for conditions, D-288
using to
abort a task, D-310
check elapsed time, D-302
check History, D-316
check if a file exists, D-304
check if process is running, D-306
trigger two or more actions, D-314
values available for conditions, D-284
viewing for a task, U-106
CONDITN WAIT task status, U-214
configuring agents and automation engines, A-98
Connect string, {net_connect} replacement value, D-257
connection information, viewing for agents connected to an automation engine, A-9
users connected to a automation engine, A-6
connection information, viewing for RMI servers connected to an automation engine, A-8
contacting technical support, A-4
copies environment variable, D-442
copying
Applications Manager objects, D-12
conditions, D-298
output scan rules, D-54
process flow components, D-134
prompts, D-238
prompts from another job or process flow, D-238
CPU limit, setting for agents, A-101
CPU WAIT, automation engine/agent status, description, U-210
crashes, how Applications Manager recovers from, U-124
Create Procedure SubVars user option, A-53
current day
filtering the Backlog and History for, U-135
querying by
in Output window, U-51
querying by in History, U-131
CURRENT QUEUE condition, D-289
CURRENT TIME condition, D-289
customizing
Applications Manager, A-56
table columns in Applications Manager windows, U-18
table columns in Applications Manager windows (for all users), A-57
-D-
daily activity, monitoring with the dashboard, U-181
dashboard, monitoring system performance, U-180
data types
adding, editing, and deleting, D-226
prompts, assigning, D-221
prompts, using in, D-226
SQL statements
adding, D-228
checking, D-228
database logins, adding, editing, and deleting, A-88
database times, setting default date/time format, A-57
database, browsing the Applications Manager database from the client, A-156
Date input/output formats, setting for data types, D-227
DATE PENDING task status, U-214
date/time formats, setting defaults, A-57
daylight savings time, scheduling during daylight savings time changes, D-360
days process flow components will run, setting, D-145
DB ERROR task status, U-215
db_login environment variable, D-442
db_password environment variable, D-442
db_type environment variable, D-442
DBA user group, A-70
DEAD task status, U-215
debug
activating, A-237
agent debug, setting, A-102
debugging SURUN, D-458
environment variable, D-442
masks
creating in awenv.ini, A-286
setting client, RMI server, all agent, and Oracle trace options, A-240
troubleshooting with, A-234
turning on for select programs, A-237
debug code, adding to program type scripts, D-430
debug_mask variable, A-289
decimal values, for run IDs, U-72
default output device, setting for users, A-50
default output directory, assigning to a user, A-51
default requestor, assigning to a process flow component in the User field, D-153
Default value, setting for prompts, D-221–D-222
DEFAULT_USER, creating, A-56
Defer schedules on startup option, setting for the automation engine, A-112
Deferring schedules, D-358
DELAY TASK condition action, D-292
DELETE DEFAULT, deleting output files, A-122
DELETE SUBVAR condition action, D-292
DELETED conditions, defining, D-287
DELETED task status, U-215
DELETED timing, setting for conditions, D-287
deleting objects
desktop settings, specifying, U-9
desktop, restoring the display when error dialogs are out of view, U-6
details, viewing for a job after execution, U-110
DIED task status, U-215
Disable clearing of login passwords on re-login option, setting for the automation engine, A-111
Disable initial predecessor inheritance option, setting for the automation engine, A-110
Disable user after 3 consecutive failed login attempts option, setting for the automation engine, A-111
disabling
Backlog queries, U-133
Output queries, U-53
Distinguished name (dn), setting for the automation engine, A-113
distribution lists
adding, A-24
output option, setting, A-25
distribution, monitoring Backlog
distribution with the dashboard, U-181
distributors, defining for AppMaster, A-298
Do not require awrun passwords option, setting for the automation engine, A-111
documentation
defining for jobs and process flows, D-72
viewing for a task, U-108
viewing for ad hoc requests, U-42
DURING conditions, defining, D-287
DURING timing, setting for conditions, D-287
DURING_WAIT variable
Background Manager, A-284
in awenv.ini, A-289
setting, D-280
dynamic load balancing, with agent groups, A-118

dynamic substitution variables
  adding, editing, and deleting, D-250
  definition of, D-246
  logins, setting, D-251
  procedures, defining, D-252

-E-

Edit Other Users’ Tasks user option, A-53
  editing
    agent for a task, U-96
    conditions in the Backlog, U-106
    import maps, D-380
    login for a task, U-96
    max run time for a task, U-96
    output function for a task, U-97
    predecessors for a task, U-100
    priority for a task, U-96
    prompts for a task, U-98
    queue for a task, U-96
    start date and time for a task, U-96
    the output device for a task, U-96

editing objects. See individual object names.

elapsed time, checking with conditions, D-302

eligibility, determining for jobs, D-557

email
  {email} replacement value, D-256
  assigning
    attachments to notifications, D-59
    recipients to notifications, D-59
  output devices, adding, A-20
  specifying for users, A-51

email output interface, creating, A-38

emailing, task output files, U-56

Enable auditing of backlog changes option, setting for the automation engine, A-110

Enable full condition debugging option, setting for the automation engine, A-109

Enable TRUE condition debugging option, setting for the automation engine, A-109

ended time, viewing for tasks, U-95

environment initialization file
  awenv.ini, A-286

environment variables
  adding, editing, and deleting, D-62
  app_path, D-442
  application, D-442
  assigning to
    agents, A-101
    applications, D-40
    process flow components, D-147
    program types, D-45
  AW_HOME, D-444
  chain_id, D-442
  chain_seq, D-442
  CLEAN, using to delete process files when the process exits, D-442
  command, D-442
  command_dir, D-442
  copies, D-442
  db_login, D-442
  db_password, D-442
  db_type, D-442
  DEBUG, D-442
  file, D-443
  function, D-443
  host_command, D-443
  job_number, D-443
  jobid, D-443
  log_run, D-443
  login, D-443
  login_sid, D-443
  module, D-443
  net_connect, D-443
  orig_log_run, D-443
  OUTPUT, D-443
  output_required, D-443
  par, D-443
  printer, D-443
  printer_type, D-443
  program, D-443
  queue, D-443
  rpf_options, D-444
  seq_no, D-444
  setting
    for jobs, D-48
      with the pm file, A-222
    SO_OPERATOR, D-444
    so_par, D-444
    source, D-444
    status, D-444
stdout, D-444
user, D-444
using in
  library paths, D-43
  printer interface scripts, A-30
  shell scripts, D-442
using in prompts, D-222
viewing for tasks, U-95
envvar.bat, role in task execution, A-221
error dialogs, restoring the display when error dialogs are out of view, U-6
error trapping in
  program type scripts, D-426
  UNIX program type scripts, D-427
  Windows program type scripts, D-428
Errors agent status, U-210
ERRORS task status, U-215
events
  logging agent events, A-166
  logging task events, A-164
exception method, setting for schedules, D-334
exceptions adding, editing, and deleting for schedules, D-342
executing your environment, A-285
execution options, setting for
  jobs, D-48
  process flow components, D-146
  process flows, D-102, D-106
existing scripts
  getting started with, D-6
  pros and cons, D-32
expire interval, setting for user passwords, A-49
Explorer Refresh Seconds, desktop setting, U-9
export file, Applications Manager definition of (for exports and imports), D-368
export lists
  Applications Manager definition of (for exports and imports), D-368
  saving, D-374
exports
  jobs and process flows, D-370
  process flow components, D-371
exports, Oracle vs. Applications Manager, A-257
external option, for adding components to a process flow, D-127
external predecessor links
  adding, D-188
  adding to tasks in the Backlog, U-105
  virtual day, setting, D-184
EXTRACT VALUE condition action, D-292

-F-
factor variable, WatchWorx, A-284
Failure (skip on success) predecessors, description of, D-163
failure predecessors, description of, D-163
fax
  fax number for users, specifying, A-51
  output devices, adding, A-20
fax output interface, creating, A-40
fax_no, {fax_no} replacement value, D-256
fields
  editing with the translator editor, A-12
  setting for report columns, A-134
file associations, adding, U-58
file environment variable, D-443
FILE ERROR task status, U-215
file extension, assigning to program types, D-46
file naming conventions, automation engine process logs, A-238
file option, setting for data types, D-234
file viewer text size, changing from the file viewer, U-55
FILESIZE, role in task execution, A-228
filtering, the Backlog and History, U-134
FINISHED task status, U-216
first name, {first} replacement value, D-257
fiscal calendar schedules, creating, D-338
fiscal calendars, creating, D-340
font size, setting for the user interface, U-12
Force password change if reset by another user option, setting for the automation engine, A-111
Force password change on new users option, setting for the automation engine, A-111
Force password to contain both alpha and numeric characters, setting for the automation engine, A-111
forecasts, viewing for jobs and process flows, U-172
Frequency
  notifications, assigning to, D-58
  schedules, setting for, D-330
FTP
  FTP job, description, D-396
  FTP_JAVA job, description, D-390
  SFTP_JAVA job, description, D-394
FTP job
  host login, using with, D-402
FTP Output Files user option, A-53
FTP.SH script, D-402
FTP_JAVA job, description, D-390
FTPing, task output files, U-56
function environment variable, D-443
future hours, filtering the Backlog and History, U-135

-G-
Gantt chart
  using with Graphical Forecasts, U-174
  viewing for process flows, D-136
Gantt legend, viewing, U-187
Gantt task summaries
  customizing table columns for the in the pop-up table, U-18
  viewing, U-187
Gantt view
  adjusted start and end times, viewing, U-189
  History Gantt view window, viewing, U-120
  keeping History, U-194
  printing, U-196
generating production schedule reports, U-178
GOTO CONDITION condition action, D-293
grant for sys, prior to install, A-270
Graphical Analysis Package, features, U-30
Graphical Forecasts, viewing for jobs and process flows, U-174
  groups, creating in a process flow, D-130

-H-
heading, setting for report columns, A-134
hidden tasks in the Output window, hiding and displaying, U-49
Hide Files on the Output Window user option, A-53
History
  checking with conditions, D-316
  completed tasks, reviewing, U-130
  Gantt view window, viewing tasks, U-120
  keeping in the Gantt view, U-194
  querying, U-130
  records, deleting, A-123
  status values (status and description/action), U-213
  table columns, customizing, U-18
  task output, viewing, U-110
History Display Minutes, desktop setting, U-9
HISTORY_PURGE, deleting history records, A-123
Hold option for ad hoc requests, U-42
HOLD PRED WT task status, U-216
HOLD TASK condition action, D-293
HOLD task status, U-216
  hold tasks, settings alerts for, U-10
  home directory files, UNIX, A-17
host command
  {host_command} USER replacement value, D-257
  assigning to program types, D-46
host command environment variable, D-443
HOST FAILURE task status, U-216
host login, using with the FTP job, D-402
HTML documentation, D-72

-I-
icons, adding to an AppMaster view, A-306
IDLED automation engine/agent status, U-210
idling agents, U-152
import file, Applications Manager
  definition of (for exports and imports), D-368
  importing
Applications Manager History Analysis
objects, A-155
auditing imports, D-378
import file and map, selecting, D-376
jobs and process flows, D-376
maps, editing, D-380

inactivating/activating
agents, A-102
jobs, D-38
process flows, D-107
queues, U-163
schedules, D-331
users, A-49

INACTIVE status
automation engine/agents, U-210
tasks, U-216

ineligible statuses, definition of, D-162
initial_sleep variable, WatchWorx, A-198
INITIATED task status, U-216

Insert components into process flow’s
queue option, setting for the automation
engine, A-112

installed program types and paths, D-432
interface scripts for output interface
objects, A-29

interim failure statuses, definition of,
D-162

internal predecessor links, arranging,
D-172

IP address, setting for agents, A-101

-J-

Java JNDI Factory class, LDAP option,
setting for the automation engine, A-113
JAVA programs, running with the
AWJAVA program type, D-512
JDBC, specifying JDBC requirements for
logins, A-90
JMS messages
retrieving as subvars, D-542
sending with conditions, D-546

Job execution, description of, A-212
job ID, {job} replacement value, D-257
Job/process flow option, using with user
groups, A-69
job_number environment variable, D-443
job_start_limit variable, A-289

JOB_START_LIMIT variable, Background
Manager, A-284

jobid environment variable, D-443

jobs

[job] replacement value, D-257
{module} replacement value, D-257
Abort if no output option, setting, D-70
activating/inactivating, D-38
adding, editing, and deleting, D-28
aliases, setting in process flows, D-142
assigning to
agents, D-37
applications, D-37
calendars, D-333
libraries, D-39
logins, D-50
output devices, D-68
output groups, D-68
program options, D-70
program types, D-39
prompts, D-220
queues, D-37
skip calendars, D-333
assigning to, schedules, D-328
Ave run time option, setting, D-49
changing bulk job/process flow
characteristics, D-82
Comma Separated option for prompts,
setting, D-221
conditions, adding to, D-282
copying, D-12
default date/time format, setting, A-57
Default value option for prompts, setting,
D-221–D-222
defining, D-28
deleting from Explorer, U-88
determining eligibility, D-557
documentation, defining for, D-72
documentation, defining for, D-72
environment variables, setting, D-48
evaluation options, setting, D-221
exporting, D-370
filtering the Backlog and History for jobs,
U-135
FTP host login, using with, D-402
importing, D-376
Keep system output option, setting, D-49
List of Values option for prompts, setting,
D-221
LOADER job, description, D-404
login options, setting, D-48
login source options, setting, D-51
Max # of revisions option, setting, D-69
Max length option for prompts, setting, D-222
Max run time option, setting, D-49
maximum number in a process flow, D-100
Min run time option, setting, D-49
minimum/maximum values for prompts, setting, D-222
Multi Select option for prompts, setting, D-221
notifications, setting, D-48
output directory, setting, D-70
output function, setting, D-69
output options, setting, D-68
output scans, setting for, D-48
passing values through a process flow, D-264
predecessors, jumping to, D-193
predecessors, removing all in the Backlog, U-90
Print system output logs option, setting, D-70
priority, setting for, D-49
program information, defining, D-36
programs, assigning to, D-39
prompts, adding, D-212
prompts, overriding in a schedule, D-344
querying for in History, U-130
Output, U-50
reports, running with a job, A-152
requesting, U-38
Restart once on abort option, setting, D-50
Retention days option, setting, D-49
running under other host logins, D-450
schedules, adding to, D-328
sequence number, {job_seq} replacement value, D-257
sequence number, {mjin} replacement value, D-257
setting execution options for process flow components, D-146
Single run option, setting, D-37
status colors changing for jobs for all users, A-57
status, monitoring and managing, U-77
Stay in queue on abort option, setting, D-38
submitting, U-40
successors, jumping to, D-193
time zones, setting, D-331
user groups, assigning to, D-76
Variable name option for prompts, setting, D-221
viewing
  details after execution, U-110
  output from History, U-110
  the next run date for a schedule, D-330
justify, setting for report columns, A-135

-K-
Keep system output option, setting for jobs, D-49
keyboard navigation, U-7
Keystroke password, LDAP option, setting for the automation engine, A-113
Keystroke path, LDAP option, setting for the automation engine, A-113
KILL TASK condition action, D-293
KILL task status, U-216
KILL1 task status, U-216
KILLED task status, U-217
KILLING task status, U-217
killing tasks, U-84

-L-
Labels.properties file, copying and editing for language translation, A-12
language setting for users, A-51
  translating for Applications Manager field names, A-12
last name, {last} replacement value, D-257
LAUNCH ERR task status, U-217
LAUNCH ERROR task status, U-217
LAUNCHED task status, U-217
launching Applications Manager, U-26
launching Applications Manager, from the command line, U-27
LDAP authorization, setting for users, A-49
  setting LDAP options, A-113
libraries
- [application_path] replacement value, D-256
- adding, editing, and deleting, D-42
- jobs, assigning to, D-39
- paths, assigning to, D-43

**limiting the list of tasks in the Backlog**, U-74

- List of Values, setting for prompts, D-221
- list option, setting for data types, D-233
- load balancing, A-118
- load factor, setting for an agent in an agent group, A-118

**LOADER job**
- description, D-404
- prompt descriptions, D-405

**local substitution variables, creating for a process flow**, D-260

- log and error files, A-286
- log file naming conventions, A-237

- Log Locks Encountered option, setting for the automation engine, A-109

- log_run environment variable, D-443
- logging on to Applications Manager under different user names and automation engines, U-28

- login environment variable, D-443
- login source options, setting for jobs, D-51

**login type**
- automation engine, setting for, A-108
- logins, setting for, A-89
- program types, assigning to, D-45

- login, {db_type} replacement value, D-256
- login, setting for users, A-50

- login_sid environment variable, D-443

**logins**
- [oracle_sid] replacement value, D-257
- adding, editing, and deleting, A-88
- assigning a JMS login to the automation engine, D-548
- creating for JMS, D-544
- creating for Web services, D-518
- options, setting for jobs, D-48
- Oracle login, changing the password for, A-94
- password, setting the login for, A-89
- port and Sid, setting, A-89

**logs**
- background processes log information, A-238
- viewing for agents, U-154

**look and feel, specifying the system look and feel**, A-333

**lp print spooler**
- a review, A-34
- specifying arguments for, A-36

**-M-**

**maintenance user group, setting for users**, A-50

**managing output**
- SURUN, capturing output from, D-458

**map file, Applications Manager definition of (for exports and imports)**, D-368

**map, Applications Manager definition of (for exports and imports)**, D-368

**mapping support objects for imports**, D-376

**master variable**, A-290

**master, {master} replacement value**, D-257

**Master_IP_Address variable**, A-290

**Masters, configuring in the Masters.properties file**, A-297

**Masters.properties file**
- detailed description, A-296
- viewing from the Applications Manager client, A-11

**MasterServerPort, description**, A-290

**Max # of revisions option, setting for jobs**, D-69

**Max length, setting for**
- data types, D-227
- prompts, D-222

**max run time**
- option, setting for jobs, D-49
- viewing and editing for tasks, U-96
max_cycles variable, WatchWorx
environment variable, A-198
max_cycles variable, WatchWorx variable, A-284
MAX_RESTARTS task status, U-217
max_time_reboot variable, WatchWorx
environment variable, A-198
max_time_reboot variable, WatchWorx variable, A-284
maximum/minimum values, setting for
prompts, D-222
message templates, adding, editing, and
deleting, D-60
message text, assigning to notifications,
D-58
messages, sending broadcast messages to
users, A-7
MGRSTOPPED task status in History,
U-217
MGRSTOPPED, automation engine/agent
status, U-210
min run time option, setting for jobs, D-49
Min Run Time task status, U-218
Min Threads, setting, U-157
Min/Max values, setting for data types,
D-227
min_time_reboot variable
WatchWorx environment variable, A-198
WatchWorx variable, A-284
minimum threads allowed for queues,
setting, U-157
minimum/maximum values, setting for
prompts, D-222
mnemonics, editing with the translator
editor, A-12
module environment variable, D-443
MODULE REQUESTED condition,
selecting, D-289
MODULE RUNNING condition, selecting,
D-289
multi_factor variable, WatchWorx, A-198
multi option, setting for data types, D-231
Multi Select, setting for prompts, D-221
multi-execution agent groups, A-117
multi-execution agent groups, adding,
A-116

-N-
naming conventions for agents, A-258
naming conventions, best practices, D-8
navigating process flows, D-132
nesting process flows within process
flows, D-100
net_connect environment variable, D-443
netrc file, using, D-398
NetWork alias, setting for logins, A-89
Next run date, viewing for schedules,
D-330
no preds option for adding components to
a process flow, D-127
no print option, setting for report
columns, A-135
NO PRIORITY task status, U-218
No_Service, automation engine/agent
status, U-210
nodes, see agents
notifications
adding, editing, and deleting, D-56
assigning
applications to, D-40
e-mail attachments to, D-59
e-mail recipients to, D-59
e-mail subjects to, D-58
frequency to, D-58
output device to, D-59
process flow components to, D-147
program types to, D-45
status trigger to, D-58
message text, adding to, D-58
viewing for tasks, U-95
notifications, assigning to
jobs, D-48
ntspawn, using to run Windows jobs, D-420
numeric qualifiers for conditions, D-290

-O-
object icons, definition of, U-67
object keys, definition of, U-67
object tree, definition of, U-67
objects
adding, editing, and deleting, D-10
assigning to user groups, A-74
auditing Applications Manager objects,
A-114
copying, D-12
offline, taking a BUSY or TROUBLE agent offline, U-153
once, evaluating conditions the first time the condition is true, D-297
options
assigning (generic), U-7
automation engine, setting for, A-106
setting for LDAP, A-113
user, setting for, A-52
Options.properties file, description of parameters, A-292
Oracle export vs. Applications Manager export, A-257
Oracle login, changing the password for, A-94
Oracle Sid, setting for logins, A-89
orig_log_run environment variable, D-443
OS type, setting for agents, A-101
OS/400
jobs, creating, D-84
program types, using, D-86
outage, scheduling behavior after an outage, D-327
Output
auto output options, setting, A-23
file viewer text size, changing, U-55
format, changing, U-55
hiding tasks, U-49
limiting to tasks submitted by user, U-48
pages, bookmarking for printing, U-55
previewing print tasks, U-56
printing, FTPing, and emailing, U-56
querying the Output window, U-50
text, finding, U-55
viewing
by page and line numbers, U-55
from History, U-110
task output, U-55
output devices
ad hoc requests, selecting for, U-40
adding, editing, and deleting, A-22
assigning
output function to, A-25
output groups to, A-23
output interfaces to, A-23
users to, A-25
assigning to
jobs, D-68
notifications, D-59
process flows, D-109
auto output options, setting for, A-23
output option, setting, A-23
querying the Output window for output devices, U-51
static options, setting, A-23
troubleshooting output problems, A-42
users, setting for, A-50
viewing and editing for tasks, U-96
output directory, assigning a different output directory to
agents, A-102
jobs, D-70
users, A-51
output distribution lists, adding, editing, and deleting, A-24
OUTPUT environment variable, D-443
output files
deleting, A-122
output function
ad hoc requests, setting for, U-41
assigning to
jobs, D-69
output devices, A-25
process flow components, D-153
process flows, D-109
querying the Output window for output function, U-51
viewing and editing for tasks, U-97
output groups
adding, editing, and deleting, A-26
assigning to
jobs, D-68
output devices, A-23
process flows, D-109
output interfaces
adding, editing, and deleting, A-28
command, setting, A-29
output devices, assigning to, A-23
output option, setting, A-32
space character, setting, A-29
static options, setting, A-29
title or banner page, setting, A-29
output interfaces, creating for email, A-38
output interfaces, creating for faxing, A-40
output option, setting for
distribution lists, A-25
output devices, A-23
output interfaces, A-32
process flow components, D-152
process flows, D-108
output options, setting for jobs, D-68
output scans
  adding, editing, and deleting, D-52
  jobs, setting for, D-48
  process flow components, assigning to, D-147
  program types, assigning to, D-45
  viewing for tasks, U-95
Output window
  customizing the table columns, U-18
  using to access the File Viewer, U-48
output_required environment variable, D-443
overriding prompts in a schedule, D-344

par environment variable, D-443
parameter format, assigning to program types, D-45
parameter passing in program type scripts, D-422
password
  assigning user login audits to enforce rules for selecting passwords, A-58
  changing for a user, A-49
  changing your password, U-28
  logins, setting for, A-89
password option, setting for data types, D-236
paths, assigning to libraries, D-43
phone number, specifying for users, A-51
phone_no, [phone_no] replacement value, D-257
plain subvars, definition of, D-246
pm file, role in task execution, A-222
pop-up tables
  customizing for the Backlog and Gantt views, U-18
  displaying on the Predecessors tab of the Task Details window, U-105
port, setting for logins, A-89
PRED WAIT task status, U-218
predecessor links
  AND/OR logic, changing, D-196
  definition of, D-160
  editing, D-192
  evaluating on select days of the week, D-202
  external, adding to process flows, D-188
tasks in the Backlog, U-105
interim failure statuses, definition of, D-162
removing external predecessors with the REMOVE_EXT_PRES_ON_INSERT T queue, U-166
rules governing their behavior, D-162
tracing, D-174
understanding, D-163
unsatisfying for other tasks in History, U-114
viewing and editing for a task, U-100
viewing in the Gantt view, U-189
virtual day, setting for external predecessors, D-184
predecessors. See predecessor links.
prefix run-time extension, D-438
Print system output logs option, setting for jobs, D-70
printer environment variable, D-443
printer groups, see output devices
printer_type environment variable, D-443
printers, see output devices
printing
  Explorer tables, U-67
  Gantt view, U-196
  object tree, U-67
  previewing, U-56
  process flow diagrams, D-115
  run date calendars, D-351
  task output files, U-56
to an Applications Manager output device, U-56
priority
  setting for agent in an agent group, A-118
  jobs, D-49
  process flows, D-107
  queues, U-157, U-163
  viewing and editing for tasks, U-96
procedures, defining in dynamic substitution variables, D-252
process flow components
  adding using drag-and-drop, D-124
definition of, D-100
environment variables, assigning to, D-147
notification, assigning to, D-147
output scan, assigning to, D-147
process flow name, viewing for tasks, U-95
process flow order no., viewing for tasks, U-95
process flow sequence number, \{flow_seq\} replacement value, D-257
process flow simulation, viewing for process flows, D-176
Process Flow Summaries
  customizing table columns for the Process Flow Summary, U-18
  viewing all tasks in a process flow with one or more running components, U-74
process flows
  \{subflow_id\} replacement value, D-258
  \{top_flow_id\} replacement value, D-258
activating and inactivating
  process flow components, D-143
  process flows, D-107
adding, editing, and deleting, D-102
aliases, setting for components, D-142
arranging using internal predecessor links, D-172
Ave run time option, setting, D-107
change revisions, implementing for, D-134
Comma Separated option for prompts, setting, D-221
components
  adding using drag-and-drop, D-124
  adding using the add buttons, D-126
maximum number in a process flow, D-100
replicating, D-134
conditions, adding, D-282
copying, D-12
documentation, defining for, D-72
execution options, setting, D-106
execution options, setting for process flow components, D-146
process flows, D-102
exporting, D-370
process flow components, D-370
filtering the Backlog and History for process flows, U-135
forecasts, viewing for, U-172
Graphical Forecasts, viewing, U-174
importing, D-376
List of Values option for prompts, setting, D-221
local substitution variables, creating, D-260
maximum levels of sub process flows, D-100
Multi Select option for prompts, setting, D-221
navigating process flows, D-132
nesting
maximum levels, D-100
within other process flows, D-100
next run date for a schedule, viewing, D-330
output options, setting for
  process flow components, D-152
  process flows, D-108
passing values through a process flow, D-264
priority, setting for, D-107
process flow simulation, viewing, D-176
prompts for process flow components, D-154
querying
History for process flows, U-130
Output window for process flows, U-51
replicating process flow components, D-134
requesting, U-38
retention days, overriding, D-110
run days, setting, D-145
running process flows, D-100
schedule end date, setting, D-330
schedule exceptions, adding, D-342
scheduling
  eligible days for process flow components, D-144
  Reschedule from (date) option, D-334
Single run option, D-107
start date for a schedule, setting, D-330
start times for a schedule, setting, D-330
subprocess flowing
  within other process flows, D-100
time zones, setting, D-331
Use job condition option for process flow
components, setting, D-147
Use request output option for process flow
components, setting, D-147
Variable name option for prompts, setting,
D-221

**process flows, viewing in Gantt chart,**
D-136

**process ID, viewing for tasks,** U-95

**processes**
- AgentService process
description, A-190
details, A-208
- AWCOMM process
details, A-206
- awcomm process
description, A-190
- awexe, A-191
- awexe, details, A-214
- awrun, A-191
- RMI server process
details, A-210
- RmiServer process
description, A-191
- starting and stopping, A-192
- WatchWorx process
description, A-190

**production schedule**
- output abbreviations, U-179
- reports, running, U-178

**program environment variable,** D-443

**program execution, how to initiate,** D-418

**program information, setting for jobs,** D-36

**program name, assigning to jobs,** D-39

**program options, assigning to jobs,** D-70

**program type scripts**
- AWJAVA, explanation of, D-512
debug code, adding, D-430
error trapping
general information, D-426
UNIX, D-427
Windows, D-428
how they are executed, D-418
parameter passing, D-422
SOCOBOL, explanation of, D-504
SQLP, explanation of, D-500
SUSOSHUTP, explanation of, D-510

- what they do, D-414

**program type, role in task execution,** A-228

**program types**
- {command_type} replacement value, D-256
- adding, editing, and deleting, D-44
- command path, assigning to, D-46
- creating, D-412
- environment variables, assigning to, D-45
- file extension, assigning to, D-46
- host command, assigning to, D-46
- jobs, assigning to, D-39
- login type, assigning to, D-45
- notification, assigning to, D-45
- output scan, assigning to, D-45
- parameter format, assigning to, D-45
- require login option, D-46
- role in task execution, A-226
- role in task execution after program
  executes, A-228

**programs**
- {command} replacement value, D-256
- defining in jobs, D-36
- how to execute, D-418
- role in task execution, A-227

**progress of day, monitoring with the**
dashboard, U-181

**prompts**
- adding
to a job, D-212
assigning
data types to prompts, D-221
to jobs and process flows, D-220
copying, D-238
duplicating from another job or process
flow, D-238
in reports, A-135
prompts, overriding in a schedule, D-344
setting for process flow components, D-154
upper case option, setting, D-222
uppercase, forcing, D-227
Value required option, setting, D-222
viewing and editing for tasks, U-98

**PW-DELETE task status,** U-218

**PW-SKIP task status,** U-218

- **Q-**

**qualifier value, for conditions,** D-290
querying
disabling
  Backlog queries, U-133
  Output queries, U-53
  Output window, U-50
  task comments, U-112

queue environment variable, D-443

Queue Summaries
  column descriptions, U-157
  customizing table columns for, U-18

QUEUE WAIT task status, U-218
QUEUED task status, U-219

queues
  {batch_queue} replacement value, D-256
  {queue} replacement value, D-257
  activating/inactivating queues, U-163
  ad hoc requests, setting for, U-41
  adding, editing, and deleting, U-162
  assigning
    to schedules, D-331
    to jobs, D-37
    process flows, D-107
  filtering the Backlog and History for, U-135
  prioritizing, U-157
  priority, assigning to, U-163
  querying History for, U-130
  queue loading, monitoring with the
    dashboard, U-181
  removing external predecessors with the
    REMOVE_EXT_PREDS_ON_INSERT
    queue, U-166
  reviewing status of, U-156
  thread schedules, adding to, U-164
  thread schedules, assigning to, U-163
  viewing and editing for tasks, U-96

Quote char, setting for prompts, D-222

-r-

read_timeout variable, A-290

Receive RmiServer Error Broadcasts user option, A-54
recovery, from system failures, U-124
RECURSIVE task status, U-219

referenced objects
  Applications Manager definition of (for
    exports and imports), D-368
  viewing for an export, D-372

references, viewing where an object is used, D-18

referential checking
  data types, setting for, D-227

refresh time, setting default date/time format, A-57

regular agent groups, adding, A-116

regular expressions
  file associations, using in, U-58
  syntax for, D-552

release notes file description, A-17
remote agents, adding, editing, and deleting, A-100
remote automation engines, running jobs remotely, A-172
removing, predecessors for a task in the Backlog, U-90
replacement values
  conditions, adding to, D-254
  SQL, adding to in data types, D-228
  dynamic subvars, D-251
  Subvar Replacement Values window, using, D-254
replacement variables used in spooler and printer definitions, A-30
replicating process flow components, D-134
reports
  adding, editing, and deleting, A-128
  creating from existing SQL, A-136
  creating jobs to run reports, A-152
  setting the login for reports, A-129
  showing in the Reports window, A-150
  steps for creating, A-128
  viewing object reports, D-14
  viewing operations reports, D-14
  request date and time, viewing for tasks, U-95

REQUEST JOB
  using arguments with the REQUEST JOB
  action, D-312
  value for condition action, D-293

request options. See prompts.
requestors
  assigning to schedules, D-331
  filtering the Backlog and History for
  requestors, U-135
Index

querying
  History for requestors, U-130
  Output window for requestors, U-51
  setting for ad hoc requests, U-41
  viewing the user for tasks, U-95

Requests
  putting on hold, U-42
  requesting jobs and process flows, U-38
  setting the start date and time, U-41
  submitting jobs and process flows, U-40

require login option, setting for a program type, D-46

Require password length of 6 characters option, setting for the automation engine, A-111

Reschedule from date, setting for schedules, D-334

RESCHEDULE TASK condition action, D-293

reserved words in Applications Manager, D-446

RESET_FLOW_RETENTION_DATES job, adding to process flows, D-110

resetting
  agents, U-153
  tasks, in the Backlog, U-86

resetting aborted jobs, U-86

ResponseTimeout variable, A-290

RESTART ON ABORT condition action, D-293

restart on abort option, U-97

Restart once on abort option, setting for jobs, D-50

restoring the display, when error dialogs are out of view, U-6

result format, setting for data types, D-227

resuming agents, U-152

RESV THRDS task status, U-219

retention days for automation engine process logs, A-239

Retention days option
  overriding in process flows, D-110
  setting for jobs, D-69

RETURN CODE condition, D-289

revisions, implementing for process flow components, D-134

RME, running jobs on remote automation engines, A-172

RMI connections, viewing reports of users and RMI servers connected to an automation engine, A-8

RMI server process
  details, A-210

RmiServer process
  description, A-191

rollover interval for automation engine process logs, A-239

rpf_options environment variable, D-444

run date calendars, printing, D-351

run dates, displaying for schedules, D-350

RUN HOST COMMAND condition action, D-294

run ID
  \{run_id\} replacement value, D-257
  decimal values, U-72
  filtering the Backlog and History for, U-135
  querying
    History for, U-131
    Output window for, U-51
    viewing for tasks, U-95

run id, unique task identification number, A-222

RUN TASK condition action, D-294

RUN TIME condition, D-289

RUNNING automation engine/agent status, U-211

run-time extensions, D-436
  execution order, D-439
  flagging non-fatal errors by changing job status, D-440
  general vs. specific, D-438
  how they work, D-438
  mail to completion script, D-441
  modifying output paths, D-441
  overriding statuses, D-440
  role in task execution, A-224
  types of, D-438

-S-

Scale slider, using in Components window, D-114

schedule creep, avoiding with the Next run date option, D-334

schedule exceptions, adding, editing, deleting, D-342

schedule forecasts, viewing, U-172
schedule jobs
  adding, D-96
  using, D-94
Scheduled end date, setting for schedules, D-330
Scheduled start date, setting for schedules, D-330
schedules
  activating/inactivating, D-331
  adding exceptions, D-342
  thread schedules, U-164
  thread schedules to queues, U-163
  to jobs and process flows, D-328
assigning to
  agents, D-331
  jobs and process flows, D-328
  queues, D-331
  users, D-331
behavior after an outage, D-327
daylight savings time, scheduling for, D-360
deferring, D-358
deleting for jobs and process flows, D-328
defining for jobs and process flows, D-328
end date, setting, D-330
multiple jobs and process flows, running on a schedule, D-326
next run date, viewing, D-330
overriding prompts in a schedule, D-344
printing run date calendars, D-351
run dates, displaying, D-350
time zones, setting, D-331
Schedules submitted as a group, A-110
scheduling
  eligible days for process flow components, D-144
  Reschedule from (date) option, selecting, D-334
Select Queues for Requests user option, A-54
Select Requestors user option, A-53
selector windows, adding, editing, and deleting objects, D-10
SELF WAIT task status, U-219
SEND JMS MESSAGE condition action, D-294
SEND NOTIFICATION condition action, D-294
seq_no environment variable, D-444
seq_no, {seq_no} replacement value, D-257
servers, viewing reports of users and RMI servers connected to an automation engine, A-8
SET ABORT STATUS condition action, D-294
SET FINISHED STATUS condition action, D-294
SET HOLD STATUS condition action, D-295
SET SKIP STATUS condition action, D-295
SET SUBVAR condition action, D-295
Set Task Name Suffixes user option, A-54
SFTP_JAVA job, description, D-394
shell scripts, using environment variables in, D-442
Show Read-Only Prompts user option, A-53
shutting down Applications Manager with the SUSOSHUTP script, D-510
SID, setting for logins, A-89
Single run option, setting for jobs, D-37
  process flows, D-107
SKIP TASK condition action, D-295
Skip!Active task status, U-219
Skip!DayofWk task status, U-219
Skip!RunCal task status, U-219
SkipCal task status, U-220
SKIPPED task status, U-220
sleep time, setting for agents, A-101
sleep_wait variable, A-290
so_ext_action variable, A-290
SO_OPERATOR environment variable, D-444
so_par environment variable, D-444
SOCOBOL program type interface script, explanation of, D-504
SODELETE, deleting output files, A-122
sorting columns, U-6
SORUN_PASSWORD environment variable, setting, D-466
sosched_flag variable, A-290
soSite role in task execution, A-221
using to execute your environment, A-285
SOSTOP Background Manager variable, A-284
source environment variable, D-444
space character, setting for output interfaces, A-29
spoolers, see output interfaces
SQL statements
  adding to data types, D-228
  checking for data types, D-228
  checking for substitution variables, D-251
SQL Trace Debug option, setting for the automation engine, A-109
SQL*Loader program, running with the LOADER job, D-404
SQL*Plus programs, running with the SQLP program type script, D-500
SQLP program type script, explanation of, D-500
Srvc_Down, automation engine/agent status, U-211
SSL Enabled, LDAP option, setting for the automation engine, A-113
STAGED HOLD task status, U-220
STAGED task status, U-220
STAGED_PW task status, U-220
staging tasks in the Backlog, U-140
Standard log files, using to troubleshoot, A-236
standard out, role in task execution, A-227
start date and time
  ad hoc requests, setting for, U-41
  filtering the Backlog and History for, U-135
  querying
    History for, U-131
    Output window for, U-51
  viewing and editing for tasks, U-96
Start times, setting for schedules, D-330
START_ERROR, automation engine/agent status, U-211
START_FAILED, automation engine/agent status, U-211
start_timeout variable, A-291
started predecessors, description of, D-163
STARTED task status in History, U-220
started time, viewing for tasks, U-95
starting and stopping agents, U-152
starting and stopping processes, A-192
starting Applications Manager Windows processes, A-264
STARTING automation engine/agent status, U-211
startso client, launching Applications Manager from the command line, U-27
static options, setting for
  output devices, A-23
  output interfaces, A-29
static substitution variables
  adding, editing, and deleting, D-248
  definition of, D-246
status
  {status} replacement value, D-257
  agents, viewing, U-151
  automation engines, viewing, U-151
  filtering the Backlog and History for task status, U-135
  History, querying for, U-131
  jobs, monitoring and managing, U-77
status bar
  color descriptions for AppMaster, U-206
  color descriptions for Explorer, U-76
  viewing in AppMaster, U-206
status colors
  changing for
    jobs and agents (for all users), A-57
    tasks and agents, U-20
STATUS condition, D-289
Status Details, viewing for tasks, U-95
status environment variable, D-444
Status Summary, customizing table columns for the Status summary, U-18
status trigger, assigning to notifications, D-58
STAY IN QUEUE ON ABORT condition action, D-295
Stay in queue on abort option, setting for jobs, D-38
stdout environment variable, D-444
STG SKIP task status, U-221
STG_PW HOLD task status, U-221
STOPPED automation engine/agent status, U-211
STOPPED task status in History, U-221
stopping and starting processes, A-192
string qualifiers for conditions, D-290
SU_TYPE column in authoriz.lis file, D-454
subject, assigning email subjects to notifications, D-58
subprocess flowing within process flows, D-100
substitution variables, D-520
  aliases, using in, D-270
  conditions, adding to, D-254
  defining with a condition statement, D-249
  dynamic, definition of, D-246
  Login, setting, D-251
  making local to a process flow, D-260
  passing values through a process flow, D-264
  plain subvars, D-246
  SQL statements, checking, D-251
  static, definition of, D-246
  Subvar Replacement Values window, using, D-254
  types, D-246
Subvar Replacement Values window, using, D-254
Success (skip on failure) predecessors, description of, D-163
Success only when FINISHED predecessors, description of, D-163
success predecessors, description of, D-163
success run-time extension, D-438
Success since last run predecessors, description of, D-163
successor links
  definition of, D-160
  tracing, D-174
successor option, for adding components to a process flow, D-127
successors
  definition of, D-160
  viewing and editing for a task, U-102
support objects, Applications Manager definition of (for exports and imports), D-368
support Web site, connecting from Applications Manager, U-25
SURUN
  debugging SURUN, D-458
  error messages, D-458
  introduction, D-450
  managing output, D-458
  program types, D-452
  SURUNP program type, D-453
  SURUNP_REQ program type, D-453
  switching users, D-454
  using to initiate tasks from other logins, D-450
  SURUNP program type, D-453
  SURUNP_REQ program type, D-453
  SUSOSHUTP program type interface
  script, explanation of, D-510
  SUSQLP program type, D-452
  SYSOUT script, using to alter file names, A-104
system failures, how Applications Manager handles, U-124
system performance, monitoring with the dashboard, U-180
SYSTEM process flow, running, A-122
SYSTEM_OUTPUT_NAME variable, using to specify output file names, A-104
-T-
tables
  adding tables and views to reports, A-130
  browsing the Applications Manager database from the client, A-156
  customizing columns in Applications Manager windows, U-18
  customizing columns in Applications Manager windows (for all users), A-57
Tail option for viewing output, U-55
Take Actions on Agents user option, A-53
task execution diagram, A-218
Task Output Files, customizing table columns for the Output Files tab on the Task Details window, U-18
task status definitions, U-213
taskbar, using, U-5
tasks
  \{task\} replacement value, D-258
  adding
    comments, U-112
    external links to tasks in the Backlog, U-105
  killing, U-84
  logging task events, A-164
  querying History for, U-130
  restart on abort option, setting, U-97
  running ad hoc requests, U-38
staging in the Backlog, U-140
status colors
  changing for tasks, U-20
status definitions, U-213
viewing
  comments, U-112
  ended times, U-95
  process flow names, U-95
  process flow order numbers, U-95
  process IDs, U-95
  prompts, U-98
  request dates and times, U-95
  run IDs, U-95
  started times, U-95
  Status Details, U-95
  task conditions, U-106
  task documentation, U-108
  task predecessors, U-100
  task successors, U-102
  users (requestors), U-95
viewing and editing
  agents, U-96
  logins, U-96
  max run times, U-96
  output devices, U-96
  output functions, U-97
  priorities, U-96
  queues, U-96
  start dates and times, U-96
tasks, initiating from a variety of logins, D-450
technical support
  contacting, A-4
  emergency (24 by 7), A-4
  standard hours, A-4
text message email, specifying for users, A-51
text messages, [text_msg] replacement value, D-258
text, finding in output, U-55
the first time the condition is true,
evaluating conditions once, D-297
theme
  specifying a color theme for the client,
    A-333
  specifying the ocean theme for the client,
    A-333
thread schedules
  adding, editing, and deleting, U-164
  assigning to
    agents, A-101
    queues, U-163
  changing for agents and automation engines, U-153
TIME SINCE REQUESTED, value for
  conditions, selecting, D-289
time zones
  automation engines, setting for, A-106
  schedules, setting for, D-331
time/date formats, setting defaults, A-57
TIMEOUT task status, U-221
TIME-OUT task status, U-221
timing, setting for conditions, D-286
title, setting a banner page for output interfaces, A-29
toolbar, using toolbar icons, U-5
ToolTips
  editing with the translator editor, A-12
  viewing and disabling, U-4
tracing predecessors and successors, D-174
translating languages for Applications Manager field names, A-12
triangle, for unsaved changes, D-20
TROUBLE
  automation engine/agent status, U-212
  setting alerts for agents, U-10
trouble run-time extension, D-438
troubleshooting
  newly created jobs, D-78
  output problems, A-42
  with
    log files and DEBUG, introduction, A-234
    standard log files, A-236
-U-

Unavailable agent status, U-212
UNAVAILABLE task status, U-221
undoing and redoing actions in process flows, D-115
UNIX, home directory files, A-17
UNSAT-FINISH task status, U-221
unsatisfying
  predecessor references for other tasks in History, U-114
updating unsaved changes, D-20
Upper case option, setting for
  data types, D-227
  prompts, D-222
URL, LDAP option, setting for the
  automation engine, A-113
usage, viewing where an object is
  referenced, D-18
Use Database Time Zone, desktop setting,
  U-9
Use job condition option, setting for
  process flow components, D-147
Use job max revisions option, setting for
  the automation engine, A-110
Use request output option, setting for
  process flow components, D-147
Use Task Count Load Balancing vs. CPU%,
  setting for agents, A-102
Use virtual day for process flow
  component days of week option, setting
  for the automation engine, A-112
user authorities, defining, A-72
USER DEFINED
  {condition1} replacement value, D-256
  {condition2} replacement value, D-256
  value for conditions, selecting, D-288
user environment variable, D-444
user groups
  assigning objects to, A-68
  assigning to
    jobs, D-76
    objects, A-74
  DBA user group, A-70
  defining, A-66
  edit user group, creating, A-66
  end-user user groups, creating, A-86
  general guidelines for creating, A-80
  job/process flow option, setting, A-69
  operator edit user group, creating, A-84
  operator no_edit user group, creating, A-84
  organizing, A-64
  programmer edit user group, creating, A-82
  programmer no_edit user group, creating,
    A-83
  user authority defined, A-72
user ID {requestor} replacement value,
  D-257
user options, setting, A-52
user password, changing, A-49
users
  activating/inactivating, A-49
  ad hoc requests, selecting for, U-41
  adding, A-48
  assigned objects, viewing, A-14
  assigning to
    agents, A-102
    output devices, A-25
    output directory, A-51
    process flow components, D-153
    schedules, D-331
    user login audits to enforce rules for
      selecting passwords, A-58
  awexe range, setting, A-50
  connections, viewing reports of users
    connected to a automation engine, A-6
  default output directory, assigning to, A-51
  email address, specifying for, A-51
  expire interval for user passwords, setting,
    A-49
  fax number, specifying for, A-51
  filtering the Backlog and History for
    requestors, U-135
  language for, setting, A-51
  LDAP authorization, setting, A-49
  logging on to Applications Manager, U-28
  login, setting, A-50
  maintenance user group, setting, A-50
  output device, setting, A-50
  phone number, specifying, A-51
  querying
    History for requestors, U-130
    Output window for requestors, U-51
  sending broadcast messages to, A-7
  text message emails, specifying for, A-51
  user options, setting, A-52

-V-
Value required option, setting for
  prompts, D-222
Variable name, setting for prompts, D-221
Variable Print option, A-35
variables
  agent, A-288
  appworx_port, A-289
  Background Manager variables, A-284
  check_interval, A-289
debug_mask, A-289
during_wait, in awenv.ini, A-289
eligible processes, A-288
initial_sleep, A-198
job_start_limit, A-289
master, A-290
Master_IP_Address, A-290
max_cycles, A-198
max_time_reboot, A-198
min_time_reboot, A-198
mult_factor, A-198
read_timeout, A-290
ResponseTimeout, A-290
sleep_wait, A-290
so_ext_action, A-290
sosched_flag, A-290
start_timeout, A-291
watch_sleep, A-198
watch_wait, A-198
watchstatus_file, A-199
WatchWorx, A-284
variables, used as replacements in spooler and printer definitions, A-30
view icons, adding to an AppMaster view, A-306
view names. See aliases.
View Other Users' Jobs user option, A-54
View Other Users' Output user option, A-54
View SYSOUT Device Output Files user option, A-54
viewing
agent for a task, U-96
agent logs, U-154
assigned objects, A-14
Backlog task summaries (pop-up menus), U-73
conditions for a task, U-106
documentation for a task, U-108
ad hoc requests, U-42
end of files with the output viewer, U-55
environment variables for a task, U-95
Gantt chart for process flows, D-136
Graphical Forecasts, U-174
login for a task, U-96
max run time for a task, U-96
notifications for a task, U-95
object reports, D-14
operations reports, U-14
output
by page and line numbers, U-55
end of files, U-55
file viewer text size, changing, U-55
from History, U-110
Tail option, U-55
output device for a task, U-96
output function for a task, U-97
output scans for a task, U-95
predescors for a task, U-100
priority for a task, U-96
process flow name for a task, U-95
process flow order number for a task, U-95
process flow simulation, D-176
process ID for a task, U-95
prompts for a task, U-98
queue for a task, U-96
reports of users and RMI servers connected to an automation engine, A-8
request date and time for a task, U-95
run ID for a task, U-95
schedule forecasts, U-172
start date and time for a task, U-96
started time for a task, U-95
Status Details for a task, U-95
successors for a task, U-102
tasks in the
  Backlog Gantt view window, U-188
  History Gantt view window, U-120
user (requestor) for a task, U-95
views, adding tables and views to reports, A-130
virtual day, start times
  setting, D-184
  setting default date/time format, A-57
viewing, D-184
-W-
WAIT UNTIL MET condition action, D-295
WARNING task status, U-221
watch_sleep variable, WatchWorx, A-198
watch_wait variable, WatchWorx, A-198
watchstart.bat script for customizing WatchWorx, A-202
watchstatus_file variable, WatchWorx, A-199
WatchWorx
  actions taken based on process and time differences, A-204
  customizing with a watchstart.bat script, A-202
  environment variables and terms, A-198
  process description, A-190
  variables
    initial_sleep, A-198
    max_cycles, A-198
    max_time_reboot, A-198
    min_time_reboot, A-198
    mult_factor, A-198
    watch_sleep, A-198
    watch_wait, A-198
    watchstatus_file, A-199
WatchWorx.notify, A-200
WatchWorx_max_idle WatchWorx variable, A-285
Web service logins, adding, editing, and deleting, D-518
Web service methods, adding, editing, and deleting, D-520
Web services
  introduction, D-528
  methods
    defaultsForRequestJob, D-530
    deleteJob, D-530
    getJobData, D-530
    holdJob, D-531
    killJob, D-531
    requestJob, D-531
    resetJob, D-532
Web Start, launching Applications Manager with, U-26
  where used, viewing where an object is referenced, D-18
width, setting for report columns, A-134
Windows jobs, running with ntspawn, D-420
windows, closing, U-5
workday schedules, creating, D-336
workload balancing, monitoring with the dashboard, U-181
wrap, setting for report columns, A-135

-Z-
ZOS, jobs, creating, D-90